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1.0 Overview 
 

This manual provides MTO standards for using Power InRoads V8i (SELECTseries 2). It 

documents the various settings (Symbologies), the intelligent display characteristics 

(Styles) of InRoads data, Preferences which are used by most of InRoads commands. 

The manual also includes the Options which define the working defaults of InRoads 

commands. 

 

These settings will help to maintain consistency in projects deliverables including 

InRoads data, AutoCAD drawings and XML reports.  It also will minimize the time 

required by each user to set up. The settings provided in this manual can be further 

customized to accommodate the specific project requirements and be saved under 

different name to be used for future similar projects. 

 

These settings/standards are stored in InRoads Preference file namely 

MTO_civil_SS2.xin. These symbologies must be used with drawing template 

MTO_InRoads_Template_SS2.dwg which contains IESCAD layers and text size, and 

cell library MTO_CellLibrary.cel which contains blocks (cells) required by 

symbologies. The text size is given an initial value of 2.0/3.0 based on the text factor 1 

for 1:1000 drawing scale (1 to 1 drawing unit). The text size may be changed by the user 

depending on the required size and drawing scale. 

 

2.0 Symbologies  
 

InRoads has no reliance on anything but its own programming relative to the calculation 

aspect of the software; however, the display side of InRoads depends on the input from 

the CAD platform. This is where the symbologies play critical part in displaying any data 

while using InRoads. Power InRoads incorporates MicroStation as its CAD platform. 

 

The types of parameters stored in a named symbology include: color, layer/level, line 

weight, line style, text height, text justification, text font, rotation angle, and so on. These 

are the particulars relating to the appearance of a piece of graphics. 

 

For example, a named symbology can specify that a line be green when displayed in 

profile but blue when displayed in a cross section and yellow when displayed in plan 

view. The same applies for displaying points or text.  

 

When a symbology is used to display or annotate feature(s), alignment(s), profile(s) or 

cross section(s), the scale factor needs to be set to the appropriate scale. The text height 

and block scale for the symbology has been set to 1:1000 drawing scale (1:1 drawing 

unit). Refer to Options - Factors on how to set the Global Scale Factors. 

 

The Named Symbology Manager is used to add, edit, delete, copy, and rename named 

symbologies and can be activated from InRoads pull down menu under Tools as shown in 

the next page: 
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InRoads symbology is defined based on MTO AutoCAD Standards Guide. All named 

symbologies are organized into groups and sub groups. For each layer in Planning and 

Design, Photogrammetry, and Surveys and Plans sections of IESCAD, there is a 

corresponding symbology named the same as the IESCAD layer name. All the 

symbologies are defined by using by-layer standard and grouped the same way as they 

appear in IESCAD.  

 

In addition to IESCAD layer named symbologies, template points, template components 

(end areas) and surface symbologies have been defined for InRoads design as per MTO 

standards. 

 

For general symbology, only default section has been defined which will apply to plan, 

profile and cross sections display (see below left). All the rest symbologies are defined 

separately for their plan, profile and cross section display (see below right). 

 

       
 

For template points, the description column in appendix A only lists MTO standard point 

names such as EP, ES etc. (refer to section Templates - Point name list for a complete list 
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of point names as per HDS naming convention). For actual template design, the point 

name should include point layer, position and location information as described below: 

 

Point naming convention: 

 

1. The first component will identify which side of the centerline which needs to be 

set up using template options when creating templates.  

2. The second component will indicate the layer/surface. 

3. The third component will be the point feature name. 

 

Example: for point edge of pavement, L-TP-EP, L-TA-EP, and L-TB-EP.  

 

Where:  

L   identifies left of centerline.  

TP, TA or TB identifies the layer and/or surface.  

EP   identifies the point feature name.  

 

The named symbologies used for Planning and Design, Photogremmetry and Surveys and 

Plans are listed in Appendix A, B and C respectively. 
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3.0 Styles 
 

InRoads has surface, geometric and survey features. A style is used to describe how and 

where a feature will be displayed. A feature style is assigned to individual features to 

determine whether points, line segments, or annotation for that feature can be displayed 

in plan view, in cross sections, or in profiles. Each feature style is linked to a named 

symbology. The named symbology defines a set of properties (such as layer/level, color 

and line style) used to display the feature. 

 

The Style Manager is used to add, edit, copy, rename, and delete styles. When users 

select Style Manager from the Tools menu, all predefined styles in the active preference 

file are displayed as shown below: 

 

 
 

 

MTO InRoads styles are based on IESCAD 2009 layering structure. The styles are 

organized into groups and sub groups. The styles include Planning and Design, 

Photogrammetry, and Surveys and Plans sections in IESCAD with additional styles for 

InRoads specific functions. Refer to the style’s description to apply the style. Existing 

feature styles are used for survey and proposed feature styles are used for design. Design 

feature styles are assigned when creating templates. Using Point Name List in MTO 

standard Template Library from the Name field in the Point Properties dialog box will 

link the point name to a predefined feature style. 

 

The styles used for Planning and Design, Photogremmetry, and Surveys and Plans are 

listed in Appendix D, E and F respectively. 
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4.0 Power InRoads Configuration 
 

Power InRoads incorporates MicroStation as its CAD platform but supports to open, 

reference, and read/write directly to Autodesk’s DWG format. MTO Power InRoads XIN 

file and Template Library are customized based on MTO AutoCAD standards, and runs 

in DWG workmode to ensure compatibility with the DWG format. The design workflows 

and the project file format are the same as InRoads on AutoCAD.  

 

It is recommended to use MTO InRoads Project Template to create InRoads project with 

proper project directory structure and create a project configuration file as described in 

this section. 

 

Download MTO’s current InRoads Project Template from the following internet address: 

http://www.xfer.mto.gov.on.ca/PTASapps/index.htm 

 

Select InRoads from the left side Menu list. On the right side, select InRoads Project 

Template_SS2.exe and save to hard drive in the project folder, for example 

c:\Projects\Hwy 69.  

 

 
 

Double click on it to unzip all files in the template. By default, the “Unzip To Folder” is 

pointing to the project folder (current active folder). The self-extractor file will install all 

components to a default subfolder called InRoads within the project folder. You can 

change to a different folder using the Browse button. 
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Click UnZip button. The InRoads subfolder will be created if it does not exist. A 

prompting dialog will appear if the folder and file with the same name already exists. 

When it is finished, close the dialog.  

 

 
 

Locate the Project Configuration File (*.pcf) in the following folder: 

 ……\InRoads\Standards\pcf 

 

Copy the file PORJECTNAME.pcf to the place where your project folder located and 

rename it to the same name as your project folder. For example, if a project folder Hwy 

69 is created in the folder C:\Projects, then copy the .pcf file to the folder C:\Projects 

and rename it to Hwy 69.pcf.  

 

If a different project directory structure is used, modify the PROJECTNAME.pcf to point 

to proper folders. Refer to Power InRoads online help for details. 

 

Start Power InRoads. On the File Open dialog of Power InRoads, locate the User list field 

at the bottom right of the dialog. 
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The User Configuration file is used to determine which workspace (project, user interface 

and user preference) is active. If you haven’t created a user configuration file pointing to 

the project configuration file folder, click in the User field and select New from the list. If 

you have done so, select the user configuration file on the list, then click the Project field, 

the project created above will be shown on the project list. 

 

To create user configuration, select New from the User list, Create User Configuration 

dialog pops up. Type a name in the Name field on the dialog. 

 

 
 

Click OK. Create User Configuration File dialog appears, type description in the 

Description field and click the Select button on the right side of the Project field. 

 

 
 

Browse to the folder where the project configuration file(s) located, for our example, 

c:\Projects.  

 



 

 
InRoads Preference and Standards Manual – Version 3.0                                                   Page 8 

 
 

Select the project configuration file (.pcf ) and click Open.  

 

When return to the Create User Configuration File dialog, you can select a customized 

user interface or leave it with the default user interface. Click OK to close the dialog. The 

project configuration file you selected appears in the Project field.  

 

 
 

You can use the Project list to select project available to you. 

 

 
 

Open MTO InRoads drawing template MTO_InRoads_Template_SS2.dwg located in 

the following folder: 

 ……\InRoads\Standards 

 

Click File > Save as from MicroStation main menu bar to save the drawing under a 

different name in desired location.  
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You can also set the template file as seed file then create a new drawing from it with the 

New file icon on the File Open dialog. 

 

The DWG template is setup for using MTO InRoads preference file and to be used in 

DWG workmode to prevent creation of data that cannot be saved to DWG files. 

 

 
 

In order for InRoads to recognize the profiles or the cross sections created in DWG mode 

when the DWG is reopened, the value of the MicroStation configuration variable 

MS_DWGSAVEAPPLICATIONDATA must be set to 1 before creating profiles or cross 

sections.   

 

Select Workspace > Configuration from MicroStation main menu bar. When the 

Configuration dialog shows up, select All (Alphabetical) from the Category list then 

look for variable MS_DWGSAVEAPPLICATIONDATA in the View/modify all 

configuration variables list. If this is the first time you set this variable, click the New 

button to add the variable to the list. If you have done so, make sure the value is set to 1. 

 

To create the variable, click the New button to bring up the New Configuration Variable 

dialog. Type MS_DWGSAVEAPPLICATIONDATA in the Variable field then type 1 

in the New Value field as shown below: 
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Click OK to close the dialog to return to the Configuration dialog. The variable created 

just now should be shown on the list now as shown below: 

 

 
 

Power InRoads allows user to activate the InRoads Group commands from the CAD 

menu (main menu bar, contextual menus, tool icons, etc) directly. In this manual, the 

InRoads commands are accessed from the InRoads Explorer menu bar.  
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5.0 InRoads Project Defaults 
 

It is recommended to create a project default name once the project directory structure 

has been created. The Set Project Defaults dialog is used to specify the initial location for 

loading/saving all files for a project. 

 

Select File > Project Defaults. In this example, xxxxx is the current project working 

directory. 
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6.0 Project Options 
 

The Project Options dialog box controls parameters that affect system-wide operation 

and can be activated from InRoads pull down menu under File. 

 

6.1   General 
 

The General tab allows you to specify general parameters for settings.  
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6.2   Factors 
 

The Factors tab allows you to set the scaling factors applied to text, cell (block), and line 

style scale by InRoads display and annotation commands. The scale factors must be set to 

the appropriate drawing scale to display and annotate a feature with a defined symbology. 

The default value has been set to 1 for 1:1000 drawings to be plotted at 1=1. Set the 

factors to 0.5, 0.2, 0.1 etc for 1:500, 1:200 and 1:100 drawings respectively.  

 

 
 

To set the Scale Factor go to File > Project Options > Factors or using Tools > Global 

Scale Factors.  The global scale factors can be accessed from InRoads Application Add-

Ins as shown below.  

 

 
 

6.3   Units and Format 
 

MTO uses metric units for highway design. The units and format are set as below. 
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6.4   Precision 
 

The Precision tab allows specification of the number of decimal places to display for 

various system parameters. The maximum precision for each parameter is seven decimal 

places except for the Scale parameter which is twelve decimal places. The settings on this 

tab are general. There are a few commands in InRoads need user to set decimal places 

within the commands to get appropriate display. The default values for this tab are shown 

as below. 
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6.5  Others 
 

Other settings for MTO preference for this dialog have been setup as follow: 
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7.0 Preferences 
 

7.1   Preference Overview 
 

A preference defines how an operation is to be performed for a given command within 

InRoads. User can save their preferred settings for a given command. More than one 

preference can be saved. Different commands can use same preference name as 

preference set. 

 

The Preference Manager is the tool that allows adding, editing, and deleting preferences 

across the entire product, all from a single dialog box. Extra caution should be given 

when using the delete button.  The delete button will delete all preferences with a given 

name for any command in InRoads – not just for a single command. To delete a 

particular preference from a single command, use the Uninitialize button.  

 

The MTO preference is the Preferred Preference set in the MTO_civil_SS2.xin file. It 

has more initialized settings for commands than any other preference set. User may load 

a different preference set by clicking on the Preferences button on any dialog.  

 

To set the Preferred Preference, select File > Project Defaults. In the Preferred 

Preference field to the bottom of the Set Project Defaults dialog, select MTO form the 

Name drop-down list. This allows users to use MTO as a system wide default preference 

when a command with a dialog box first time activated. Click Apply to save the change 

made to the configuration. 
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7.2   Surface 
 

Surface contains all information related to a Digital Terrain Model (DTM). Surface is 

made up of features.  A feature is a single instance of a 3D geometric representation in 

the DTM. A feature can be one of five types, corresponding to the type of DTM points 

contained: random, breakline, exterior boundary, interior boundary, or contour. Features 

are essentially just groups of DTM points -- each group is given a name and assigned a 

feature style. Non-triangulated features can be stored in a surface along with triangulated 

features, and they can be used as design control, be displayed and annotated from the 

surface. 

 

In InRoads, features can be created or imported into the surface. Feature data in the 

surface can be displayed in plan, profile and cross section view. The surface data is used 

for design analysis and computation. InRoads provides the tools for modifying, 

manipulating and displaying surfaces. 

 

 

7.2.1    Import Surface from Graphic Element 

 

Select File > Import > Surface 

 

The graphics data must be in the drawing file that to be imported into the surface. To load 

the graphics into a surface, you must create a new surface first or have an existing surface 

opened.   
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7.2.2    Export Surface 

 

Select File > Export > Surface 

 

Generate an ASCII file containing data for a specified surface. 

 

 
 

 

7.2.3    View Perimeter 

 

Select Surface > View Surface > Perimeter 

 

This command displays the outermost edge of a triangulated digital terrain model. This 

command is very helpful for visualizing the boundaries of the triangulated model and for 

fitting the surface to the viewing screen so that the results of subsequent commands can 

be seen. 

 

 
 

Set the appropriate surface to active for example OG-Test and click the Apply button. 

The surface boundary showed as below. 
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7.2.4    View Triangles 

 

Select Surface > View Surface > Triangles 

 

This command displays all or a portion of the triangles contained within the active 

surface. InRoads displays the triangles that are created when the model is triangulated.  

 

This command can be used to help evaluate the terrain model and pinpoint areas that 

either have too many points or too few points. 

 

 
 

Select the surface for which you want to display triangles and click the Apply button.  

 

 
 

If a Region has been placed in the drawing, the Region Mode on the dialog will be 

activated as shown above. Triangles can be shown within the selected area. The picture 

below show triangles with region placed. 
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7.2.5    View Contours 

 

Select Surface> View Surface > Contours 

 

This command generates and displays elevation contours for the active surface. This 

command automatically generates major contours, minor contours, depression contours, 

and contour labels in the drawing. 

 

Major contours are contour lines that display at an elevation interval you specify. Minor 

contours display a specified number of times between each major contour. 

 

Before applying the command, set appropriate surface active and select a named 

preference. The MTO preference is the default setting. MTO_PH and MTO_SP are 

used to display the contour line and labels on Photogrammetry and Surveys and Plans 

layer respectively. To display a different scale for example 1:500, set the Global Scale 

Factors to 0.5.  
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Shown here is an example of contours drawn with preference MTO at 1:1000 scale. 

 

 
 

 

7.2.6    Annotate Feature 
 

Select Surface> View Surface > Annotate Feature 
 

This command places text describing characteristics and annotates slope direction of 

features in the active surface. It annotates whether points, line segments, slope direction, 

crests, sags, or all five. 
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The preference MTO provides initial settings for all five type annotations. You can select 

the type of information to annotate from the main tab and select any combination of data 

from the following tabs respectively. By default, the Points is selected with Feature 

Name and Elevation to be annotated. See below for settings for each tab. 

 

 
 



 

 
InRoads Preference and Standards Manual – Version 3.0                                                   Page 23 
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7.3   Horizontal Alignment 
 

InRoads provides different tools to display and annotate horizontal alignments. Use both 

Horizontal Annotation and Curve Set Annotation commands for displaying in MTO 

format. Before viewing and annotating horizontal alignment, set the desired scale factor.  

 

7.3.1    View Horizontal Annotation 

 

Select Geometry > View Geometry > Horizontal Annotation 

 

This command displays and annotates multiple horizontal alignments at the same time. 

Preferences have been setup based on IESCAD layering standard for Planning and 

Design, Surveys and Plans and Photogrammetry alignment. The default setting MTO 

will use the alignment style assigned in the geometry project to display and annotate the 

selected alignment with the points and tangents information. 

 

Shown below are alignments with different styles and an example illustrates the 

annotation with the default setting. 

 

 
 

 
 

When selecting a preference other than the preference MTO, InRoads will ignore the 

alignment style assigned in the geometry project and use the style defined in the selected 

preference to display the alignment with the annotation.  
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The annotated information is controlled by toggling on/off the fields under Geometry 

Feature leaf in style editor. Select different fields for project specific requirements. 

 

 
 

Select and load named preference MTO_Alignment_S&P. Select alignment(s) and click 

Apply. This preference displays the alignment and the element annotations. Then use 

Curve Set Annotation to display the PI symbol and short tangents. 

  

 
 

7.3.2    Curve Set Annotation 

 

Select Geometry > View Geometry > Curve Set Annotation 

 

This command has the same set of preferences as the Horizontal Annotation command. 

Preferences have been setup for displaying the PI symbol, short tangents and curve 

information. All preferences have a few items selected for annotation by default. The 

annotated curve information is controlled by toggling on/off the annotation items below 

the Text field under Annotation leaf. Select different items for project specific 

requirements.  
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Click Preferences and load named preference MTO_Alignment_S&P.  

 

 
 

Click Apply. The PI symbol, short tangent and curve information are added to the 

alignment as shown below. 
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7.3.3    View Stationing 

 

This command controls the display of station annotation text along the active horizontal 

alignment. You can place stations along a horizontal alignment at a specified interval. 

 

Select Geometry > View Geometry > Stationing 

 

There are different setups for station annotation including preferences for new (P&D) and 

existing (S&P) alignment stationing. Default preference MTO is similar as preference 

MTO_Alignment_P&D with different offsets from the center line. Both preferences 

MTO_Alignment_P&D and MTO_Alignment_S&P are set up Down Station (looking 

down the alignment). Options for Up Station (looking up the alignment) as the reference 

name indicated are also provided.  

 

 
 

Select named preference MTO_Alignment_S&P and click Load. Click Apply and 

Close. Major stations, major ticks, minor ticks, PI stations and cardinal stations are 

displayed along the alignment as shown in the picture. 
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7.4   Profile 
 

7.4.1    Create Profile 

 

This command extracts and displays profiles along horizontal alignments or selected 

graphics strings. A profile displays elevation data extracted from selected surfaces along 

the defined path. Before starting, select a proper symbology for the surface to be 

extracted.  

 

 
 

 

Select Evaluation > Profile > Create Profile 

 

Preferences have been set up with different vertical exaggerations (1V, 2V, 5V and 10V) 

for new (P&D) profile and 1 vertical exaggeration (10V) for existing (S&P) profile. The 

default preference MTO is for P&D with vertical exaggeration 10.  

 

See below for available preferences. 
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Shown below are examples for same profile created with 2 deferent preferences MTO 

(first) and MTO_S&P_10V (second).  

 

 
 

 
 

7.4.2    View Vertical Annotation 

 

This command displays and annotates vertical point and alignment information, such as 

tangent grade and vertical curve information. 

 

Select Geometry > View Geometry > Vertical Annotation 

 

Click Preferences and load a named preference.  
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Default preference MTO is a simplified setup providing brief vertical alignment 

information on the P&D layers. See below. 

 

 
 

The preference MTO_Proposed provides more detailed curve information for proposed 

vertical alignment as shown below. 
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The preference MTO_Existing provides same information as the preference 

MTO_Proposed for existing vertical alignment using the S&P layers. 

 

7.4.3    Annotate Profile 

 

This command adds textual and graphical information to existing profiles. You can 

annotate various types of information such as stationing values, existing and proposed 

elevations, and superelevation and curvature diagrams in any combination. 

 

Select Evaluation > Profile > Annotate Profile 

 

On the left of the dialog box is a list of available items that can be annotated. Default 

preference MTO provides parameter settings for each of the entries in the list using 

IESCAD layers and pre-defined symbologies. The MTO preference has a sample 

selection with four types of data (Proposed, Existing, Grade and Distance, and Station) 

selected for annotation. You can choose the type of information that is relevant to your 

project from the available list to display in the profile. See below the default selection list 

and a sample parameter setting(s). 
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The diagram below shows sample results of annotating the four types of data from the 

selection list. 

 

 
 

The data that this command displays is not automatically related to the profile that you 

are annotating. The data is derived from the active horizontal and vertical alignments, as 

well as the active surface and active roadway definition. To accurately annotate a profile, 

you must make sure that the alignments, surface, and roadway definition displayed are 

the ones that were used when the profile was extracted 

 

7.4.4    Annotate Feature in Profile 

 

This command is used to annotate the features displayed in a profile. The command runs 

on a profile set, which you select. There is a surface list, which lists all the surfaces 

loaded. The feature list displays all the features in the specified surface. Use this list to 

select the features to be annotated. The two types of features displayed in profiles are 

projected features and crossing features. Projected features have endpoint components 

and a linear component. Crossing features only have a point component. You can select 

to annotate points, line segments, or both. 
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Select Evaluation > Profile > Annotate Feature in Profile 

 

Click Preferences and load a named preference.  

 

 
 

The references have been set for annotating line segments (MTO_Line) or points 

(MTO_Points).  

 

When annotating line segments, you can specify a location for the text along the line: 

Midpoint, Start, or End. You can also display the absolute slope of the feature and use an 

alternate slope if the slope exceeds a given percentage. See below an example of 

projected line segments annotation. 

 

 
 

When annotating points, you may choose to annotate the crossing points, projected 

points, or both. If projected points are being annotated, the text can be placed at every 

vertex and at a given interval. Shown below is an example of projected points annotation: 
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7.5   Cross Section 
 

Cross sections are used to display and annotate surfaces features in a vertical plane. Cross 

sections are extracted at a specified interval across a horizontal alignment or some other 

linear feature. Cross sections can be extracted at a skewed angle, but they are typically 

perpendicular to the alignment.  

 

Depending on the project, cross sections sets are drawn with vary scales, intervals, 

vertical exaggeration factors and the amount of annotations. This section will discuss 

how to use the MTO preferences to generate cross section set and cross section report. 

 

The sample set is in 1:100 scale with OG, TP and SG surfaces annotated.  

 

7.5.1    Create Cross Sections 

 

Since the cross section scale is 1:100, set the Global Scale Factors to 0.1.  

 

Select Evaluation > Cross Section > Cross Sections 

 

On the left side of Cross Sections dialog, select Create Cross Section folder. 

 

Click Preferences and load named preference MTO_Sheet(1:100).  

 

 
 

Go through each subfolder and leaf under Create Cross Section folder on the left panel of 

the dialog to make selections/changes for project specific requirements. The preference 

MTO_Sheet_Table (1:100) is set to create cross sections for annotating sections in table. 

See section Annotate Cross Section in Table for details. 

 

Click General leaf. Change the interval and offsets as project required. Select the 

surfaces you want to displace in the cross sections. You can save the settings under a 

different preference name for later use when you work on the same project. 
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Click Source and make sure the proper alignment is show in the alignment field. 

 

 
 

 

Click Controls > Limits. Give station range otherwise display whole project. 

 

 
 

 

Click Layout > Sheet Border.  Select standard paper size or customize the paper size. If 

you select the custom paper size, the value you input in the Width and Height filed is in 
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meter when you print the drawing at given scale. The default value for 

MTO_Sheet(1:100) is 5 for width and 0.58 for height which will generate a 5000x580mm 

roll drawing when plot at 1:100 scale. 

 

 
 

Click Apply. Shown below is a set of sections and a single enlarged section.  
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7.5.2    Annotate Cross Sections 

 

Cross section annotations typical include OG, TP & SG surface Point Offset & Elevation, 

and features names. For each of these surfaces, there are preferences named with the 

surface name and the scale in the parenthesis. For example MTO_OG (1:100) is the 

preference name for the OG surface annotation in 1:100 scale cross section set. 

 

The annotation preferences are setup to work with the crossing features. Crossing 

features must be displayed in cross section to be annotated. User can choose to annotate 

surface instead of surface crossing features. However, some of the annotation texts may 

get overlapped. Select the Update Cross Section folder from the Cross Sections dialog 

to load the crossing features to the cross section set. 

 

To annotate the 1:100 cross section set, set the Global Scale Factors to 0.1.  

 

a) OG surface 

 

Select Evaluation > Cross Section > Cross Sections 

 

On the left side of Cross Sections dialog, select Update Cross Section folder. 

 

Click Crossing Features leaf and toggle on the Display On option. Select OG surface 

and select all the features in the feature list window.  

 

 
 

Click Apply, all selected features points are displayed in the cross section set. 

 

On the left side of Cross Sections dialog, select Annotate Cross Section folder. 
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Click Preferences and load named preference MTO_OG (1:100).  

 

Click General and select the OG surface. 

 

Click Features > Annotate. Select all the features from the feature list.  

 

 
 

Click Apply. Show here is an image of OG surface annotated with the crossing features. 
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If the OG surface used in design doesn’t have crossing features, click Points and check 

Include Points option. 

 

 
 

The OG surface is annotated with some text overlapping. 

 

 
 

b) TP Surface.  

 

Select Evaluation > Cross Section > Cross Sections 

 

On the left side of Cross Sections dialog, select Update Cross Section folder. 

 

Click Crossing Features leaf and toggle on the Display On option. Select design surface 

and select all the TP surface features in the feature list window. If the Feature Filter Lock 

is on and the proper filter is selected, then select all the features in the feature list 

window. 
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Click Apply, all selected TP surface features points are displayed in the cross section set. 

 

On the left side of Cross Sections dialog, select Annotate Cross Section folder. 

 

Click Preferences and load named preference MTO_TP (1:100).  

 

Click General and select the design surface (Test_21 for this example). 

 

Click Features > Annotate. Select all the features from the feature list.  
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Click Apply. Now the TP surface is annotated with the crossing features. 

 

 
 

c) SG Surface.  

 

Select Evaluation > Cross Section > Cross Sections 

 

On the left side of Cross Sections dialog, select Update Cross Section folder. 
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Click Crossing Features leaf and toggle on Display On option. If SG surface has been 

created, then select SG surface and select all the features in the SG surface. If no SG 

surface has been created, use the design surface created from InRoads roadway designer. 

Select the design surface and then select the SG surface features from the feature list 

window. Use the filter to help the selection. It is recommended to create separated 

surfaces for each subsurface before updating/annotating cross sections set. These sub 

surfaces are also used to create the grade report.  

 

 
 

Click Apply, all selected SG surface features points are displayed in the cross section set. 

 

On the left side of Cross Sections dialog, select Annotate Cross Section folder. 

 

Click Preferences and load named preference MTO_SG (1:100).  

 

Click General and select the SG surface/design surface (depending on which surface is 

used for displaying the features). 

 

Click Features > Annotate. Select all the features from the feature list.  
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Click Apply. Now the SG surface is annotated with the crossing features. 

 

 
 

 

7.5.3    Annotate Cross Section in Table 

 

To annotate cross section in table style, you need to create the cross section set with more 

space below each section. Use the preference with “_Table” in the preference name to 

create the cross section set then use the preferences also with the “_Table” in the 

preference name for annotation.   
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Set the Global Scale Factors to 0.1. 

 

Select Evaluation > Cross Section > Cross Sections 

 

On the left side of Cross Sections dialog, select Create Cross Section folder. 

 

Click Preferences and load named preference MTO_Sheet_Table (1:100).   

 

 
 

Go through each subfolder and leaf under Create Cross Section folder on the left panel of 

the dialog to make selections/changes for project specific requirements.  

 

Click Apply. The cross section set will be created with more space between sections. See 

below. 

 

 
 

Select Evaluation > Cross Section > Cross Sections 

 

On the left side of Cross Sections dialog, select Update Cross Section folder. 

 

Refer to previous section to add features for each layer/surface (OG, TP, and SG). 

 

On the left side of Cross Sections dialog, select Annotate Cross Section folder. 

 

Click Preferences and load named preference with “_Table” in the preference name. 
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Load named preference MTO_OG_Table (1:100) for OG surface annotation.  

 

Click General and select the OG surface. 

 

Click Features > Annotate. Select all the features from the feature list.  

 

Click Apply. Now the OG surface is annotated in the table below the section. 

 

 
 

Load named preference MTO_TP_Table (1:100) for TP surface annotation.  

 

Click General and select the TP surface. 

 

Click Features > Annotate. Select all the features from the feature list.  

 

Click Apply. Now the annotation for TP surface is added to the table after the OG 

surface annotation. 
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Load named preference MTO_SG_Table (1:100) for SG surface annotation.  

 

Click General and select the SG surface. 

 

Click Features > Annotate. Select all the features from the feature list.  

 

Click Apply. Now the annotation for SG surface is added to the table below the TP 

surface annotation. 

 

 
 

 

7.5.4    Cross Section Report 

 

This command creates a station, offset, and elevation report for a specified cross section 

set. Before running the report, make sure that you display features, components, and all 

surfaces that you want in the report.  

 

Select Evaluation > Cross Section > Cross Section Report.  

 

Select surface and click Apply. 
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Select Evaluation > CrossSectionGradebook.xsl (deisgn surface) or 

CrossSectionGradebookWide.xsl (subsurface).   

 

The precision and formats can be set by selecting Tools > Format Options. 
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7.6   Volume 
 

The Volumes commands calculate volumes between surfaces. They can compute the 

materials required for each layer in your roadway.    

 

7.6.1    End-Area Volume 

 

This command performs the traditional end-area volume calculation to compute cut, fill, 

and net volumes using a series of cross sections extracted along a previously defined 

alignment. You can also add unsuitable material to calculations and/or add volume 

exceptions. A complete report listing all computed quantities on a station-by-station basis 

can also be generated with this command.  

 

The command requires cross sections created through InRoads with at least two displayed 

surfaces. The End-Ares Volumes are based on the cross sections displayed in the CAD. 

You don’t have to load the surfaces in order to compute End-Area Volume. 

 

Select Evaluation > Cross Section > Cross Sections 

 

On the left side of Cross Sections dialog, select End-Area Volumes folder. 

 

Click Preferences and load preferred preference. Default preference MTO has initial 

settings. User should go through each of the leaves under End-Area Volumes folder on 

the left panel of the dialog to make selections/changes for project specific requirements.  

 

Select the desired cross section set form the Cross Section Set drop down list. 

 

Click General, toggle on the desired surfaces. By default, the volume will be calculated 

for whole cross section set with Create XML Report option toggled on. 
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Click Unsuitable Materials by Feature/ Station to add unsuitable material to end area 

calculations (topsoil stripping and muck removal). If both options are used, the materials 

defined by the station range supersede any defined by the feature method. 
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Click Classification leaf. Use this dialog to control how volumes are calculated and 

reported for individual materials. Individual materials are those not normally included in 

the unclassified cut and fill volumes. These include substrata materials, component 

materials, and materials calculated from the Material Features leaf.  
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Click Compaction/Expansion, Volume Exceptions, or Added Quantities leaf to adjust 

end area calculations. Use Cut/Fill Factor to account for any swell or shrinkage that may 

occur when remove/place material. Use Volume Exceptions to ignore earthwork quantity 

in a given range (bridge). 

 

 
 

 

Click File > Save or Save As to save an End-Area Volume parameter file (*.eav) to store 

the parameters entered above. 

 

Click Annotation leaf to select annotation options. Shown below are default settings. 

Change the options as you need. In order to show information properly, the Global Scale 

Factors need to be set to reflect the cross section set scale.  
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Click Apply to calculate the volumes. Below is an example of annotated cross section 

set. 

 

 
 

With Create XML Report option toggled on, Bentley Civil Report Browser displayed. 

Select a report format from the style sheet list on the left panel of the browser. There are 

seven style sheets from the Evaluation folder can be used to view End Area Volume 

report.  
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7.6.2    Mass-Haul Diagram 

 

This command generates a Mass-Haul diagram for the specified range from the selected 

cross section set and displays it in the drawing file. A Mass-Haul diagram shows 

cumulative total of cut and fill volumes along a horizontal alignment. Before you 

generate a Mass-Haul diagram, you must have the cross section set displayed in the 

active drawing window. 

 

Select Evaluation > Cross Section > Cross Sections 

 

On the left side of Cross Sections dialog, select End-Area Volumes folder then select 

Mass-Haul Diagram folder. 

 

Click Preferences and load preferred preference. The preferences with “MTO_MHD_” 

in the preference name are set for Mass Haul Diagram. MTO_MHD_1000 is set to 1000 

m
3
 per major grid with a horizontal exaggeration of 1 and a vertical exaggeration of 0.01. 

Preference MTO_MHD_5000 is set to 5000 m
3
 per major grid and MTO_MHD_10000 

is set to 10000 m
3
 per major grid. Select the named preference base on the earthwork 

volume of the project. 
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Change the Global Scale Factors for annotation to match the plot scale. 

 

 
 

Go through each of the leaves under End-Area Volumes folder on the left panel of the 

dialog to make selections/changes for quantities to be included in Mass-Haul diagram. 

You can load the Parameter File from the End-Area Volume calculation if you have 

saved one. 
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Click General leaf under Mass Haul Diagram folder. You can change the mass haul 

diagram direction and horizontal and vertical exaggerations.  

 

 
 

Shown below is an example of a mass-haul diagram. 
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7.7   Templates 
 

A MTO standard template library MTO_STD_Templates.itl has been provided with 

MTO InRoads Project Template. This library contains several typical sections, 

components and end conditions with predefined point names that are associated with 

MTO standard styles and symbologies. It can be used to facilitate the creation of new 

components/templates on any project library. 

 

7.7.1    Point name list 

 

The standard template library contains a predefined point name list where point names 

are assigned style defined in MTO InRoads preference file MTO_civil_SS2.xin.   
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Employ the standard Point Name List and supplement as needed before creating project 

templates. Apply prefix, suffix and layer identifier to the point names and keep the points 

linked to predefined feature styles.  

 

7.7.2    Parametric Constraints 

 

Parametric constraints can be used to change one or more labeled constraint values of a 

template while the template is being processed in the Roadway Designer. This allows 

you to use only one template to handle a number of different conditions.  When use 

Parametric Constraints, designers should consider the constraint types and the design 

features to assign descriptive names for the labels. 

 

Typical label names are combinations of abbreviations such as: 

 

Constraint Types: 
  

Width Horizontal Constraint 

Depth/Thickness/Height Vertical Constraint 

Slope/Slp Slope Constraint 

  

Design Features:  
 

Rdwy Roadway 

Shld Shoulder 

SW Sidewalk 

Lane Travel Lane 

Blvd Boulevard 

Pavt Pavement 

Drive Driveway 

Curb Curb 

Ditch Ditch 

Median Median 

 

Material/Surface Layer 
 

Asph Asphalt 

Conc Concrete 

GranA Granular A 

GranB Granular B 

Sand Sand 

WC Wearing Course 

BC Binder Course 

Base Base Course 

SG Subgrade 

 

Suffix 
 

Lt Left 

Rt Right 
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Some Example Labels: 
 

Lt_Shld_Asph_Depth Left Shoulder Asphalt Depth 

Rt_Shld_Slp Right Shoulder Slope 

Rt_Pavt_Width Right Pavement Width 

GranA_Depth Granular A Depth 

 

7.7.3    Template Options 

 

The template options have been set to “Apply Affixes” for default preference MTO. The 

affixes are prefixes L- and R-. The affixes will be applied to point names when the 

components are placed into the template.  

 

 
 

For more complicated templates, suffixes such as –L and –R or _L and _R can also be 

added to the point names. 
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7.8   Roadway Designer 
 

7.8.1    Superelevation Wizard 

 

The superelevation wizard in Roadway Designer is used to create superelevation in the 

roadway design process. MTO uses the table method. The superelevation rate tables are 

found in MTO InRoads Project folder: ...\InRoads\ Standards\Superelevation 

 

 
 

The MTO superelevation rate tables are ASCII files and named by maximum 

superelevation rate and design speed. For example, the table MTO_06_100k.sup is MTO 

standards for a maximum 6% superelevation rate at 100km/h design speed. 

 

The default preference MTO sets 60% of the length of the transition section on the 

tangent and 40% on the circular curve. The cross-fall transition is set to start from 0 cross 

slope at the end of the tangent runout to full superelevation over the spiral length. 

 

Select the desired superelevation table to load the Transition Lengths. The tangent 

runout must be calculated and input into the wizard. For more information on working 

with Superelevation wizard, refer to MTO Customization Documentation.   
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7.8.2    Create Design Surface 

 

Once one or more corridors have been designed, this command is used to create the 

design surface or surfaces. You can either create a unified or merged surface out of all the 

corridors in the design, or create a separate surface for each corridor.  

 

The default preference MTO has the following options toggled on. 

 

New Surface for Each Corridor is on. Each surface created from this command is given 

the name of corresponding Corridor. When this option is toggled off, the name provided 

in the Name field becomes the name of the surface created, and the name of each 

corridor is prefixed to each of the features that are created.  To use Clipping and 

Aliasing function, this option must be toggled off.  

 

Empty Design Surface is on to ensure that the existing surface is emptied before re-

creating it.  

 

Triangulate Surface is on to automatically triangulate surface(s) when created.  

 

Remove Loops is on to eliminate loops created in linear features as well as trim 

transverse features to prevent feature overlapping that may cause surface problems.  
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Add Exterior Boundary is on to automatically create an exterior boundary for the 

design surface(s).  

 

See below the default setting. 
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7.9   Drive Roadway 
 

Power InRoads allows users to virtually drive through the designed 3D corridor model to 

see the impact of design plans, and to visualize the 3D model. 

 

The Drive Roadway command is an Application Add-In with InRoads. To use it, toggle it 

on first in Application Add-Ins. 

 

Select Tools > Application Add-Ins. 

 

 
 

Close the dialog. The command now appears as an optional item of the Modeler pull 

down menu. 

 

 
 

Select Modeler > Drive Roadway.  

 

Shown below is the Drive Roadway dialog with the default settings. 

 



 

 
InRoads Preference and Standards Manual – Version 3.0                                                   Page 65 

 
 

Before using this command, load a horizontal and a vertical alignment, and display the 

roadway in 3D.  Specify different Horizontal/Vertical offset, Speed, Frames per Second, 

and Target Distance to see the difference in the Drive Roadway view. 

 

Drive Roadway command provides a wireframe view. Shown below is a view of a 

designed roadway model. 

 

 
 

 

Shown below is the same view displayed in a different style (using the Display Style of 

MicroStation). 
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7.10   Drafting 
 

7.10.1    Place Coordinate Grid 

 

Use this command to display a coordinate grid based on the parameters that you define.  

 

Select Drafting > Place Coordinate Grid to create a coordinate grid in current drawing. 

 

Default preference MTO is set at 100 intervals for both Northing and Easting at which 

grid lines and annotation will be placed. Shown below are the preference settings and 

displayed grid. 
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7.11   Tools 
 

7.11.1  Tracking 

 

Select Tools > Tracking  

 

This command dynamically displays the northing and easting coordinates of the cursor 

location, as well as the surface elevation, slope, and aspect based on the active surface. 

The dialog box also dynamically reports the cursor location in terms of station and offset 

from the active horizontal alignment. All or part of the active surface information can be 

annotated in the drawing file by placing a data point and then edits can be made. The 

preference MTO has been set to display all the information on layer PD-N-MSC by 

default. To change the options to be annotated, click Settings from the Tracking dialog 

to open the Tracking Symbology dialog. 

 

 
 

See below a sample output. 
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7.11.2  XML Reports 

 

There are several commands that generate XML reports. The main location is Tools > 

XML Reports. 

 

This command generates XML data files. The XML files are temporary files that contain 

raw or computed data. The XSL style sheets are used to transform the XML data to text 

or HTML format. The reports are displayed in the Bentley Civil Report Browser. The 

report format can be changed by selecting the style sheet from the style sheet list on the 

left side of the browser. Some of the more commonly used reports have been provided 

with initiate settings for MTO_civil_SS2.xin. 

 

a) Geometry Report 

 

The Geometry Report command provides options to specify groups of alignments and 

cogo points to be included in the report data file as well as vertical alignments, and 

horizontal and vertical event points. Each data file can be formatted into report with 

multiple style sheets to review alignment data, calculate areas, and produce geometry 

reports. By default, only horizontal alignment information will be included.  

 

 
 

You must include at least one horizontal alignment in the Include field to generate a 

geometry report. Based on your project data, you can: 

 

Specify one or more horizontal alignments to be included in the Include field of the 

Horizontal Alignments area. Use * to select all of the alignments in the geometry 

project. 

 

Specify a group of cogo points to be included in the Include field of the Cogo Points 

area. Use * to select all of the cogo points in the geometry project. 
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Toggle on Include Vertical Alignments to include information about vertical alignment 

of the selected horizontal alignment(s).  

 

Toggle on Include Vertical Event Points to include information about the vertical event 

points for all the vertical alignments associated with each selected horizontal alignment. 

 

Toggle on Include Horizontal Event Points to include information about the horizontal 

event points associated with each selected horizontal alignment. 

 

Toggle on Interval and key in a value greater than 0. Additional points, the computed 

event points will be added to the XML report data file along each selected alignment at 

specified interval.  

 

Shown below is an example of Horizontal Alignment Review Report. 

 

 
 

Same report data displayed with List Coordinates with Station Report style sheet. 



 

 
InRoads Preference and Standards Manual – Version 3.0                                                   Page 71 

 
 

b) Station Base/Offset Report 

 

Station Base Report and Station Offset Report are used to report alignments and/or 

surface features. Both commands have similar options and operation: 

 

General leaf: At least one horizontal alignment or one feature in the From field must be 

included. For Station Base Report command, the Station Limits option can be used to 

limit the reported information based on the specified Start and Stop station values. But 

this option only applies to computed data such as event points by interval. 
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Include leaf: At least one option from Horizontal On-Alignment Points, Horizontal 

Event Points, Vertical On-Alignment Points, Vertical Event Points, or Interval must 

be toggled on. By default, both Station Base Report and Station Offset Report are set 

to include alignment cardinal points and feature points, and measurements at 25m 

intervals as shown below: 

 

 
 

 
 

To generate the Station Base or Station Offset report, at least one horizontal alignment 

on the Horizontal Alignments leaf or one feature on the Features leaf must also be 

included.  
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Filter and wildcards can be used to specify groups of alignments. Key in * will select all 

of the alignments in the geometry project. 

 

Shown below is a sample station base report: 
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8.0 InRoads Deliverables 

 
MTO InRoads Project Template is to be used to organized all InRoads project files and 

data set. A document in Word or ASCII format shall be created in the Design Notes 

folder containing the following information: 

 

a. A brief description of the project. 

b. AutoCAD/InRoads Version used. 

c. Special software settings, customizations, and procedures. 

d. Problems encountered and work around solutions. 

e. Brief descriptions of InRoads project file(s). 

f. All other information necessary for the use of the data/files 
 

The file should use a ProjectName_IR naming convention. 
 

The complete InRoads design package consists of all the electronic data in the InRoads 

Project Template folder and its subfolder. It should include the InRoads design data and 

all supporting information necessary to reproduce the design (surfaces, drawings, reports 

etc.), and for a future designer to understand the design and use the data. The InRoads 

project data should be identical to the contents presented in the contract book. 

Unnecessary data should be deleted from the project folder prior to submission. 

 

There are different InRoads data and files required to complete the InRoads design 

project. An InRoads project may contain some or all of the following data and files:  
 

Project files (.rwk): 

A project file is composed of surfaces, a template library, coordinate geometry projects, 

roadway designs, and a preference file related to a particular project. The .rwk files must 

be updated to contain all the files needed for the design of the project or subproject(s). 
 

Preference files (.xin): 

The preference files control the display of design information. The .xin file is required to 

get alignments, profiles, sections, and other design data properly displayed. 
 

Surface Files (.dtm): 

These files contain all the information related to the existing and proposed digital terrain 

model surface.  DTM files include: 

 

Existing surfaces:   Existing ground and substratum surfaces 

Proposed surfaces:  Finish ground, material layers and subgrade surfaces 

Other surfaces:       Surfaces created for staging, non-triangulated features or any surface 

used to develop digital terrain modes, plans, profiles, cross sections, 

and quantities for the final design package. 

Geometry Project Files (.alg): 

An InRoads project may contain one or more geometry projects. The .alg file is used to 

store coordinate geometry information, superelevation, and alignment information for a 
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specific geometry project. The name of the highway should be part of the name. The 

description should be self descriptive with information such as the type and the limits of the 

alignment.  

 

Template Library (.itl): 

The template library file stores definitions for typical sections. All typical sections 

needed for the design of the project must be stored in one final design template library. 

All project related templates, components, and end conditions are organized in project 

template folder within the template library.  
 

Roadway design (Library) (.ird): 

A roadway library file stores roadway modeling definitions, design controls, and station 

and typical section information used by the Roadway Modeler command to create 

surface models along a horizontal alignment. 
 

Custom Cross Section files (.xsc):  

These files contain a list of stations and offsets for InRoads to display sections. They will 

contain constant intervals, special stations, and skewed sections. 
 

Style sheet (.xsl):  

Style sheet specifies what information to be retrieved from the XML file and how to 

format the data into a report. Any customized Style sheet shall be included.  

 

Reports (.txt, .xml, .rpt, .dat, .html and others): 

Reporting in InRoads is flexible and comprehensive. All engineering data created as a 

part of the project can be reported in InRoads. Such reports include: 

 End area volume report (quantity), 

 Cross section report (grade control), 

 Geometry report, 

 Superelevation report, and 

 Any other reports generated during the design process 

 

Drawings: (.dwg) 

Original design cross section set used to produce the earthwork quantity report shall be 

included. 
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    Default Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

General 

Default Default 0 0 2.0                         

Breaklines Breaklines BREAKLINES PD-G-TEXT 3.0                         

INR_Circle Point Circle    0  2.0 0 Circle                     

INR_Triangle Point Triangle    0  2.0 0 Tranlgle                     

INR_Square Point Square       0 Square                     

INR_Plus Sign Point Plus Sign       0 Plus Sign                     

INR_Dumbbell Point Dumbbell       0 Dumbbell                     

INR_Cross Point Cross       0 Cross                     

INR_Target Point Target       0 Target                     

INR_Circle_SP_
EN 

Point Circle - S&P 
Entrance 

  SP-E-LABELS 2.0 SP-E-ALI-E1 Circle                     

INR_Circle_SP_
SR 

Point Circle - S&P Side 
Road 

  SP-E-LABELS 2.0 SP-E-ALI-S1 Circle                     

INR_Circle_PH_
EN 

Point Circle - PH 
Entrance 

  PH-E-LABELS 2.0 PH-E-ALI-E1 Circle                     

Random Random Point   PD-G-TEXT 2.0 RANDOM Cross                     

BORDER 
Frame - Title Block 
Borders 

BORDER BORDER 3.0 BORDER Circle                     

DWGINFO Drawing Info DWGINFO DWGINFO 3.0 DWGINFO Circle                     

VPORTS Viewports VPORTS VPORTS 3.0 VPORTS Circle                     

MT-G-GRID General Grid MT-G-GRID                             
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    Default Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

MT-G-GRID-T General Grid Text   MT-G-GRID-T 3.0                         

MT-P-GRID Profile Grid           MT-P-GRID     MT-P-GRID Plus Sign           

MT-P-GRID-T Profile Grid Text             MT-P-GRID-T 3.0               

MT-T-GRID Cross Section Grid                     MT-T-GRID         

MT-T-GRID-T Cross Section Grid Text                       MT-T-GRID-T 0.4     

PD-G-CONS 
Temproray Construction 
Lines - Design 

PD-G-CONS PD-G-TEXT 2.5                         

PD-G-DIM Dimensions - Design PD-G-DIM PD-G-DIM 3.0 PD-G-DIM Plus Sign                     

PD-G-LEGEND 
Keyplan Legend - 
Design 

PD-G-LEGEND PD-G-TEXT 3.0                         

PD-G-SYMBOL 
General Symbol - 
Design 

PD-G-SYMBOL 
PD-G-
SYMBOL-IDC 

3.0 PD-G-SYMBOL Plus Sign                     

PD-G-SYMBOL-
IDC 

General Symbol IDC - 
Design 

  
PD-G-
SYMBOL-IDC 

3.0                         

PD-G-25MM 
0.25mm General Lines - 
Design 

PD-G-25MM PD-G-TEXT 3.0                         

PD-G-40MM 
0.40mm General Lines - 
Design 

PD-G-40MM PD-G-TEXT 3.0                         

PD-G-50MM 
0.50mm General Lines - 
Design 

PD-G-50MM PD-G-TEXT 3.0                         

PD-G-75MM 
0.75mm General Lines - 
Design 

PD-G-75MM PD-G-TEXT 3.0                         

PD-G-TEXT General Text - Design   PD-G-TEXT 2.0                         

PD-N-LIMIT 
Contract - Construction 
Limits - Design 

PD-N-LIMIT                             
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    Plan Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

Alignment 

PD-N-ALI-CL 
Centreline Alignment - 
Design 

PD-N-ALI-CL PD-N-ALI-CL-T 2.0     PD-P-BED-TP         PD-N-ALI-CL     PD-N-ALI-CL Plus Sign 

PD-N-ALI-CL-T 
Centreline Alignment 
Text - Design 

PD-N-ALI-CL-T PD-N-ALI-CL-T 3.0 PD-N-ALI-CL-T Circle   PD-N-ALI-CL-T 3.0       PD-N-ALI-CL-T 3.0     

PD-N-ALI-CL-
PTS 

Centreline Alignment 
Points - Circle 

  PD-N-ALI-CL-T 2.0 
PD-N-ALI-CL-
PTS 

Circle                     

PD-N-ALI-CL-
PTST 

Centreline Alignment 
Points - Triangle 

  PD-N-ALI-CL-T 2.0 
PD-N-ALI-CL-
PTS 

Tranlgle                     

Barrier 

PD-N-BAR-FL Fence - Design PD-N-BAR-FL PD-N-BAR-T 3.0     PD-N-BAR-FL PD-N-BAR-T 3.0       PD-N-BAR-T 3.0 PD-N-BAR-FL Plus Sign 

PD-N-BAR-GU3 
Guide Rail (3 Cable) - 
Design 

PD-N-BAR-
GU3 

PD-N-BAR-T 3.0     
PD-N-BAR-
GU3 

PD-N-BAR-T 3.0       PD-N-BAR-T 3.0 
PD-N-BAR-
GU3 

Plus Sign 

PD-N-BAR-GU6 
Guide Rail (6 Cable) - 
Design 

PD-N-BAR-
GU6 

PD-N-BAR-T 3.0     
PD-N-BAR-
GU6 

PD-N-BAR-T 3.0       PD-N-BAR-T 3.0 
PD-N-BAR-
GU6 

Plus Sign 

PD-N-BAR-
GUB 

Guide Rail (Box Beam) - 
Design 

PD-N-BAR-
GUB 

PD-N-BAR-T 3.0     
PD-N-BAR-
GUB 

PD-N-BAR-T 3.0       PD-N-BAR-T 3.0 
PD-N-BAR-
GUB 

Plus Sign 

PD-N-BAR-
GUC 

Guide Rail (Concrete 
Barrier) - Design 

PD-N-BAR-
GUC 

PD-N-BAR-T 3.0     
PD-N-BAR-
GUC 

PD-N-BAR-T 3.0       PD-N-BAR-T 3.0 
PD-N-BAR-
GUC 

Plus Sign 

PD-N-BAR-GUI 
Guide Rail (IBC) - 
Design 

PD-N-BAR-GUI PD-N-BAR-T 3.0     PD-N-BAR-GUI PD-N-BAR-T 3.0       PD-N-BAR-T 3.0 PD-N-BAR-GUI Plus Sign 

PD-N-BAR-
GUS 

Guide Rail (Steel Beam) 
- Design 

PD-N-BAR-
GUS 

PD-N-BAR-T 3.0     
PD-N-BAR-
GUS 

PD-N-BAR-T 3.0       PD-N-BAR-T 3.0 
PD-N-BAR-
GUS 

Plus Sign 

PD-N-BAR-IBM 
Intial Barrier Module 
(IBM) - Design 

PD-N-BAR-IBM PD-N-BAR-T 3.0     PD-N-BAR-IBM PD-N-BAR-T 3.0               

PD-N-BAR-JB Jersey Barrier - Design PD-N-BAR-JB PD-N-BAR-T 3.0     PD-N-BAR-JB PD-N-BAR-T 3.0     PD-N-BAR-JB PD-N-BAR-T 3.0 PD-N-BAR-JB Plus Sign 

PD-N-BAR-NB Noise Barrier - Design PD-N-BAR-NB PD-N-BAR-T 3.0     PD-N-BAR-NB PD-N-BAR-T 3.0     PD-N-BAR-NB PD-N-BAR-T 3.0 PD-N-BAR-NB Plus Sign 

PD-N-BAR-T Barrier Text - Design   PD-N-BAR-T 3.0       PD-N-BAR-T 3.0       PD-N-BAR-T 3.0     

Drainage 

PD-N-DRN-BD Bottom of Ditch - Design PD-N-DRN-BD PD-N-DRN-T 3.0     PD-P-DRN-BD PD-P-DRN-T 3.0     PD-N-DRN-BD PD-N-DRN-T 3.0 PD-N-DRN-BD Cross 
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    Plan Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

PD-N-DRN-CB Catch Bain - Design   PD-N-DRN-T 3.0 PD-N-DRN-CB PD_CB PD-P-DRN-CB PD-P-DRN-T 3.0 PD-P-DRN-CB Plus Sign   PD-N-DRN-T 3.0 PD-N-DRN-CB Plus Sign 

PD-N-DRN-CV Culvert - Design PD-N-DRN-CV PD-N-DRN-T 3.0     PD-P-DRN-CV PD-P-DRN-T 3.0 PD-P-DRN-CV Cross PD-N-DRN-CV PD-N-DRN-T 3.0 PD-N-DRN-CV Cross 

PD-N-DRN-DI Ditch Inlet - Design PD-N-DRN-DI PD-N-DRN-T 3.0 PD-N-DRN-DI PD_DI PD-P-DRN-DI PD-P-DRN-T 3.0 PD-P-DRN-DI Plus Sign   PD-N-DRN-T 3.0 PD-N-DRN-DI Plus Sign 

PD-N-DRN-MH Manhole - Design PD-N-DRN-MH PD-N-DRN-T 3.0 PD-N-DRN-MH PD_MH PD-P-DRN-MH PD-P-DRN-T 3.0 PD-P-DRN-MH Plus Sign   PD-N-DRN-T 3.0 PD-N-DRN-MH Plus Sign 

PD-N-DRN-RR Rip-Rap - Design PD-N-DRN-RR PD-N-DRN-T 3.0                         

PD-N-DRN-
SAN 

Sanitary Sewer Pipe - 
Design 

PD-N-DRN-
SAN 

PD-N-DRN-T 3.0     
PD-P-DRN-
SAN 

PD-P-DRN-T 3.0 
PD-P-DRN-
SAN 

Cross 
PD-N-DRN-
SAN 

PD-N-DRN-T 3.0 
PD-N-DRN-
SAN 

Cross 

PD-N-DRN-
SEW 

Storm Sewer Pipe - 
Design 

PD-N-DRN-
SEW 

PD-N-DRN-T 3.0     
PD-P-DRN-
SEW 

PD-P-DRN-T 3.0 
PD-P-DRN-
SEW 

Cross 
PD-N-DRN-
SEW 

PD-N-DRN-T 3.0 
PD-N-DRN-
SEW 

Cross 

PD-N-DRN-
SUB 

Sub Drain - Design 
PD-N-DRN-
SUB 

PD-N-DRN-T 3.0     
PD-P-DRN-
SUB 

PD-P-DRN-T 3.0 
PD-P-DRN-
SUB 

Cross 
PD-N-DRN-
SUB 

PD-N-DRN-T 3.0 
PD-N-DRN-
SUB 

Cross 

PD-N-DRN-WL Water Level - Design PD-N-DRN-WL PD-N-DRN-T 3.0     PD-N-DRN-WL PD-P-DRN-T 3.0               

PD-N-DRN-T Drainage Text - Design   PD-N-DRN-T 3.0       PD-P-DRN-T 3.0       PD-N-DRN-T 3.0     

Miscellaneous  

PD-N-MSC 
Miscellaneous (Generic 
Items) - Design 

PD-N-MSC PD-N-MSC-T 3.0 PD-N-MSC Cross PD-P-MSC PD-P-MSC-T 3.0               

PD-N-MSC-AS 
Asphalt (Miscellaneous 
Paving) - Design 

PD-N-MSC-AS PD-N-MSC-T 3.0     PD-P-MSC-AS PD-P-MSC-T 3.0     PD-N-MSC-AS PD-N-MSC-T 3.0 PD-N-MSC-AS Cross 

PD-N-MSC-BN Bull Nose - Design PD-N-MSC-BN PD-N-MSC-T 3.0     PD-P-MSC-BN PD-P-MSC-T 3.0               

PD-N-MSC-CO Concrete - Design PD-N-MSC-CO PD-N-MSC-T 3.0     PD-P-MSC-CO PD-P-MSC-T 3.0     PD-N-MSC-CO PD-N-MSC-T 3.0 PD-N-MSC-CO Plus Sign 

PD-N-MSC-
COA 

Concrete with Asphalt 
Surface - Design 

PD-N-MSC-
COA 

PD-N-MSC-T 3.0                         

PD-N-MSC-EJ 
Expansion Joint - 
Design 

PD-N-MSC-EJ PD-N-MSC-T 3.0     PD-N-MSC-EJ PD-P-MSC-T 3.0               

PD-N-MSC-EX 
Bottom of earth or rock 
Excavation - Design 

PD-N-MSC-EX PD-N-MSC-T 3.0     PD-P-MSC-EX PD-P-MSC-T 3.0     PD-N-MSC-EX PD-N-MSC-T 3.0 PD-N-MSC-EX  Plus Sign 

PD-N-MSC-
GAB 

Gabion Baskets - 
Design 

PD-N-MSC-
GAB 

PD-N-MSC-T 3.0     
PD-P-MSC-
GAB 

PD-P-MSC-T 3.0     
PD-N-MSC-
GAB 

PD-N-MSC-T 3.0     
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    Plan Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

PD-N-MSC-RW Retaining Wall - Design PD-N-MSC-RW PD-N-MSC-T 3.0     PD-P-MSC-RW PD-P-MSC-T 3.0     PD-N-MSC-RW PD-N-MSC-T 3.0 PD-N-MSC-RW Plus Sign 

PD-N-MSC-
SIGN 

Sign Footing - Design 
PD-N-MSC-
SIGN 

PD-N-MSC-T 3.0     
PD-P-MSC-
SIGN 

PD-P-MSC-T 3.0     
PD-N-MSC-
SIGN 

PD-N-MSC-T 3.0 
PD-N-MSC-
SIGN 

Plus Sign 

PD-N-MSC-
SWA 

Sidewalk - Asphalt - 
Design 

PD-N-MSC-
SWA 

PD-N-MSC-T 3.0               
PD-N-MSC-
SWA 

PD-N-MSC-T 3.0 
PD-N-MSC-
SWA 

Plus Sign 

PD-N-MSC-
SWC 

Sidewalk Concrete - 
Design 

PD-N-MSC-
SWC 

PD-N-MSC-T 3.0               
PD-N-MSC-
SWC 

PD-N-MSC-T 3.0 
PD-N-MSC-
SWC 

Plus Sign 

PD-N-MSC-T 
Miscelleneous Text - 
Design 

  PD-N-MSC-T 3.0       PD-P-MSC-T 3.0       PD-N-MSC-T 3.0     

Pavement Marking 

PD-N-PMK 
Pavement Marking - 
Design 

PD-N-PMK PD-N-PMK-T 3.0     PD-N-PMK PD-N-PMK-T 3.0       PD-N-PMK-T 3.0 PD-N-PMK Cross 

PD-N-PMK-
GORE 

Pavement Marking - 
Gore Area - Design 

PD-N-PMK-
GORE 

PD-N-PMK-T 3.0     
PD-N-PMK-
GORE 

PD-N-PMK-T 3.0       PD-N-PMK-T 3.0 
PD-N-PMK-
GORE 

Cross 

PD-N-PMK-
PMBW 

Broken White Line - 
Design 

PD-N-PMK-
PMBW 

PD-N-PMK-T 3.0     
PD-N-PMK-
PMBW 

PD-N-PMK-T 3.0       PD-N-PMK-T 3.0 
PD-N-PMK-
PMBW 

Cross 

PD-N-PMK-
PMBY 

Broken Yellow Line - 
Design 

PD-N-PMK-
PMBY 

PD-N-PMK-T 3.0     
PD-N-PMK-
PMBY 

PD-N-PMK-T 3.0       PD-N-PMK-T 3.0 
PD-N-PMK-
PMBY 

Cross 

PD-N-PMK-
PMSW 

Solid White Line - 
Design 

PD-N-PMK-
PMSW 

PD-N-PMK-T 3.0     
PD-N-PMK-
PMSW 

PD-N-PMK-T 3.0       PD-N-PMK-T 3.0 
PD-N-PMK-
PMSW 

Cross 

PD-N-PMK-
PMSY 

Solid Yellow Line - 
Design 

PD-N-PMK-
PMSY 

PD-N-PMK-T 3.0     
PD-N-PMK-
PMSY 

PD-N-PMK-T 3.0       PD-N-PMK-T 3.0 
PD-N-PMK-
PMSY 

Cross 

PD-N-PMK-T 
Pavement Marking Text 
- Design 

  PD-N-PMK-T 3.0       PD-N-PMK-T 3.0       PD-N-PMK-T 3.0     

Roadway 

PD-N-RDS-CR Crown of Road - New PD-N-RDS-CR PD-N-RDS-T 3.0     PD-N-RDS-CR PD-P-G-T 3.0     PD-N-RDS-CR PD-N-RDS-T 3.0     

PD-N-RDS-
CGA 

Curb and Gutter - 
Asphalt - Design 

PD-N-RDS-
CGA 

PD-N-RDS-T 3.0     
PD-N-RDS-
CGA 

PD-P-G-T 3.0     
PD-N-RDS-
CGA 

PD-N-RDS-T 3.0 
PD-N-RDS-
CGA 

Cross 

PD-N-RDS-
CGC 

Curb and Gutter - 
Concrete - Design 

PD-N-RDS-
CGC 

PD-N-RDS-T 3.0     
PD-N-RDS-
CGC 

PD-P-G-T 3.0     
PD-N-RDS-
CGC 

PD-N-RDS-T 3.0 
PD-N-RDS-
CGC 

Plus Sign 

PD-N-RDS-EP 
Edge of Pavement - 
Design 

PD-N-RDS-EP PD-N-RDS-T 3.0     PD-P-BED-EP PD-P-BED-T 3.0     PD-N-RDS-EP     PD-N-RDS-EP Square 

PD-N-RDS-EPS 
Edge of Paved Shoulder 
- Design 

PD-N-RDS-
EPS 

PD-N-RDS-T 3.0     
PD-P-BED-
EPS 

PD-P-BED-T 3.0     
PD-N-RDS-
EPS 

    
PD-N-RDS-
EPS 

Cross 
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    Plan Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

PD-N-RDS-ES 
Edge of Graunlar 
Shoulder - Design 

PD-N-RDS-ES PD-N-RDS-T 3.0     PD-N-RDS-ES PD-P-G-T 3.0     PD-N-RDS-ES     PD-N-RDS-ES Cross 

PD-N-RDS-TC Top of Cut - Design PD-N-RDS-TC PD-N-RDS-T 3.0     PD-P-BED-TC PD-P-BED-T 3.0     PD-N-RDS-TC     PD-N-RDS-TC Plus Sign 

PD-N-RDS-TS 
Toe of Fill Slope - 
Design 

PD-N-RDS-TS PD-N-RDS-T 3.0     PD-P-BED-TS PD-P-BED-T 3.0     PD-N-RDS-TS     PD-N-RDS-TS Plus Sign 

PD-N-RDS-UR Unpaved Road - Design PD-N-RDS-UR PD-N-RDS-T 3.0     PD-N-RDS-UR PD-P-MSC-T 3.0       PD-N-RDS-T 3.0 PD-N-RDS-UR Cross 

PD-N-RDS-T Road Text - Design   PD-N-RDS-T 3.0       PD-P-BED-T 3.0       PD-N-RDS-T 3.0     

Property and Right of Way  

PD-N-ROW-PLI 
Limited Interest - 
Permanent - Design 

PD-N-ROW-
PLI 

PD-N-ROW-T 3.0               
PD-N-ROW-
PLI 

PD-N-ROW-T 3.0 
PD-N-ROW-
PLI 

ROW_Prop 

PD-N-ROW-TLI 
Limited Intyerest - 
Temporary - Design 

PD-N-ROW-TLI PD-N-ROW-T 3.0               PD-N-ROW-TLI PD-N-ROW-T 3.0 PD-N-ROW-TLI ROW_Prop 

PD-N-ROW-PRI 
Property Required - 
Intermediate - Design 

PD-N-ROW-
PRI 

PD-N-ROW-T 3.0               
PD-N-ROW-
PRI 

PD-N-ROW-T 3.0 
PD-N-ROW-
PRI 

ROW_Prop 

PD-N-ROW-
PRU 

Property Required - 
Ultimate - Design 

PD-N-ROW-
PRU 

PD-N-ROW-T 3.0               
PD-N-ROW-
PRU 

PD-N-ROW-T 3.0 
PD-N-ROW-
PRU 

ROW_Prop 

PD-N-ROW-
DEL 

Property Deletion - 
Design 

PD-N-ROW-
DEL 

PD-N-ROW-T 3.0                         

PD-N-ROW-T 
Property and ROW Text 
- Design 

  PD-N-ROW-T 3.0                 PD-N-ROW-T 3.0     

Vegetation 

PD-N-VEG-
SOD 

Sod - Design 
PD-N-VEG-
SOD 

PD-N-VEG-T 3.0                         

PD-N-VEG-WO 
Vegetation Wood 
Outline - Design 

PD-N-VEG-WO PD-N-VEG-T 3.0                         

PD-N-VEG-T Vegetation Text - Design   PD-N-VEG-T 3.0                         

General Profile 

PD-P-LIMIT 
Profile Contract 
Construction Limits - 
Design 

          PD-P-LIMIT                   

PD-P-LIMIT-T 
Profile Job Limits Text - 
Design 

            PD-P-LIMIT-T 3.0               
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    Plan Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

PD-P-G-T General Text - Profile             PD-P-G-T 3.0               

Road Bed Profile 

PD-P-BED-GRA 
Top of Granular A - 
Profile - Design 

          
PD-P-BED-
GRA 

PD-P-BED-T 3.0               

PD-P-BED-GRB 
Top of Granular B - 
Profile - Design 

          
PD-P-BED-
GRB 

PD-P-BED-T 3.0               

PD-P-BED-SG 
Subgrade - Profile - 
Design 

          PD-P-BED-SG PD-P-BED-T 3.0               

PD-P-BED-TCL 
Top of Cut - Left Side - 
Profile - Design 

          PD-P-BED-TCL PD-P-BED-T 3.0               

PD-P-BED-TCR 
Top of Cut - Right Side - 
Profile - Design 

          
PD-P-BED-
TCR 

PD-P-BED-T 3.0               

PD-P-BED-TF 
Top of Filter Course - 
Profile - Design 

          PD-P-BED-TF PD-P-BED-T 3.0               

PD-P-BED-TP 
Top of Pavement - 
Profile - Design 

          PD-P-BED-TP PD-P-BED-T 3.0               

PD-P-BED-TSL 
Toe of Fill Slope - Left - 
Profile - Design 

          PD-P-BED-TSL PD-P-BED-T 3.0               

PD-P-BED-TSR 
Toe of Fill Slope - Right 
- Profile - Design 

          
PD-P-BED-
TSR 

PD-P-BED-T 3.0               

PD-P-BED-
VALBL 

Vertical Align. Stations - 
Tables - Design 

            
PD-P-BED-
VALBL 

3.0               

PD-P-BED-
VAPTS 

Vertical Align. VPI - 
Tangents - Design 

          
PD-P-BED-
VAPTS 

    
PD-P-BED-
VAPTS 

Circle           

PD-P-BED-T 
Profile Roadbed Text - 
Design 

            PD-P-BED-T 3.0               

Drainage Profile 

PD-P-DRN-BDL 
Bottom of Ditch - Left - 
Profile - Design 

          
PD-P-DRN-
BDL 

PD-P-BED-T 3.0               

PD-P-DRN-
BDM 

Bottom of Ditch Median - 
Profile - Design 

          
PD-P-DRN-
BDM 

PD-P-BED-T 3.0               

PD-P-DRN-
BDR 

Bottom of Ditch - Right - 
Profile - Design 

          
PD-P-DRN-
BDR 

PD-P-BED-T 3.0               

PD-P-DRN-CB 
Catch Basin - Profile - 
Design 

          PD-N-DRN-CB PD-R-DRN-T 3.0 PD-N-DRN-CB Cross           
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    Plan Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

PD-P-DRN-CV Culvert - Profile - Design           PD-P-DRN-CV PD-P-DRN-T 3.0 PD-P-DRN-CV Cross           

PD-P-DRN-DI 
Ditch Inlet - Profile - 
Design 

          PD-P-DRN-DI PD-P-DRN-T 3.0 PD-P-DRN-DI Cross           

PD-P-DRN-MH 
Manhole - Profile - 
Design 

          PD-P-DRN-MH PD-P-DRN-T 3.0 PD-P-DRN-MH Cross           

PD-P-DRN-SAN 
Sanitary Sewer Pipe - 
Profile - Design 

          
PD-P-DRN-
SAN 

PD-P-DRN-T 3.0 
PD-P-DRN-
SAN 

Cross           

PD-P-DRN-
SEW 

Storm Sewer Pipe - 
Profile - Design 

          
PD-P-DRN-
SEW 

PD-P-DRN-T 3.0 
PD-P-DRN-
SEW 

Cross           

PD-P-DRN-SUB 
Sub Drain - Profile - 
Design 

          
PD-P-DRN-
SUB 

PD-P-DRN-T 3.0 
PD-P-DRN-
SUB 

Cross           

PD-P-DRN-T 
Profile Drainage Text - 
Design 

            PD-P-DRN-T 3.0               

Ground Profile  

PD-P-GND-
MUB 

Bottom of Muskeg - 
Profile - Design 

          
PD-P-GND-
MUB 

PD-P-GND-T 3.0               

PD-P-GND-
MUT 

Top of Muskeg - Profile - 
Design 

          
PD-P-GND-
MUT 

PD-P-GND-T 3.0               

PD-P-GND-OG 
Original Ground - Profile 
- Design 

          PD-P-GND-OG PD-P-GND-T 3.0               

PD-P-GND-RK 
Top of Rock - Profile - 
Design 

          PD-P-GND-RK PD-P-GND-T 3.0               

PD-P-GND-T 
Profile Ground Text - 
Design 

            PD-P-GND-T 3.0               

Miscellaneous Profile 

PD-P-MSC 
Profile Miscellaneous 
lines - Design 

          PD-P-MSC PD-P-MSC-T 3.0               

PD-P-MSC-EF 
Earh Fill - Profile - 
Design 

          PD-P-MSC-EF PD-P-MSC-T 3.0               

PD-P-MSC-EX 
Bottom of earth or rock 
Excavation - Profile - 
Design 

          PD-P-MSC-EX PD-P-MSC-T 3.0               

PD-P-MSC-RF 
Rock Fill - Profile - 
Design 

          PD-P-MSC-RF PD-P-MSC-T 3.0               

PD-P-MSC-SH Shatter - Profile - Design           PD-P-MSC-SH PD-P-MSC-T 3.0               



Appendix A 

InRoads Symbologies for Planning and Design 
 

InRoads Preference and Standards Manual – Version 3.0            Appendix A - 9 

    Plan Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

PD-P-MSC-T 
Profile Miscellaneous 
Text - Design 

            PD-P-MSC-T 3.0               

Removal 

PD-R-BAR-FL Fence - Removal PD-R-BAR-FL PD-R-BAR-T 3.0                         

PD-R-BAR-GU Guide Rail - Removal PD-R-BAR-GU PD-R-BAR-T 3.0                         

PD-R-BAR-T Removal Barrier Text   PD-R-BAR-T 3.0                         

PD-R-DRN-CB Catch Basin - Removal PD-R-DRN-CB PD-R-DRN-T 3.0 PD-R-DRN-CB Plus Sign                     

PD-R-DRN-CV Culvert - Removal PD-R-DRN-CV PD-R-DRN-T 3.0                         

PD-R-DRN-MH Manhole - Removal PD-R-DRN-MH PD-R-DRN-T 3.0 PD-R-DRN-MH Plus Sign                     

PD-R-DRN-
SAN 

Sanitary Sewer Pipe - 
Removal 

PD-R-DRN-
SAN 

PD-R-DRN-T 3.0                         

PD-R-DRN-
SEW 

Storm Sewer Pipe - 
Removal 

PD-R-DRN-
SEW 

PD-R-DRN-T 3.0                         

PD-R-DRN-
SUB 

Sub Drain - Removal 
PD-R-DRN-
SUB 

PD-R-DRN-T 3.0                         

PD-R-DRN-T Removal Drainage Text   PD-R-DRN-T 3.0                         

PD-R-MSC 
Miscellaneous items - 
Removal 

PD-R-MSC PD-R-MSC-T 3.0                         

PD-R-MSC-AS 
Asphalt Pavement - 
Removal 

PD-R-MSC-AS PD-R-MSC-T 3.0                         

PD-R-MSC-CO 
Concrete Pavement - 
Removal 

PD-R-MSC-CO PD-R-MSC-T 3.0                         

PD-R-MSC-
COA 

Concrete with Asphalt 
Surface - Removal 

PD-R-MSC-
COA 

PD-R-MSC-T 3.0                         

PD-R-MSC-
SWA 

Sidewalk - Asphalt - 
Removal 

PD-R-MSC-
SWA 

PD-R-MSC-T 3.0                         

PD-R-MSC-
SWC 

Sidewalk Concrete - 
Removal 

PD-R-MSC-
SWC 

PD-R-MSC-T 3.0                         

PD-R-MSC-T 
Removal Miscellaneous 
Text 

  PD-R-MSC-T 3.0                         
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    Plan Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

PD-R-RDS-
CGA 

Curb and Gutter - 
Asphalt - Removal 

PD-R-RDS-
CGA 

PD-R-RDS-T 3.0                         

PD-R-RDS-
CGC 

Curb and Gutter - 
Concrete - Removal 

PD-R-RDS-
CGC 

PD-R-RDS-T 3.0                         

PD-R-RDS-UR 
Edge of Unpaved Road - 
Removal 

PD-R-RDS-UR PD-R-RDS-T 3.0                         

PD-R-RDS-T Removal Road Text   PD-R-RDS-T 3.0                         

PD-R-VEG-CLR Cleared - Removal 
PD-R-VEG-
CLR 

PD-R-VEG-T 3.0                         

PD-R-VEG-
CLRCUT 

Close Cut Cleared - 
Removal 

PD-R-VEG-
CLRCUT 

PD-R-VEG-T 3.0                         

PD-R-VEG-
CLRGRB 

Cleared & Grubbed - 
Removal 

PD-R-VEG-
CLRGRB 

PD-R-VEG-T 3.0                         

PD-R-VEG-
GRB 

Grubbed - Removal 
PD-R-VEG-
GRB 

PD-R-VEG-T 3.0                         

PD-R-VEG-T 
Removal Vegetation 
Text 

  PD-R-VEG-T 3.0                         

Typical Section 

PD-T-25MM 0.25mm Line - Typical                     PD-T-25MM         

PD-T-25MM-P 0.25mm Hatch - Typical                     PD-T-25MM-P         

PD-T-30MM 0.30mm Line - Typical                     PD-T-30MM         

PD-T-30MM-P 0.30mm Hatch - Typical                     PD-T-30MM-P         

PD-T-40MM 0.40mm Line - Typical                     PD-T-40MM         

PD-T-40MM-
DASH 

0.40mm Dashed Line - 
Typical 

                    
PD-T-40MM-
DASH 

        

PD-T-50MM 0.50mm Line - Typical                     PD-T-50MM         

PD-T-50MM-P 0.50mm Hatch - Typical                     PD-T-50MM-P         

PD-T-75MM 0.75mm Line - Typical                     PD-T-75MM         
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    Plan Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

PD-T-CL Centreline  - Typical                     PD-T-CL         

PD-T-DIM Dimensions - Typical                       PD-T-DIM 3.0     

PD-T-OG 
Original Ground - 
Typical 

                    PD-T-OG         

PD-T-OG-ELEV 
Cross Section 
Annotation - OG 
Elevation 

                      
PD-T-OG-
ELEV 

2.0     

PD-T-OG-OFF 
Cross Section 
Annotation - OG Offset 

                      PD-T-OG-OFF 2.0     

PD-T-NOTE-T General Notes - Typical                       PD-T-NOTE-T 3.0     

PD-T-TEXT All Text for Typicals                       PD-T-TEXT 2.0     

PD-T-TP-OFF 
Cross Section 
Annotation - TP Offset 

                      PD-T-TP-OFF 2.0     

PD-T-TP-ELEV 
Cross Section 
Annotation - TP 
Elevation 

                      PD-T-TP-ELEV 2.0     

PD-T-SG-ELEV 
Cross Section 
Annotation - SG 
Elevation 

                      
PD-T-SG-
ELEV 

2.0     

PD-T-SG-OFF 
Cross Section 
Annotation - SG Offset 

                      PD-T-SG-OFF 2.0     



Appendix A 

InRoads Symbologies for Planning and Design 
 

InRoads Preference and Standards Manual – Version 3.0            Appendix A - 12 

 

    Plan Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

Template Points 

Auxiliary Point 
Template Auxiliary Point 
IP, IBR 

PD-N-MSC                   PD-N-MSC PD-N-RDS-T 2.0 PD-N-MSC Plus Sign 

Centerline 
Alignment 

Centerline Alignment 
(Point CL) 

PD-N-ALI-CL PD-N-ALI-CL-T 3.0               PD-N-ALI-CL PD-N-RDS-T 2.0 PD-N-ALI-CL Circle 

Curb and Gutter 
(Asphalt) 

Asphalt Curb and Gutter 
(Point CU &  GU) 

PD-N-RDS-
CGA 

PD-N-RDS-T 3.0     
PD-N-RDS-
CGA 

PD-P-G-T 3.0     
PD-N-RDS-
CGA 

PD-N-RDS-T 3.0 
PD-N-RDS-
CGA 

* 

Curb and Gutter 
(Concrete) 

Concrete Curb and 
Gutter (Point CU &  GU) 

PD-N-RDS-
CGC 

PD-N-RDS-T 3.0     
PD-N-RDS-
CGC 

PD-P-G-T 3.0     
PD-N-RDS-
CGC 

PD-N-RDS-T 3.0 
PD-N-RDS-
CGC 

* 

Edge of 
Pavement 

Edge of Pavement 
(Point EP) 

PD-N-RDS-EP PD-N-RDS-T 3.0     PD-P-BED-EP PD-P-BED-T 3.0     PD-N-RDS-EP     PD-N-RDS-EP Square 

Edge of 
Shoulder 

Edge of Shoulder (Point 
ES) 

PD-N-RDS-ES PD-N-RDS-T 3.0     PD-P-BED-ES PD-P-BED-T 3.0     PD-N-RDS-ES     PD-N-RDS-ES Cross 

Edge of Paved 
Shoulder 

Edge of Paved Shoulder 
(Point EPS) 

PD-N-RDS-
EPS 

PD-N-RDS-T 3.0     
PD-P-BED-
EPS 

PD-P-BED-T 3.0     
PD-N-RDS-
EPS 

    
PD-N-RDS-
EPS 

Cross 

Edge of 
Rounding 

Edge of Rounding (Point 
ER) 

PD-N-RDS-ER PD-N-RDS-T 3.0               PD-N-RDS-ER     PD-N-RDS-ER Cross 

Rounding 
Breakpoint 

Rounding Point (Point 
BR) 

PD-N-RDS-BR                   PD-N-RDS-BR     PD-N-RDS-BR Plus Sign 

Granular 
Rounding 

Granular Rounding 
(Point GR) 

PD-N-RDS-GR PD-N-RDS-T 3.0               PD-N-RDS-GR     PD-N-RDS-GR Plus Sign 

Granular 
Shoulder 

Granular Shoulder 
(Point GS) 

PD-N-RDS-GS PD-N-RDS-T 3.0               PD-N-RDS-GS     PD-N-RDS-GS Plus Sign 

Bottom of Ditch 
Bottom of Ditch (Point 
BC, CH, MD, DI, DO) 

PD-N-DRN-BD PD-N-DRN-T 3.0     PD-N-DRN-BD PD-P-DRN-T 3.0     PD-N-DRN-BD     PD-N-DRN-BD Cross 

Bottom of Ditch 
- Lt 

Bottom of Ditch, Left - 
Design 

PD-N-DRN-BD PD-N-DRN-T 3.0     
PD-P-DRN-
BDL 

PD-P-DRN-T 3.0     PD-N-DRN-BD PD-N-DRN-T 3.0 PD-N-DRN-BD Cross 

Bottom of Ditch 
- MD 

Bottom of Ditch, Median 
- Design 

PD-N-DRN-BD PD-N-DRN-T 3.0     
PD-P-DRN-
BDM 

PD-P-DRN-T 3.0     PD-N-DRN-BD PD-N-DRN-T 3.0 PD-N-DRN-BD Cross 

Bottom of Ditch 
- Rt 

Bottom of Ditch, Right - 
Design 

PD-N-DRN-BD PD-N-DRN-T 3.0     
PD-P-DRN-
BDR 

PD-P-DRN-T 3.0     PD-N-DRN-BD PD-N-DRN-T 3.0 PD-N-DRN-BD Cross 

Rock 
Rock (Point RFT, RFB, 
BRK, RBI) 

PD-N-RDS-RK PD-N-RDS-T 3.0     PD-P-GND-RK PD-P-GND-T 3.0     PD-N-RDS-RK PD-N-RDS-T 3.0 PD-N-RDS-RK Cross 

Rock Shatter 
Rock Shatter (Point SH, 
IB) 

PD-N-RDS-SH PD-N-RDS-T 3.0     PD-P-MSC-SH PD-P-MSC-T 3.0     PD-N-RDS-SH PD-N-RDS-T 3.0 PD-N-RDS-SH Cross 

Earth Bench 
Earth Bench (Point EBI, 
EBO, OB) 

PD-N-RDS-EB                   PD-N-RDS-EB     PD-N-RDS-EB Cross 
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    Plan Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

Subdrain Subdrain (Point SD) 
PD-N-DRN-
SUB 

PD-N-DRN-T 3.0     
PD-P-DRN-
SUB 

PD-P-DRN-T 3.0 
PD-P-DRN-
SUB 

Cross 
PD-N-DRN-
SUB 

PD-N-DRN-T 3.0 
PD-N-DRN-
SUB 

Cross 

Top of Cut Top of Cut (Point TC) PD-N-RDS-TC PD-N-RDS-T 3.0     PD-P-BED-TC PD-P-BED-T 3.0     PD-N-RDS-TC     PD-N-RDS-TC Plus Sign 

Top of Cut - Lt 
Top of Cut (Point TC) - 
Left 

PD-N-RDS-TC PD-N-RDS-T 3.0     
PD-P-BED-
TCL 

PD-P-BED-T 3.0     PD-N-RDS-TC     PD-N-RDS-TC Plus Sign 

Top of Cut - Rt 
Top of Cut (Point TC) - 
Right 

PD-N-RDS-TC PD-N-RDS-T 3.0     
PD-P-BED-
TCR 

PD-P-BED-T 3.0     PD-N-RDS-TC     PD-N-RDS-TC Plus Sign 

Toe of Fill Slope Toe of Slope (Point TS) PD-N-RDS-TS PD-N-RDS-T 3.0     PD-P-BED-TS PD-P-BED-T 3.0     PD-N-RDS-TS     PD-N-RDS-TS Plus Sign 

Toe of Fill Slope 
- Lt 

Toe of Slope (Point TS) 
- Left 

PD-N-RDS-TS PD-N-RDS-T 3.0     
PD-P-BED-
TSL 

PD-P-BED-T 3.0     PD-N-RDS-TS     PD-N-RDS-TS Plus Sign 

Toe of Fill Slope 
- Rt 

Toe of Slope (Point TS) 
- Right 

PD-N-RDS-TS PD-N-RDS-T 3.0     
PD-P-BED-
TSR 

PD-P-BED-T 3.0     PD-N-RDS-TS     PD-N-RDS-TS Plus Sign 

Raised Berm Raised Berm (Point RB) PD-N-RDS-RB                   PD-N-RDS-RB     PD-N-RDS-RB Cross 

Retaining Wall 
Reatining Wall (Point 
RW) 

PD-N-MSC-RW PD-N-MSC-T 3.0     
PD-P-MSC-
RW 

PD-P-MSC-T 3.0     
PD-N-MSC-
RW 

PD-N-MSC-T 3.0 PD-N-MSC-RW Plus Sign 

Sidewalk 
(Asphalt) 

Asphalt Sidewalk (Point 
SW) 

PD-N-MSC-
SWA 

PD-N-MSC-T 3.0               
PD-N-MSC-
SWA 

PD-N-MSC-T 3.0 
PD-N-MSC-
SWA 

Cross 

Sidewalk 
(Concrete) 

Concrete Sidewalk 
(Point SW) 

PD-N-MSC-
SWC 

PD-N-MSC-T 3.0               
PD-N-MSC-
SWC 

PD-N-MSC-T 3.0 
PD-N-MSC-
SWA 

Cross 

Muskeg Muskeg (Point MU) PD-N-RDS-ME PD-N-RDS-T 3.0     
PD-P-GND-
MUT 

PD-P-GND-T 3.0     PD-N-RDS-ME     PD-N-RDS-ME Plus Sign 

Barrier Barrier (Point BA) 
PD-N-RDS-
BAR 

PD-N-RDS-T 3.0     
PD-N-RDS-
BAR 

PD-P-G-T 3.0     
PD-N-RDS-
BAR 

    
PD-N-RDS-
BAR 

Plus Sign 

Jersey Barrier Jersey Barrier (Point JB) PD-N-BAR-JB PD-N-BAR-T 3.0     PD-N-BAR-JB PD-P-G-T 3.0     PD-N-BAR-JB     PD-N-BAR-JB Plus Sign 

Template Components 

Asphalt Top 
Course 

Asphalt Top Course 
PD-N-RDS-
ATC 

                  
PD-N-RDS-
ATC 

PD-N-RDS-T 3.0     

Asphalt Base 
Course 1 

Asphalt Base Course 1 PD-N-RDS-A1                   PD-N-RDS-A1 PD-N-RDS-T 3.0     

Asphalt Base 
Course 2 

Asphalt Base Course 2 PD-N-RDS-A2                   PD-N-RDS-A2 PD-N-RDS-T 3.0     

Asphalt Base 
Course 3 

Asphalt Base Course 3 PD-N-RDS-A3                   PD-N-RDS-A3 PD-N-RDS-T 3.0     
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    Plan Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

Asphalt Base 
Course 4 

Asphalt Base Course 4 PD-N-RDS-A4                   PD-N-RDS-A4 PD-N-RDS-T 3.0     

Asphalt 
Shoulder Top 
Course 

Asphalt Shoulder Top 
Course 

PD-N-RDS-AS1                   
PD-N-RDS-
AS1 

PD-N-RDS-T 3.0     

Asphalt 
Shoulder Base 
Course 

Asphalt Shoulder Base 
Course 

PD-N-RDS-AS2                   
PD-N-RDS-
AS2 

PD-N-RDS-T 3.0     

Concrete 
Pavement 

Concrete Pavement PD-N-MSC-CO                   PD-N-MSC-CO PD-N-MSC-T 3.0     

Curb and Gutter 
(Asphalt) 

Asphalt Curb and Gutter 
(Point CU &  GU) 

PD-N-RDS-
CGA 

PD-N-RDS-T 3.0     
PD-N-RDS-
CGA 

PD-P-G-T 3.0     
PD-N-RDS-
CGA 

PD-N-RDS-T 3.0 
PD-N-RDS-
CGA 

* 

Curb and Gutter 
(Concrete) 

Concrete Curb and 
Gutter (Point CU &  GU) 

PD-N-RDS-
CGC 

PD-N-RDS-T 3.0     
PD-N-RDS-
CGC 

PD-P-G-T 3.0     
PD-N-RDS-
CGC 

PD-N-RDS-T 3.0 
PD-N-RDS-
CGC 

* 

Granular A Granular A PD-N-RDS-GU                   PD-N-RDS-GU PD-N-RDS-T 3.0     

Granular B Granular B PD-N-RDS-GL                   PD-N-RDS-GL PD-N-RDS-T 3.0     

Granular 
Shoulder 

Granular Shoulder 
(Point GS) 

PD-N-RDS-GS PD-N-RDS-T 3.0               PD-N-RDS-GS     PD-N-RDS-GS Plus Sign 

Jersey Barrier Jersey Barrier (Point JB) PD-N-BAR-JB PD-N-BAR-T 3.0     PD-N-BAR-JB PD-P-G-T 3.0     PD-N-BAR-JB     PD-N-BAR-JB Plus Sign 

Curb & Gutter 
OPSD 600.010 

Curb & Gutter OPSD 
600.010 

PD-N-RDS-
CGC 

                  
PD-N-RDS-
CGC 

PD-N-RDS-T 3.0     

Curb & Gutter 
OPSD 600.020 

Curb & Gutter OPSD 
600.020 

PD-N-RDS-
CGC 

                  
PD-N-RDS-
CGC 

PD-N-RDS-T 3.0     

Curb & Gutter 
OPSD 600.030 

Curb & Gutter OPSD 
600.030 

PD-N-RDS-
CGC 

                  
PD-N-RDS-
CGC 

PD-N-RDS-T 3.0     

Curb & Gutter 
OPSD 600.040 

Curb & Gutter OPSD 
600.040 

PD-N-RDS-
CGC 

                  
PD-N-RDS-
CGC 

PD-N-RDS-T 3.0     

Curb & Gutter 
OPSD 600.050 

Curb & Gutter OPSD 
600.050 

PD-N-RDS-
CGC 

                  
PD-N-RDS-
CGC 

PD-N-RDS-T 3.0     

Curb & Gutter 
OPSD 600.060 

Curb & Gutter OPSD 
600.060 

PD-N-RDS-
CGC 

                  
PD-N-RDS-
CGC 

PD-N-RDS-T 3.0     

Curb & Gutter 
OPSD 600.070 

Curb & Gutter OPSD 
600.070 

PD-N-RDS-
CGC 

                  
PD-N-RDS-
CGC 

PD-N-RDS-T 3.0     

Curb & Gutter 
OPSD 600.080 

Curb & Gutter OPSD 
600.080 

PD-N-RDS-
CGC 

                  
PD-N-RDS-
CGC 

PD-N-RDS-T 3.0     

Curb & Gutter 
OPSD 600.090 

Curb & Gutter OPSD 
600.090 

PD-N-RDS-
CGC 

                  
PD-N-RDS-
CGC 

PD-N-RDS-T 3.0     
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    Plan Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

Curb & Gutter 
OPSD 600.100 

Curb & Gutter OPSD 
600.100 

PD-N-RDS-
CGC 

                  
PD-N-RDS-
CGC 

PD-N-RDS-T 3.0     

Curb & Gutter 
OPSD 600.110 

Curb & Gutter OPSD 
600.110 

PD-N-RDS-
CGC 

                  
PD-N-RDS-
CGC 

PD-N-RDS-T 3.0     

Curb & Gutter 
OPSD 601.010 

Curb & Gutter OPSD 
601.010 

PD-N-RDS-
CGC 

                  
PD-N-RDS-
CGC 

PD-N-RDS-T 3.0     

Muskeg Backfill Muskeg Backfill                     PD-N-RDS-MB PD-N-RDS-T 3.0     

Muskeg 
Excavation 

Muskeg Excavation                     PD-N-RDS-ME PD-N-RDS-T 3.0     

Cut Cut PD-N-RDS-TC                   PD-N-RDS-TC PD-N-RDS-T 2.0     

Fill Fill PD-N-RDS-TS                   PD-N-RDS-TS PD-N-RDS-T 2.0     

Milling Milling PD-N-MSC-MI PD-N-MSC-T 3.0               PD-N-MSC-MI PD-N-MSC-T 3.0   

Rock Cut Rock Cut PD-N-RDS-RC                   PD-N-RDS-RC PD-N-RDS-T 3.0     

Rock Fill Rock Fill PD-N-RDS-RK                   PD-N-RDS-RK PD-N-RDS-T 3.0     

Rock Shatter 
Rock Shatter (Point SH, 
IB) 

PD-N-RDS-SH PD-N-RDS-T 3.0     PD-P-MSC-SH PD-P-MSC-T 3.0     PD-N-RDS-SH PD-N-RDS-T 3.0 PD-N-RDS-SH Cross 

Rock Shatter 
(Partial) 

Rock Shatter (Partial for 
deduction) 

PD-N-RDS-SH              PD-N-RDS-SH PD-N-RDS-T 3.0   

Sidewalk 
(Asphalt) 

Asphalt Sidewalk (Point 
SW) 

PD-N-MSC-
SWA 

PD-N-MSC-T 3.0               
PD-N-MSC-
SWA 

PD-N-MSC-T 3.0 
PD-N-MSC-
SWA 

Cross 

Sidewalk 
(Concrete) 

Concrete Sidewalk 
(Point SW) 

PD-N-MSC-
SWC 

PD-N-MSC-T 3.0               
PD-N-MSC-
SWC 

PD-N-MSC-T 3.0 
PD-N-MSC-
SWA 

Cross 

Stripping Stripping 
PD-N-MSC-
Stripping 

PD-N-MSC-T 3.0               
PD-N-MSC-
Stripping 

PD-N-MSC-T 3.0 
PD-N-MSC-
Stripping 

Cross 

Subdrain Subdrain (Point SD) 
PD-N-DRN-
SUB 

PD-N-DRN-T 3.0     
PD-P-DRN-
SUB 

PD-P-DRN-T 3.0 
PD-P-DRN-
SUB 

Cross 
PD-N-DRN-
SUB 

PD-N-DRN-T 3.0 
PD-N-DRN-
SUB 

Cross 

V Median Ditch Median Ditch 
PD-N-RDS-
MED 

                  
PD-N-RDS-
MED 

        

DTM  

DTM_OG 
Original Ground - 
Existing 

          PD-P-GND-OG PD-P-GND-T 3.0     PD-T-OG PD-T-OG-T 3.0 PD-T-OG Plus Sign 
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    Plan Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

DTM_OG (SP) Original Ground - S&P           SP-P-ALI-CL SP-G-TEXT 3.0     SP-G-40MM SP-G-TEXT 3.0 SP-G-40MM Plus Sign 

DTM_Proposed Proposed Surface           PD-P-BED-TP PD-P-BED-T 3.0     PD-T-TP PD-T-TEXT 3.0 PD-T-TP Plus Sign 

DTM_TP 
(Asphalt) 

Top of Designed 
Surface - Asphalt 

          PD-P-BED-TP PD-P-BED-T 3.0     PD-N-SF-AP PD-N-RDS-T 3.0 PD-N-SF-AP Cross 

DTM_TP 
(Concrete) 

Top of Designed 
Surface - Concrete 

          PD-P-BED-TP PD-P-BED-T 3.0     PD-N-SF-CO PD-N-RDS-T 3.0 PD-N-SF-CO Cross 

DTM_TA 
Top of Granular A 
Surface 

          
PD-P-BED-
GRA 

PD-P-BED-T 3.0     PD-N-SF-TA PD-N-RDS-T 3.0 PD-N-SF-TA Circle 

DTM_TB 
Top of Granular B 
Surface 

          
PD-P-BED-
GRB 

PD-P-BED-T 3.0     PD-N-SF-TB PD-N-RDS-T 3.0 PD-N-SF-TB Plus Sign 

DTM_SG Subgrade Surface           PD-P-BED-SG PD-P-BED-T 3.0     PD-N-SF-SG PD-N-RDS-T 3.0 PD-N-SF-SG Plus Sign 

DTM_Rock 
Shatter 

Rock Shatter Surface           PD-P-MSC-SH PD-P-G-T 3.0     PD-N-SF-SH PD-N-RDS-T 3.0 PD-N-SF-SH Cross 

DTM_Rock 
Survey 

Rock Survey Surface           
SP-E-GND-
RKS 

PD-P-BED-T 3.0     
SP-E-GND-
RKS 

PD-N-RDS-T 3.0 
SP-E-GND-
RKS 

Cross 

DTM_Rock 
Design 

Rock Design Surface           PD-P-GND-RK PD-P-BED-T 3.0     PD-N-SF-RK PD-N-RDS-T 3.0 PD-N-SF-RK Cross 

DTM_Muskeg 
Survey 

Muskeg Survey Surface           SP-E-GND-MU PD-P-BED-T 3.0     SP-E-GND-MU PD-N-RDS-T 3.0 SP-E-GND-MU Cross 

DTM Boundary Surface Boundary 
PD-SF-
BOUNDARY 

PD-G-TEXT 3.0                         

DTM Triangles DTM Triangles 
PD-SF-
TRIANGLES 

PD-G-TEXT 3.0                         

Contours-Major Contours CONT-MJR CONT-LABELS 2.5                         

Contours-Minor Contours CONT-MNR CONT-LABELS 2.5                         

Contour Labels Contour Labels   CONT-LABELS 2.0                         
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    Default Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

Photogrammetry General 

PH-G-25MM 0.25mm Line - Existing PH-G-25MM PH-G-TEXT 3.0                         

PH-G-40MM 0.40mm Line - Existing PH-G-40MM PH-G-TEXT 3.0                         

PH-G-50MM 0.50mm Line - Existing PH-G-50MM PH-G-TEXT 3.0                         

PH-G-75MM 0.75mm Line - Existing PH-G-75MM PH-G-TEXT 3.0                         

PH-G-TEXT General Text - Existing   PH-G-TEXT 3.0                         

PH-E-
SCANNED 

Scanned Images - 
Existing 

PH-E-
SCANNED 

PH-G-TEXT 3.0 
PH-E-
SCANNED 

Plus Sign                     

PH-G-
SYMBOLS 

Symbols - Existing 
PH-G-
SYMBOLS 

PH-G-TEXT 3.0 
PH-G-
SYMBOLS 

Plus Sign                     

PH-E-LABELS String Labels - Existing             PH-E-LABELS 3.0               

Survey Monument 

PH-E-MON 
Horizontal Control - 
Existing 

PH-E-MON PH-E-MON 3.0 PH-E-MON Circle                     

PH-E-MON-BM 
Vertical Control - 
Existing 

PH-E-MON-BM PH-E-MON-BM 3.0 PH-E-MON-BM Circle                     
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    Plan Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

Alignment 

PH-E-ALI-E1 
Entrance Alignment - 
Existing 

PH-E-ALI-E1 PH-E-LABELS 2.0 PH-E-ALI-E1 Circle PH-E-ALI-E1         PH-E-ALI-E1     PH-E-ALI-E1 Plus Sign 

Barrier 

PH-E-BAR-BB 
Barrier Concrete 
(Bottom) - Existing 

PH-E-BAR-BB PH-E-BAR-T 3.0     PH-E-BAR-BB               PH-E-BAR-BB Plus Sign 

PH-E-BAR-BT 
Barrier Concrete (Top) - 
Existing 

PH-E-BAR-BT PH-E-BAR-T 3.0     PH-E-BAR-BT               PH-E-BAR-BT Plus Sign 

PH-E-BAR-FL Fence (Top) - Existing PH-E-BAR-FL PH-E-BAR-T 3.0     PH-E-BAR-FL               PH-E-BAR-FL Plus Sign 

PH-E-BAR-GAT Gate - Existing 
PH-E-BAR-
GAT 

PH-E-BAR-T 3.0     
PH-E-BAR-
GAT 

              
PH-E-BAR-
GAT 

Plus Sign 

PH-E-BAR-GU Guide Rail - Existing PH-E-BAR-GU PH-E-BAR-T 3.0     PH-E-BAR-GU               PH-E-BAR-GU Plus Sign 

PH-E-BAR-NB 
Noise Barrier (Top) - 
Existing 

PH-E-BAR-NB PH-E-BAR-T 3.0     PH-E-BAR-NB               PH-E-BAR-NB Plus Sign 

PH-E-BAR-T Barrier Text - Existing   PH-E-BAR-T 3.0       PH-E-BAR-T 3.0       PH-E-BAR-T 3.0     

Contour  

PH-E-CTR-C1 
Contour (Primary) - 
Existing 

PH-E-CTR-C1 PH-E-CTR-T 3.0                         

PH-E-CTR-C2 
Contour (Secondary) - 
Existing 

PH-E-CTR-C2 PH-E-CTR-T 3.0                         

PH-E-CTR-T Contour Text - Existing   PH-E-CTR-T 3.0                         

Drainage  

PH-E-DRN-BD 
Bottom of Ditch - 
Existing 

PH-E-DRN-BD PH-E-DRN-T 3.0     PH-E-DRN-BD PH-E-DRN-T 3.0     PH-E-DRN-BD PH-E-DRN-T 3.0 PH-E-DRN-BD Plus Sign 

PH-E-DRN-CB Catch Basin - Existing   PH-E-DRN-T 3.0 PH-E-DRN-CB SP_CB   PH-E-DRN-T 3.0 PH-E-DRN-CB Plus Sign           

PH-E-DRN-CVP 
Culvert (One End) - 
Existing 

  PH-E-DRN-T 3.0 
PH-E-DRN-
CVP 

SP_CVP   PH-E-DRN-T 3.0 
PH-E-DRN-
CV-P 

Plus Sign           
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    Plan Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

PH-E-DRN-CV-
P 

Culvert Outline - Existing 
PH-E-DRN-
CV-P 

PH-E-DRN-T 3.0     
PH-E-DRN-
CV-P 

PH-E-DRN-T 3.0     
PH-E-DRN-
CV-P 

PH-E-DRN-T 3.0     

PH-E-DRN-CVT 
Culvert Centreline (Top) 
- Existing 

PH-E-DRN-
CVT 

PH-E-DRN-T 3.0     
PH-E-DRN-
CVT 

PH-E-DRN-T 3.0     
PH-E-DRN-
CVT 

PH-E-DRN-T 3.0     

PH-E-DRN-DI Ditch Inlet - Existing   PH-E-DRN-T 3.0 PH-E-DRN-DI SP_DI   PH-E-DRN-T 3.0 PH-E-DRN-DI Plus Sign           

PH-E-DRN-EM 
Edge of Muskeg - 
Existing 

PH-E-DRN-EM PH-E-DRN-T 3.0     PH-E-DRN-EM PH-E-DRN-T 3.0     PH-E-DRN-EM PH-E-DRN-T 3.0 PH-E-DRN-EM Plus Sign 

PH-E-DRN-EM-
P 

Muskeg Pattern - 
Existing 

PH-E-DRN-
EM-P 

PH-E-DRN-T 3.0                         

PH-E-DRN-EW Edge of Water - Existing PH-E-DRN-EW PH-E-DRN-T 3.0     PH-E-DRN-EW PH-E-DRN-T 3.0       PH-E-DRN-T 3.0 PH-E-DRN-EW Plus Sign 

PH-E-DRN-MH Manhole - Existing   PH-E-DRN-T 3.0 PH-E-DRN-MH SP_MH   PH-E-DRN-T 3.0 PH-E-DRN-MH Plus Sign           

PH-E-DRN-RR Rip-Rap - Existing PH-E-DRN-RR PH-E-DRN-T 3.0                         

PH-E-DRN-T Drainage Text - Existing   PH-E-DRN-T 3.0       PH-E-DRN-T 3.0       PH-E-DRN-T 3.0     

Ground Feature 

PH-E-GND-AO 
Asphalt Outline - 
Existing 

PH-E-GND-AO PH-E-GND-T 3.0     PH-E-GND-AO               PH-E-GND-AO Plus Sign 

PH-E-GND-AS Asphalt Shots - Existing PH-E-GND-AS PH-E-GND-T 3.0     PH-E-GND-AS               PH-E-GND-AS Plus Sign 

PH-E-GND-BA 
Bank of River or Stream 
- Existing 

PH-E-GND-BA PH-E-GND-T 3.0     PH-E-GND-BA               PH-E-GND-BA Plus Sign 

PH-E-GND-BC 
Bottom of Rock Cut - 
Existing 

PH-E-GND-BC PH-E-GND-T 3.0     PH-E-GND-BC               PH-E-GND-BC Plus Sign 

PH-E-GND-CO 
Concrete Outline - 
Existing 

PH-E-GND-CO PH-E-GND-T 3.0     PH-E-GND-CO               PH-E-GND-CO Plus Sign 

PH-E-GND-CS 
Concrete Shots - 
Existing 

PH-E-GND-CS PH-E-GND-T 3.0     PH-E-GND-CS               PH-E-GND-CS Plus Sign 

PH-E-GND-EC 
Entrance Centreline - 
Existing 

PH-E-GND-EC PH-E-GND-T 3.0     PH-E-GND-EC     PH-E-GND-EC Plus Sign PH-E-GND-EC     PH-E-GND-EC Plus Sign 

PH-E-GND-GO Gravel Outline - Existing PH-E-GND-GO PH-E-GND-T 3.0     PH-E-GND-GO               PH-E-GND-GO Plus Sign 
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    Plan Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

PH-E-GND-GS Gravel Shots - Existing PH-E-GND-GS PH-E-GND-T 3.0     PH-E-GND-GS               PH-E-GND-GS Plus Sign 

PH-E-GND-GX 
Original Ground 
(Approximate) - Existing 

PH-E-GND-GX PH-E-GND-T 3.0     PH-E-GND-GX               PH-E-GND-GX Plus Sign 

PH-E-GND-OG 
Original Ground Fault - 
Existing 

PH-E-GND-OG PH-E-GND-T 3.0     PH-E-GND-OG         PH-E-GND-OG     PH-E-GND-OG Plus Sign 

PH-E-GND-
RBE 

Railway Ballast Edge - 
Existing 

PH-E-GND-
RBE 

PH-E-GND-T 3.0     
PH-E-GND-
RBE 

              
PH-E-GND-
RBE 

Plus Sign 

PH-E-GND-RBT 
Railwat Ballast Top - 
Existing 

PH-E-GND-
RBT 

PH-E-GND-T 3.0     
PH-E-GND-
RBT 

              
PH-E-GND-
RBT 

Plus Sign 

PH-E-GND-
RKO 

Rock Outline - Existing 
PH-E-GND-
RKO 

PH-E-GND-T 3.0     
PH-E-GND-
RKO 

              
PH-E-GND-
RKO 

Plus Sign 

PH-E-GND-
RKS 

Rock Shots - Existing 
PH-E-GND-
RKS 

PH-E-GND-T 3.0     
PH-E-GND-
RKS 

              
PH-E-GND-
RKS 

Plus Sign 

PH-E-GND-SP Stock Piles - Existing PH-E-GND-SP PH-E-GND-T 3.0     PH-E-GND-SP               PH-E-GND-SP Plus Sign 

PH-E-GND-TC 
Top of Rock Cut - 
Existing 

PH-E-GND-TC PH-E-GND-T 3.0     PH-E-GND-TC               PH-E-GND-TC Plus Sign 

PH-E-GND-XX 
Original Ground 
Estimated - Existing 

PH-E-GND-XX PH-E-GND-T 3.0     PH-E-GND-XX               PH-E-GND-XX Plus Sign 

PH-E-GND-P 
Ground Patterning (Cut 
and Fill) - Existing 

PH-E-GND-P PH-E-GND-T 3.0     PH-E-GND-P PH-E-GND-T 3.0               

PH-E-GND-T Ground Features Text   PH-E-GND-T 3.0       PH-E-GND-T 3.0               

Miscellaneous 

PH-Q-MSC-AU Audit Line - Existing PH-Q-MSC-AU PH-E-MSC-T 3.0                         

PH-E-MSC-AX Excluded Area - Existing PH-E-MSC-AX PH-E-MSC-T 3.0     PH-E-MSC-AX                   

PH-E-MSC-AX-
P 

Excluded Area Pattern - 
Existing 

PH-E-MSC-
AX-P 

PH-E-MSC-T 3.0                         

PH-E-MSC-BLF 
Building Foundations 
Ruins - Existing 

PH-E-MSC-
BLF 

PH-E-MSC-T 3.0     
PH-E-MSC-
BLF 

              
PH-E-MSC-
BLF 

Plus Sign 

PH-E-MSC-BLR 
Buidling Roofline - 
Existing 

PH-E-MSC-
BLR 

PH-E-MSC-T 3.0     
PH-E-MSC-
BLR 

              
PH-E-MSC-
BLR 

Plus Sign 
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    Plan Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

PH-E-MSC-BS 
Building Surround - 
Existing 

PH-E-MSC-BS PH-E-MSC-T 3.0     PH-E-MSC-BS               PH-E-MSC-BS Plus Sign 

PH-E-MSC-BY 
Segment Boundary - 
Existing 

PH-E-MSC-BY PH-E-MSC-T 3.0     PH-E-MSC-BY               PH-E-MSC-BY Plus Sign 

PH-E-MSC-CE Cemetery - Existing PH-E-MSC-CE PH-E-MSC-T 3.0     PH-E-MSC-CE               PH-E-MSC-CE Plus Sign 

PH-E-MSC-DK 
Wooden Decks or Docks 
- Existing 

PH-E-MSC-DK PH-E-MSC-T 3.0     PH-E-MSC-DK               PH-E-MSC-DK Plus Sign 

PH-E-MSC-EJ 
Expansion Joint - 
Existing 

PH-E-MSC-EJ PH-E-MSC-T 3.0     PH-E-MSC-EJ                   

PH-E-MSC-EV-
Z 

Miscellaneous 
Elavations 

  
PH-E-MSC-
EV-Z 

3.0 
PH-E-MSC-
EV-Z 

SP_MSC_Z   
PH-E-MSC-
EV-Z 

3.0 
PH-E-MSC-
EV-Z 

SP_MSC_Z   
PH-E-MSC-
EV-Z 

3.0 
PH-E-MSC-
EV-Z 

SP_MSC_Z 

PH-E-MSC-
GAB 

Gabion Baskets - 
Existing 

PH-E-MSC-
GAB 

PH-E-MSC-T 3.0     
PH-E-MSC-
GAB 

                  

PH-E-MSC-GC Golf Course - Existing PH-E-MSC-GC PH-E-MSC-T 3.0                     PH-E-MSC-GC Plus Sign 

PH-E-MSC-HR 
Bridge Hand Rails - 
Existing 

PH-E-MSC-HR PH-E-MSC-T 3.0     PH-E-MSC-HR               PH-E-MSC-HR Plus Sign 

PH-E-MSC-OR Orchard - Existing PH-E-MSC-OR PH-E-MSC-T 3.0     PH-E-MSC-OR               PH-E-MSC-OR Plus Sign 

PH-E-MSC-OS 
Overhead Sign - 
Existing 

PH-E-MSC-OS PH-E-MSC-T 3.0 PH-E-MSC-OS SP_OS PH-E-MSC-OS         PH-E-MSC-OS     PH-E-MSC-OS Plus Sign 

PH-E-MSC-RLT 
Railway Top of Rail - 
Existing 

PH-E-MSC-
RLT 

PH-E-MSC-T 3.0     
PH-E-MSC-
RLT 

              
PH-E-MSC-
RLT 

Plus Sign 

PH-E-MSC-RW 
Top of Retaining Wall - 
Existing 

PH-E-MSC-
RW 

PH-E-MSC-T 3.0     
PH-E-MSC-
RW 

              
PH-E-MSC-
RW 

Plus Sign 

PH-E-MSC-SW Sidewalk - Existing PH-E-MSC-SW PH-E-MSC-T 3.0     PH-E-MSC-SW               PH-E-MSC-SW Plus Sign 

PH-E-MSC-VI Vineyard - Existing PH-E-MSC-VI PH-E-MSC-T 3.0                     PH-E-MSC-VI Plus Sign 

PH-E-MSC-WW 
Walkway-Trails-Paths - 
Existing 

PH-E-MSC-
WW 

PH-E-MSC-T 3.0     
PH-E-MSC-
WW 

              
PH-E-MSC-
WW 

Plus Sign 

PH-E-MSC-T Miscellaneous Text   PH-E-MSC-T 3.0       PH-E-MSC-T 3.0       PH-E-MSC-T 3.0     

Roadway  
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    Plan Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

PH-E-RDS-AE Asphalt Edge - Existing PH-E-RDS-AE PH-E-RDS-T 3.0     PH-E-RDS-AE               PH-E-RDS-AE Plus Sign 

PH-E-RDS-BRD Bridge Deck - Existing 
PH-E-RDS-
BRD 

PH-E-RDS-T 3.0     
PH-E-RDS-
BRD 

              
PH-E-RDS-
BRD 

Plus Sign 

PH-E-RDS-CR 
Crown of Road - 
Existing 

PH-E-RDS-CR PH-E-RDS-T 3.0     PH-E-RDS-CR               PH-E-RDS-CR Plus Sign 

PH-E-RDS-CU Curbs - Existing PH-E-RDS-CU PH-E-RDS-T 3.0     PH-E-RDS-CU               PH-E-RDS-CU Plus Sign 

PH-E-RDS-EG Edge of Gutter - Existing PH-E-RDS-EG PH-E-RDS-T 3.0     PH-E-RDS-EG               PH-E-RDS-EG Plus Sign 

PH-E-RDS-EN 
Entrance - Uncertain 
Surface - Existing 

PH-E-RDS-EN PH-E-RDS-T 3.0     PH-E-RDS-EN               PH-E-RDS-EN Plus Sign 

PH-E-RDS-EP 
Edge of Pavement - 
Existing 

PH-E-RDS-EP PH-E-RDS-T 3.0     PH-E-RDS-EP               PH-E-RDS-EP Square 

PH-E-RDS-ES 
Edge of Shoulder - 
Existing 

PH-E-RDS-ES PH-E-RDS-T 3.0     PH-E-RDS-ES               PH-E-RDS-ES Plus Sign 

PH-E-RDS-NG 
Gravel Entrance - 
Existing 

PH-E-RDS-NG PH-E-RDS-T 3.0     PH-E-RDS-NG               PH-E-RDS-NG Plus Sign 

PH-E-RDS-NP 
Paved Entrance - 
Existing 

PH-E-RDS-NP PH-E-RDS-T 3.0     PH-E-RDS-NP               PH-E-RDS-NP Plus Sign 

PH-E-RDS-RD 
Roads of Uncertain 
Material - Existing 

PH-E-RDS-RD PH-E-RDS-T 3.0     PH-E-RDS-RD               PH-E-RDS-RD Plus Sign 

PH-E-RDS-UR 
Gravel Sideroads - 
Existing 

PH-E-RDS-UR PH-E-RDS-T 3.0     PH-E-RDS-UR               PH-E-RDS-UR Plus Sign 

PH-E-RDS-T Roadway Text - Existing   PH-E-RDS-T 3.0       PH-E-RDS-T 3.0       PH-E-RDS-T 3.0     

Utility 

PH-E-UTL-AN 
Anchor for Guy Wire - 
Existing 

  PH-E-UTL-T 2.0 PH-E-UTL-AN SP_AN                 PH-E-UTL-AN Cross 

PH-E-UTL-BH 
Bell Hydro Pole - 
Existing 

  PH-E-UTL-T 2.0 PH-E-UTL-BH SP_BH                 PH-E-UTL-BH Cross 

PH-E-UTL-BP Bell Pole - Existing   PH-E-UTL-T 2.0 PH-E-UTL-BP SP_BP                 PH-E-UTL-BP Cross 

PH-E-UTL-FH Fire Hydrant - Existing   PH-E-UTL-T 2.0 PH-E-UTL-FH SP_FH                 PH-E-UTL-FH Cross 
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    Plan Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

PH-E-UTL-HP Hydro Pole - Existing   PH-E-UTL-T 2.0 PH-E-UTL-HP SP_HP                 PH-E-UTL-HP Cross 

PH-E-UTL-HT Hydro Tower - Existing   PH-E-UTL-T 2.0 PH-E-UTL-HT Circle                 PH-E-UTL-HT Cross 

PH-E-UTL-LS Light Standard - Existing   PH-E-UTL-T 2.0 PH-E-UTL-LS SP_LS                 PH-E-UTL-LS Cross 

PH-E-UTL-PW Pole Well - Existing   PH-E-UTL-T 2.0 PH-E-UTL-PW SP_PW                 PH-E-UTL-PW Cross 

PH-E-UTL-PO Pole Other - Existing   PH-E-UTL-T 2.0 PH-E-UTL-PO SP_PO                 PH-E-UTL-PO Cross 

PH-E-UTL-WE Well - Existing   PH-E-UTL-T 2.0 PH-E-UTL-WE SP_WE       PH-E-UTL-WE INR_PT16       PH-E-UTL-WE Cross 

PH-E-UTL-T Utilities Text - Existing   PH-E-UTL-T 2.0       PH-E-UTL-T 2.0       PH-E-UTL-T 2.0     

Vegetation 

PH-E-VEG-HE Hedge - Existing PH-E-VEG-HE PH-E-VEG-T 3.0 PH-E-VEG-HE Circle                 PH-E-VEG-HE Cross 

PH-E-VEG-TR Trees - Existing   PH-E-VEG-T 3.0 PH-E-VEG-TR SP_TREE                 PH-E-VEG-TR Cross 

PH-E-VEG-WD Woods Details - Existing PH-E-VEG-WD PH-E-VEG-T 3.0 PH-E-VEG-WD Circle                     

PH-E-VEG-T 
Vegetation Text - 
Existing 

  PH-E-VEG-T 3.0       PH-E-VEG-T 3.0       PH-E-VEG-T 3.0     
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    Default Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

Surveys & Plans General 

SP-G-CONS 
Construction Lines - 
Existing 

SP-G-CONS SP-G-TEXT 3.0                         

SP-G-25MM 0.25mm Line - Existing SP-G-25MM SP-G-TEXT 3.0                         

SP-G-40MM 0.40mm Line - Existing SP-G-40MM SP-G-TEXT 3.0                         

SP-G-50MM 0.50mm Line - Existing SP-G-50MM SP-G-TEXT 3.0                         

SP-G-75MM 0.75mm Line - Existing SP-G-75MM SP-G-TEXT 3.0                         

SP-G-TEXT General Text - Existing   SP-G-TEXT 3.0                         

SP-G-
SYMBOLS 

Symbols - Existing 
SP-G-
SYMBOLS 

SP-G-TEXT 3.0 
SP-G-
SYMBOLS 

Plus Sign                     

SP-E-LABELS String Labels - Existing             SP-E-LABELS 3.0               

SP-E-
SCANNED 

Scanned Images - 
Existing 

SP-E-
SCANNED 

SP-G-TEXT 3.0 
SP-E-
SCANNED 

Plus Sign                     

Survey Monument  

SP-E-MON 
Survey Monuments - 
Existing 

SP-E-MON SP-G-MON-T 3.0 SP-E-MON Circle                     

SP-E-MON-BM 
Survey Monuments - 
Existing 

SP-E-MON-BM SP-G-MON-T 3.0 SP-E-MON-BM Circle                     

SP-G-MON-T 
Monument Text - 
Existing 

  SP-G-MON-T 2.5                         
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    Plan Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

Alignment 

SP-E-ALI 
Misc Alignment - 
Existing 

SP-E-ALI SP-E-LABELS 2.0 SP-E-ALI Circle SP-E-ALI         SP-E-ALI     SP-E-ALI Plus Sign 

SP-E-ALI-CL 
Centerline Alignment - 
Existing 

SP-E-ALI-CL SP-E-ALI-CL-T 2.0     SP-P-ALI-CL         SP-E-ALI-CL     SP-E-ALI-CL Plus Sign 

SP-E-ALI-CL-C 
Centreline Alignment 
Chainage - Existing 

SP-E-ALI-CL-C SP-E-ALI-CL-C 3.0       SP-E-ALI-CL-C 3.0               

SP-E-ALI-CL-
PTS 

Centreline Alignment 
Points - Circle 

  SP-E-ALI-CL-T 2.0 
SP-E-ALI-CL-
PTS 

Circle                     

SP-E-ALI-CL-
PTST 

Centreline Alignment 
Points - Triangle 

  SP-E-ALI-CL-T 2.0 
SP-E-ALI-CL-
PTS 

Tranlgle                     

SP-E-ALI-CL-T 
Centreline Alignment 
Text - Existing 

  SP-E-ALI-CL-T 3.0       SP-E-ALI-CL-T 3.0       SP-E-ALI-CL-T 3.0     

SP-E-ALI-D1 
Drainage Alignment - 
Existing 

SP-E-ALI-D1 SP-E-ALI-D1 2.0 SP-E-ALI-D1 Circle SP-E-ALI-D1         SP-E-ALI-D1     SP-E-ALI-D1 Cross 

SP-E-ALI-E1 
Entrance Alignment - 
Existing 

SP-E-ALI-E1 SP-E-LABELS 2.0     SP-E-ALI-E1         SP-E-ALI-E1     SP-E-ALI-E1 Plus Sign 

SP-E-ALI-R1 Align Revision - Ramp SP-E-ALI-R1 SP-E-LABELS 2.0 SP-E-ALI-R1 Circle SP-E-ALI-R1         SP-E-ALI-R1     SP-E-ALI-R1 Plus Sign 

SP-E-ALI-S1 
Sideroad Alignment - 
Existing 

SP-E-ALI-S1 SP-E-LABELS 2.0     SP-E-ALI-S1         SP-E-ALI-S1     SP-E-ALI-S1 Plus Sign 

Barrier 

SP-E-BAR-BB 
Barrier Concrete 
(Bottom) - Existing 

SP-E-BAR-BB SP-E-BAR-T 3.0     SP-E-BAR-BB               SP-E-BAR-BB Plus Sign 

SP-E-BAR-BT 
Barrier Concrete (Top) - 
Existing 

SP-E-BAR-BT SP-E-BAR-T 3.0     SP-E-BAR-BT               SP-E-BAR-BT Plus Sign 

SP-E-BAR-FB Fitch Barrier - Existing SP-E-BAR-FB SP-E-BAR-T 3.0     SP-E-BAR-FB               SP-E-BAR-FB Plus Sign 

SP-E-BAR-FL 
Fence Line (Ground) - 
Existing 

SP-E-BAR-FL SP-E-BAR-T 3.0     SP-E-BAR-FL               SP-E-BAR-FL Plus Sign 

SP-E-BAR-FN Fence Line - Existing SP-E-BAR-FN SP-E-BAR-T 3.0     SP-E-BAR-FN               SP-E-BAR-FN Plus Sign 

SP-E-BAR-GAT Gate - Existing 
SP-E-BAR-
GAT 

SP-E-BAR-T 3.0     
SP-E-BAR-
GAT 

              
SP-E-BAR-
GAT 

Plus Sign 
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    Plan Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

SP-E-BAR-GP-
Z 

Guide Rail (Top of Post) 
- Existing 

SP-E-BAR-GP-
Z 

SP-E-BAR-T 3.0     
SP-E-BAR-GP-
Z 

              
SP-E-BAR-GP-
Z 

Plus Sign 

SP-E-BAR-GU 
Guide Rail (Ground) - 
Existing 

SP-E-BAR-GU SP-E-BAR-T 3.0     SP-E-BAR-GU               SP-E-BAR-GU Plus Sign 

SP-E-BAR-GW-
Z 

Guide Rail (Top of Wire) 
- Existing 

SP-E-BAR-
GW-Z 

SP-E-BAR-T 3.0     
SP-E-BAR-
GW-Z 

              
SP-E-BAR-
GW-Z 

Plus Sign 

SP-E-BAR-NB 
Noise Barrier (Ground) - 
Existing 

SP-E-BAR-NB SP-E-BAR-T 3.0     SP-E-BAR-NB               SP-E-BAR-NB Plus Sign 

SP-E-BAR-T Barrier Text - Existing   SP-E-BAR-T 3.0       SP-E-BAR-T 3.0       SP-E-BAR-T 3.0     

Contour 

SP-E-CTR-C1 
Contour (Primary) - 
Existing 

SP-E-CTR-C1 SP-E-CTR-T 3.0                         

SP-E-CTR-C2 
Contour (Secondary) - 
Existing 

SP-E-CTR-C2 SP-E-CTR-T 3.0                         

SP-E-CTR-T Contour Text - Existing   SP-E-CTR-T 3.0                         

Drainage  

SP-E-DRN-BD 
Bottom of Ditch - 
Existing 

SP-E-DRN-BD SP-E-DRN-T 3.0     SP-E-DRN-BD SP-E-DRN-T 3.0     SP-E-DRN-BD SP-E-DRN-T 3.0 SP-E-DRN-BD Plus Sign 

SP-E-DRN-CB Catch Basin - Existing   SP-E-DRN-T 3.0 SP-E-DRN-CB SP_CB   SP-E-DRN-T 3.0 SP-E-DRN-CB Plus Sign           

SP-E-DRN-CVP 
Culvert (One End) - 
Existing 

  SP-E-DRN-T 3.0 
SP-E-DRN-
CVP 

SP_CVP   SP-E-DRN-T 2.0 
SP-E-DRN-
CVP 

Plus Sign           

SP-E-DRN-CV-
P 

Culvert Symbology - 
Existing 

SP-E-DRN-CV-
P 

SP-E-DRN-T 3.0     
SP-E-DRN-CV-
P 

SP-E-DRN-T 3.0     
SP-E-DRN-CV-
P 

SP-E-DRN-T 3.0     

SP-E-DRN-CVT 
Culvert Centreline (Top) 
- Existing 

SP-E-DRN-
CVT 

SP-E-DRN-T 3.0     
SP-E-DRN-
CVT 

SP-E-DRN-T 3.0     
SP-E-DRN-
CVT 

SP-E-DRN-T 3.0     

SP-E-DRN-CV-
Z 

Culvert Elevation - 
Existing 

  
SP-E-DRN-CV-
Z 

3.0 
SP-E-DRN-CV-
Z 

Plus Sign   
SP-E-DRN-CV-
Z 

3.0 
SP-E-DRN-CV-
Z 

Plus Sign   
SP-E-DRN-CV-
Z 

3.0 
SP-E-DRN-CV-
Z 

Plus Sign 

SP-E-DRN-DB-
Z 

Ditch Inlet (Bottom 
Elevation) - Existing 

  
SP-E-DRN-DB-
Z 

3.0 
SP-E-DRN-DB-
Z 

Plus Sign   
SP-E-DRN-DB-
Z 

3.0 
SP-E-DRN-DB-
Z 

Plus Sign   
SP-E-DRN-DB-
Z 

3.0 
SP-E-DRN-DB-
Z 

Plus Sign 

SP-E-DRN-DC 
Ditch Centreline - 
Existing 

SP-E-DRN-DC SP-E-DRN-T 3.0     SP-E-DRN-DC SP-E-DRN-T 3.0     SP-E-DRN-DC SP-E-DRN-T 3.0 SP-E-DRN-DC Cross 
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ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

SP-E-DRN-DI Ditch Inlet - Existing   SP-E-DRN-T 3.0 SP-E-DRN-DI SP_DI   SP-E-DRN-T 3.0 SP-E-DRN-DI Plus Sign           

SP-E-DRN-DT-
Z 

Culvert Inlet (Top 
Elevation) - Existing 

  
SP-E-DRN-DT-
Z 

3.0 
SP-E-DRN-DT-
Z 

Plus Sign   
SP-E-DRN-DT-
Z 

3.0 
SP-E-DRN-DT-
Z 

Plus Sign   
SP-E-DRN-DT-
Z 

3.0 
SP-E-DRN-DT-
Z 

Plus Sign 

SP-E-DRN-EM 
Edge of Muskeg - 
Existing 

SP-E-DRN-EM SP-E-DRN-T 3.0     SP-E-DRN-EM SP-E-DRN-T 3.0     SP-E-DRN-EM SP-E-DRN-T 3.0 SP-E-DRN-EM Plus Sign 

SP-E-DRN-EM-
P 

Muskeg Pattern - 
Existing 

SP-E-DRN-
EM-P 

SP-E-DRN-T 3.0                         

SP-E-DRN-EW Edge of Water - Existing SP-E-DRN-EW SP-E-DRN-T 3.0     SP-E-DRN-EW SP-E-DRN-T 3.0       SP-E-DRN-T 3.0 SP-E-DRN-EW Plus Sign 

SP-E-DRN-FR-
Z 

Frustum Elevation - 
Existing 

  
SP-E-DRN-FR-
Z 

3.0 
SP-E-DRN-FR-
Z 

Plus Sign   
SP-E-DRN-FR-
Z 

3.0 
SP-E-DRN-FR-
Z 

Plus Sign   
SP-E-DRN-FR-
Z 

3.0 
SP-E-DRN-FR-
Z 

Plus Sign 

SP-E-DRN-MH Manhole - Existing   SP-E-DRN-T 3.0 SP-E-DRN-MH SP_MH   SP-E-DRN-T 3.0 SP-E-DRN-MH Plus Sign           

SP-E-DRN-RR Rip-Pap - Existing SP-E-DRN-RR SP-E-DRN-T 3.0                         

SP-E-DRN-SAN 
Sanitary Sewer Pipe - 
Existing 

SP-E-DRN-
SAN 

SP-E-DRN-T 3.0     
SP-E-DRN-
SAN 

SP-E-DRN-T 3.0 
SP-E-DRN-
SAN 

Cross 
SP-E-DRN-
SAN 

SP-E-DRN-T 3.0 
SP-E-DRN-
SAN 

Cross 

SP-E-DRN-
SEW 

Storm Sewer Pipe - 
Existing 

SP-E-DRN-
SEW 

SP-E-DRN-T 3.0     
SP-E-DRN-
SEW 

SP-E-DRN-T 3.0 
SP-E-DRN-
SEW 

Cross 
SP-E-DRN-
SEW 

SP-E-DRN-T 3.0 
SP-E-DRN-
SEW 

Cross 

SP-E-DRN-SU-
Z 

Sump Elevation - 
Existing 

  
SP-E-DRN-SU-
Z 

3.0 
SP-E-DRN-SU-
Z 

Plus Sign   
SP-E-DRN-SU-
Z 

3.0 
SP-E-DRN-SU-
Z 

Plus Sign   
SP-E-DRN-SU-
Z 

3.0 
SP-E-DRN-SU-
Z 

Plus Sign 

SP-E-DRN-WM Water Mark - Existing 
SP-E-DRN-
WM 

SP-E-DRN-T 3.0 SP-E-DRN-WM Cross   SP-E-DRN-T 3.0 
SP-E-DRN-
WM 

Plus Sign   SP-E-DRN-T 3.0 
SP-E-DRN-
WM 

Plus Sign 

SP-E-DRN-T Drainage Text - Existing   SP-E-DRN-T 3.0       SP-E-DRN-T 3.0               

Ground Feature 

SP-E-GND-AO 
Asphalt Outline - 
Existing 

SP-E-GND-AO SP-E-GND-T 3.0     SP-E-GND-AO               SP-E-GND-AO Plus Sign 

SP-E-GND-AS Asphalt Shots - Existing SP-E-GND-AS SP-E-GND-T 3.0     SP-E-GND-AS               SP-E-GND-AS Plus Sign 

SP-E-GND-BA 
Bank of River or Stream 
- Existing 

SP-E-GND-BA SP-E-GND-T 3.0     SP-E-GND-BA               SP-E-GND-BA Plus Sign 

SP-E-GND-BC 
Bottom of Rock Cut - 
Existing 

SP-E-GND-BC SP-E-GND-T 3.0     SP-E-GND-BC               SP-E-GND-BC Plus Sign 
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ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

SP-E-GND-CO 
Concrete Outline - 
Existing 

SP-E-GND-CO SP-E-GND-T 3.0     SP-E-GND-CO               SP-E-GND-CO Plus Sign 

SP-E-GND-CS 
Concrete Shots - 
Existing 

SP-E-GND-CS SP-E-GND-T 3.0     SP-E-GND-CS               SP-E-GND-CS Plus Sign 

SP-E-GND-DS Door Sill - Existing SP-E-GND-DS SP-E-GND-T 3.0     SP-E-GND-DS               SP-E-GND-DS Plus Sign 

SP-E-GND-EC 
Entrance Centreline - 
Existing 

SP-E-GND-EC SP-E-GND-EC 2.0     SP-E-GND-EC     SP-E-GND-EC Plus Sign SP-E-GND-EC     SP-E-GND-EC Plus Sign 

SP-E-GND-GO Gravel Outline - Existing SP-E-GND-GO SP-E-GND-T 3.0     SP-E-GND-GO               SP-E-GND-GO Plus Sign 

SP-E-GND-GS Gravel Shots - Existing SP-E-GND-GS SP-E-GND-T 3.0     SP-E-GND-GS               SP-E-GND-GS Plus Sign 

SP-E-GND-OG 
Original Ground Fault - 
Existing 

SP-E-GND-OG SP-E-GND-T 3.0     SP-E-GND-OG         SP-E-GND-OG     SP-E-GND-OG Plus Sign 

SP-E-GND-RBE 
Railway Ballast Edge - 
Existing 

SP-E-GND-
RBE 

SP-E-GND-T 3.0     
SP-E-GND-
RBE 

              
SP-E-GND-
RBE 

Plus Sign 

SP-E-GND-RBT 
Railway Ballast Top - 
Existing 

SP-E-GND-
RBT 

SP-E-GND-T 3.0     
SP-E-GND-
RBT 

              
SP-E-GND-
RBT 

Plus Sign 

SP-E-GND-
RKO 

Rock Outline - Existing 
SP-E-GND-
RKO 

SP-E-GND-T 3.0     
SP-E-GND-
RKO 

              
SP-E-GND-
RKO 

Plus Sign 

SP-E-GND-RKS Rock Shots - Existing 
SP-E-GND-
RKS 

SP-E-GND-T 3.0     
SP-E-GND-
RKS 

              
SP-E-GND-
RKS 

Plus Sign 

SP-E-GND-SB 
River or Stream Bed - 
Existing 

SP-E-GND-SB SP-E-GND-T 3.0     SP-E-GND-SB         SP-E-GND-SB     SP-E-GND-SB Plus Sign 

SP-E-GND-SP 
Stock Piles/Gravel Pits - 
Existing 

SP-E-GND-SP SP-E-GND-T 3.0     SP-E-GND-SP               SP-E-GND-SP Plus Sign 

SP-E-GND-TC 
Top of Rock Cut - 
Existing 

SP-E-GND-TC SP-E-GND-T 3.0     SP-E-GND-TC               SP-E-GND-TC Plus Sign 

SP-E-GND-TS Toe of Slope - Existing SP-E-GND-TS SP-E-GND-T 3.0     SP-E-GND-TS               SP-E-GND-TS Plus Sign 

SP-E-GND-P 
Ground Patterning (Cut-
Fill) - Existing 

SP-E-GND-P SP-E-GND-T 3.0     SP-E-GND-P SP-E-GND-T 3.0               

SP-E-GND-T 
Ground Feature Text - 
Existing 

  SP-E-GND-T 3.0       SP-E-GND-T 3.0               

Miscellaneous  
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ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

SP-Q-MSC-AU Audit Line - Existing SP-Q-MSC-AU SP-Q-MSC-AU 3.0                         

SP-E-MSC-BLO 
Building Outline(Bottom) 
- Existing 

SP-E-MSC-
BLO 

SP-E-MSC-T 3.0     
SP-E-MSC-
BLO 

              
SP-E-MSC-
BLO 

Cross 

SP-E-MSC-BN 
Centre of Bull Nose - 
Existing 

SP-E-MSC-BN SP-E-MSC-T 3.0     SP-E-MSC-BN                   

SP-E-MSC-BRP Bridge Pillar - Existing 
SP-E-MSC-
BRP 

SP-E-MSC-T 3.0 
SP-E-MSC-
BRP 

Cross 
SP-E-MSC-
BRP 

    
SP-E-MSC-
BRP 

Cross       
SP-E-MSC-
BRP 

Cross 

SP-E-MSC-BY 
Segment Boundary - 
Existing 

SP-E-MSC-BY SP-E-MSC-T 3.0     SP-E-MSC-BY               SP-E-MSC-BY Cross 

SP-E-MSC-CE Cemetry - Existing SP-E-MSC-CE SP-E-MSC-T 3.0     SP-E-MSC-CE               SP-E-MSC-CE Cross 

SP-E-MSC-DD Deck Drain - Existing SP-E-MSC-DD SP-E-MSC-T 3.0     SP-E-MSC-DD               SP-E-MSC-DD Cross 

SP-E-MSC-DK 
Wooden Decks or Docks 
- Existing 

SP-E-MSC-DK SP-E-MSC-T 3.0     SP-E-MSC-DK               SP-E-MSC-DK Cross 

SP-E-MSC-EJ 
Expansion Joint - 
Existing 

SP-E-MSC-EJ SP-E-MSC-T 3.0     SP-E-MSC-EJ                   

SP-E-MSC-EV-
Z 

Miscellaneous 
Elevations - Existing 

  
SP-E-MSC-EV-
Z 

3.0 
SP-E-MSC-EV-
Z 

SP_MSC_Z   
SP-E-MSC-EV-
Z 

3.0 
SP-E-MSC-EV-
Z 

SP_MSC_Z   
SP-E-MSC-EV-
Z 

3.0 
SP-E-MSC-EV-
Z 

SP_MSC_Z 

SP-E-MSC-
GAB 

Gabian Baskets - 
Existing 

SP-E-MSC-
GAB 

SP-E-MSC-T 3.0     
SP-E-MSC-
GAB 

                  

SP-E-MSC-GFL 
Gate with Flashing Light 
- Existing 

SP-E-MSC-
GFL 

SP-E-MSC-T 3.0     
SP-E-MSC-
GFL 

                  

SP-E-MSC-HR 
Bridge Hand Rails - 
Existing 

SP-E-MSC-HR SP-E-MSC-T 3.0     SP-E-MSC-HR               SP-E-MSC-HR Cross 

SP-E-MSC-OS 
Overhead Sign - 
Existing 

SP-E-MSC-OS SP-E-MSC-T 3.0 SP-E-MSC-OS SP_OS SP-E-MSC-OS         SP-E-MSC-OS     SP-E-MSC-OS Cross 

SP-E-MSC-
RCS 

Railway Crossing Sign - 
Existing 

SP-E-MSC-
RCS 

SP-E-MSC-T 3.0 
SP-E-MSC-
RCS 

Plus Sign 
SP-E-MSC-
RCS 

                  

SP-E-MSC-RLS Railway Sign - Existing 
SP-E-MSC-
RLS 

SP-E-MSC-T 3.0 
SP-E-MSC-
RLS 

Plus Sign 
SP-E-MSC-
RLS 

                  

SP-E-MSC-RLT 
Railway/Top of Rail - 
Existing 

SP-E-MSC-
RLT 

SP-E-MSC-T 3.0     
SP-E-MSC-
RLT 

              
SP-E-MSC-
RLT 

Cross 

SP-E-MSC-RW 
Bottom of Retaining Wall 
- Existing 

SP-E-MSC-RW SP-E-MSC-T 3.0     SP-E-MSC-RW               SP-E-MSC-RW Cross 
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ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

SP-E-MSC-SW Sidewalk - Existing SP-E-MSC-SW SP-E-MSC-T 3.0     SP-E-MSC-SW               SP-E-MSC-SW Cross 

SP-E-MSC-WW 
Walkways/Trails/Paths - 
Existing 

SP-E-MSC-
WW 

SP-E-MSC-T 3.0     
SP-E-MSC-
WW 

              
SP-E-MSC-
WW 

Cross 

SP-E-MSC-T 
Miscellaneous Text - 
Existing 

  SP-E-MSC-T 3.0       SP-E-MSC-T 3.0       SP-E-MSC-T 3.0     

Property Boundary  

SP-E-BDY-
CITY 

City Boundary - Existing 
SP-E-BDY-
CITY 

SP-E-BDY-T 3.0                     
SP-E-BDY-
CITY 

Plus Sign 

SP-E-BDY-LIN 
General Property 
Boundary Line - Existing 

SP-E-BDY-LIN SP-E-BDY-T 3.0                     SP-E-BDY-LIN Plus Sign 

SP-E-BDY-LLS 
Lot Line Subdivision 
Boundary - Existing 

SP-E-BDY-LLS SP-E-BDY-T 3.0                     SP-E-BDY-LLS Plus Sign 

SP-E-BDY-LLC 
Lot Line Concession 
Boundary - Existing 

SP-E-BDY-LLC SP-E-BDY-T 3.0                     SP-E-BDY-LLC Plus Sign 

SP-E-BDY-T 
Property Boundary Text 
- Existing 

  SP-E-BDY-T 3.0       SP-E-BDY-T 3.0       SP-E-BDY-T 3.0     

Right of Way 

SP-E-ROW-
MTO 

Existing MTO Property 
SP-E-ROW-
MTO 

        
SP-E-ROW-
MTO 

        
SP-E-ROW-
MTO 

SP-E-ROW-T 3.0 
SP-E-ROW-
MTO 

ROW_Ex 

SP-E-ROW-T 
Right of Way Text - 
Existing 

  SP-E-ROW-T 3.0       SP-E-ROW-T 3.0       SP-E-ROW-T 3.0     

Roadway 

SP-E-RDS-AE Asphalt Edge - Existing SP-E-RDS-AE SP-E-RDS-T 3.0     SP-E-RDS-AE               SP-E-RDS-AE Plus Sign 

SP-E-RDS-BRD Bridge Deck - Existing 
SP-E-RDS-
BRD 

SP-E-RDS-T 3.0     
SP-E-RDS-
BRD 

              
SP-E-RDS-
BRD 

Plus Sign 

SP-E-RDS-CR 
Crown of Road - 
Existing 

SP-E-RDS-CR SP-E-RDS-T 3.0     SP-E-RDS-CR               SP-E-RDS-CR Plus Sign 

SP-E-RDS-CU Curbs - Existing SP-E-RDS-CU SP-E-RDS-T 3.0     SP-E-RDS-CU               SP-E-RDS-CU Plus Sign 

SP-E-RDS-DL 
Driving Lane Edge - 
Existing 

SP-E-RDS-DL SP-E-RDS-T 3.0     SP-E-RDS-DL               SP-E-RDS-DL Plus Sign 
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ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

SP-E-RDS-EG 
Edge of Gutter - 
Exisiting 

SP-E-RDS-EG SP-E-RDS-T 3.0     SP-E-RDS-EG               SP-E-RDS-EG Plus Sign 

SP-E-RDS-EP 
Edge of Pavement - 
Exisiting 

SP-E-RDS-EP SP-E-RDS-T 3.0     SP-E-RDS-EP               SP-E-RDS-EP Square 

SP-E-RDS-ES 
Wdge of Shoulder - 
Exisiting 

SP-E-RDS-ES SP-E-RDS-T 3.0     SP-E-RDS-ES               SP-E-RDS-ES Plus Sign 

SP-E-RDS-NG 
Gravel Entrance - 
Exisiting 

SP-E-RDS-NG SP-E-RDS-T 3.0     SP-E-RDS-NG               SP-E-RDS-NG Plus Sign 

SP-E-RDS-NP 
Paved Entrance - 
Existing 

SP-E-RDS-NP SP-E-RDS-T 3.0     SP-E-RDS-NP               SP-E-RDS-NP Plus Sign 

SP-E-RDS-RS Ripple Strip - Existing SP-E-RDS-RS SP-E-RDS-T 3.0                     SP-E-RDS-RS Plus Sign 

SP-E-RDS-SR 
Sideroad Paved - 
Exisiting 

SP-E-RDS-SR SP-E-RDS-T 3.0     SP-E-RDS-SR               SP-E-RDS-SR Plus Sign 

SP-E-RDS-UR 
Gravel Sideroad - 
Existing 

SP-E-RDS-UR SP-E-ROW-T 3.0     SP-E-RDS-UR               SP-E-RDS-UR Plus Sign 

SP-E-RDS-T Roadway Text - Existing   SP-E-RDS-T 3.0       SP-E-RDS-T 3.0               

Utility 

SP-E-UTL-AN Anchor - Existing   SP-E-UTL-T 2.0 SP-E-UTL-AN SP_AN                 SP-E-UTL-AN Cross 

SP-E-UTL-BH 
Bell Hydro Pole - 
Existing 

  SP-E-UTL-T 2.0 SP-E-UTL-BH SP_BH                 SP-E-UTL-BH Cross 

SP-E-UTL-BP Bell Pole - Existing   SP-E-UTL-T 2.0 SP-E-UTL-BP SP_BP                 SP-E-UTL-BP Cross 

SP-E-UTL-FH Fire Hydrant - Existing   SP-E-UTL-T 2.0 SP-E-UTL-FH SP_FH                 SP-E-UTL-FH Cross 

SP-E-UTL-GV Gas Valve - Existing   SP-E-UTL-T 2.0 SP-E-UTL-GV SP_GV                 SP-E-UTL-GV Cross 

SP-E-UTL-
HCG-Z 

Hydro Crossing Ground 
Elevations - Existing 

  
SP-E-UTL-
HCG-Z 

2.0 
SP-E-UTL-
HCG-Z 

Plus Sign   
SP-E-UTL-
HCG-Z 

2.0 
SP-E-UTL-
HCG-Z 

Plus Sign   
SP-E-UTL-
HCG-Z 

2.0 
SP-E-UTL-
HCG-Z 

Plus Sign 

SP-E-UTL-
HCW-Z 

Hydro Crossing Wire 
Elevations - Existing 

  
SP-E-UTL-
HCW-Z 

2.0 
SP-E-UTL-
HCW-Z 

Plus Sign   
SP-E-UTL-
HCW-Z 

2.0 
SP-E-UTL-
HCW-Z 

Plus Sign   
SP-E-UTL-
HCW-Z 

3.0 
SP-E-UTL-
HCW-Z 

Plus Sign 

SP-E-UTL-HP Hydro Pole - Existing   SP-E-UTL-T 2.0 SP-E-UTL-HP SP_HP                 SP-E-UTL-HP Cross 
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    Plan Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

SP-E-UTL-HT Hydro Tower - Existing   SP-E-UTL-T 2.0 SP-E-UTL-HT Circle                 SP-E-UTL-HT Cross 

SP-E-UTL-LS Light Standard - Existing   SP-E-UTL-T 2.0 SP-E-UTL-LS SP_LS                 SP-E-UTL-LS Cross 

SP-E-UTL-PL Pipeline - Existing SP-E-UTL-PL SP-E-UTL-T 2.0     SP-E-UTL-PL               SP-E-UTL-PL Cross 

SP-E-UTL-PO Pole - Other - Existing   SP-E-UTL-T 2.0 SP-E-UTL-PO SP_PO                 SP-E-UTL-PO Cross 

SP-E-UTL-PW Pole Well - Existing   SP-E-UTL-T 2.0 SP-E-UTL-PW SP_PW                 SP-E-UTL-PW Cross 

SP-E-UTL-TB 
Utility Terminal Box - 
Existing 

  SP-E-UTL-T 2.0 SP-E-UTL-TB SP_TB       SP-E-UTL-TB Cross       SP-E-UTL-TB Cross 

SP-E-UTL-UB 
Underground Bell - 
Existing 

SP-E-UTL-UB SP-E-UTL-T 2.0     SP-E-UTL-UB     SP-E-UTL-UB Circle       SP-E-UTL-UB Circle 

SP-E-UTL-UG 
Underground Gas - 
Existing 

SP-E-UTL-UG SP-E-UTL-T 2.0     SP-E-UTL-UG     SP-E-UTL-UG Circle       SP-E-UTL-UG Circle 

SP-E-UTL-UH 
Underground Hydro - 
Existing 

SP-E-UTL-UH SP-E-UTL-T 2.0     SP-E-UTL-UH     SP-E-UTL-UH Circle       SP-E-UTL-UH Circle 

SP-E-UTL-UM 
Underground Utility 
Marker - Existing 

  SP-E-UTL-T 2.0 SP-E-UTL-UM SP_UM                 SP-E-UTL-UM Cross 

SP-E-UTL-UT 
Underground Utility - 
Other - Existing 

SP-E-UTL-UT SP-E-UTL-T 2.0 SP-E-UTL-UT Cross SP-E-UTL-UT     SP-E-UTL-UT Cross       SP-E-UTL-UT Cross 

SP-E-UTL-UTV 
Underground Cable TV - 
Existing 

SP-E-UTL-UTV SP-E-UTL-T 2.0     SP-E-UTL-UTV     SP-E-UTL-UTV Circle       SP-E-UTL-UTV Circle 

SP-E-UTL-UW 
Underground Watermain 
- Existing 

SP-E-UTL-UW SP-E-UTL-T 2.0     SP-E-UTL-UW     SP-E-UTL-UW Circle       SP-E-UTL-UW Circle 

SP-E-UTL-VE Vent - Existing   SP-E-UTL-T 2.0 SP-E-UTL-VE SP_VE                 SP-E-UTL-VE Cross 

SP-E-UTL-WE Well - Existing   SP-E-UTL-T 2.0 SP-E-UTL-WE SP_WE       SP-E-UTL-WE INR_PT16       SP-E-UTL-WE Cross 

SP-E-UTL-WV Water Valve - Existing   SP-E-UTL-T 2.0 SP-E-UTL-WV SP_WV       SP-E-UTL-WV Cross       SP-E-UTL-WV Cross 

SP-E-UTL-T Utilities Text - Existing   SP-E-UTL-T 2.0       SP-E-UTL-T 2.0       SP-E-UTL-T 2.0     

Vegetation 
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    Plan Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

SP-E-VEG-HE Hedge - Existing SP-E-VEG-HE SP-E-VEG-T 3.0 SP-E-VEG-HE Circle                 SP-E-VEG-HE Cross 

SP-E-VEG-P 
Bush Symbology - 
Existing 

SP-E-VEG-P SP-E-VEG-T 2.0     SP-E-VEG-P                   

SP-E-VEG-TR Trees - Existing   SP-E-VEG-T 3.0 SP-E-VEG-TR SP_TREE                 SP-E-VEG-TR Plus Sign 

SP-E-VEG-WD Woods Detail - Existing SP-E-VEG-WD SP-E-VEG-T 3.0     SP-E-VEG-WD                   

SP-E-VEG-WO 
Woods Overhang - 
Existing 

SP-E-VEG-WO SP-E-VEG-T 3.0     SP-E-VEG-WO                   

SP-E-VEG-WT 
Woods Turnkline - 
Existing 

SP-E-VEG-WT SP-E-VEG-T 3.0     SP-E-VEG-WT                   

SP-E-VEG-T 
Vegetation Text - 
Existing 

  SP-E-VEG-T 3.0       SP-E-VEG-T 3.0       SP-E-VEG-T 3.0     

Profile  

SP-P-ALI-CL 
Profile Information - 
Existing 

          SP-P-ALI-CL SP-P-ALI-CL 3.0 SP-P-ALI-CL Circle           

SP-P-ALI-DRN 
Profile Drainage 
Information - Existing 

          SP-P-ALI-DRN 
SP-P-ALI-
DRN-T 

3.0 SP-P-ALI-DRN Plus Sign           

SP-P-ALI-DRN-
T 

Profile Text - Existing             
SP-P-ALI-
DRN-T 

3.0               

SP-P-ALI-GRID Profile Grid - Existing           
SP-P-ALI-
GRID 

                  

SP-P-ALI-
GRID-T 

Profile Chainage - 
Existing 

            
SP-P-ALI-
GRID-T 

3.0               

LEGAL SURVEYS 

SP-L-MON 
Horizontal Control 
Points - Legal 

  SP-L-TEXT 3.0 SP-L-MON Circle                     

SP-L-MON-BM Bench Marks - Legal   SP-L-TEXT 3.0 SP-L-MON-BM Circle                     

SP-L-25MM 0.25mm Line - Legal SP-L-25MM SP-L-TEXT 3.0                         

SP-L-25MM-
SDASH 

0.25mm Short Dashed 
Line - Legal 

SP-L-25MM-
SDASH 

SP-L-TEXT 3.0                         
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    Plan Profile Cross Section 

ItemName Description Line Text Point Line Text Point Line Text Point 

    Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol Layer Layer Hight Layer Symbol 

SP-L-25MM-
LDASH 

0.25mm Long Dashed 
Line - Legal 

SP-L-25MM-
LDASH 

SP-L-TEXT 3.0                         

SP-L-40MM 0.40mm Line - Legal SP-L-40MM SP-L-TEXT 3.0                         

SP-L-40MM-
LDASH 

0.40mm Long Dashed 
Line - Legal 

SP-L-40MM-
LDASH 

SP-L-TEXT 3.0                         

SP-L-50MM 0.50mm Line - Legal SP-L-50MM SP-L-TEXT 3.0                         

SP-L-FABRIC 
LINES 

Fabric Lines - Legal 
SP-L-FABRIC 
LINES 

SP-L-FABRIC 
TEXT 

3.0                         

SP-L-FABRIC 
TEXT 

Fabric Text - Legal   
SP-L-FABRIC 
TEXT 

3.0                         

SP-L-PARCEL Parcel - Legal SP-L-PARCEL SP-L-TEXT 3.0                         

SP-L-PART 
LINES 

Part Lines - Legal 
SP-L-PART 
LINES 

SP-L-PART 
TEXT 

3.0                         

SP-L-PART 
TEXT 

Part Text - Legal   
SP-L-PART 
TEXT 

3.0                         

SP-L-TEXT Legal Text   SP-L-TEXT 3.0                         

SP-L-
SYMBOLS 

Legal Symbols - Legal   SP-L-TEXT 3.0 
SP-L-
SYMBOLS 

Circle                     
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Surface Feature 

Plan Cross Section Profile 

Style Name Description Item Code 
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General 

BORDER Frame - Title Block Borders   x   x   x   x   x     x BORDER     

DWGINFO DWGINFO   x   x   x   x   x     x DWGINFO     

VPORTS VPORTS   x x x x     x   x     x VPORTS     

MT-G-GRID MTO General Grid   x                       MT-G-GRID     

MT-G-GRID-T MTO General Grid Text       x       x         x MT-G-GRID-T     

MT-P-GRID MTO Profile Grid                   x       MT-P-GRID     

MT-P-GRID-T MTO Profile Grid Text                         x MT-P-GRID-T     

PD-G-CONS Temproray Construction Lines - Design   x   x   x   x   x     x PD-G-CONS     

PD-G-DIM General Dimensions - Design   x   x       x         x PD-G-DIM     

PD-G-LEGEND Keyplan Legend - Design   x   x       x         x PD-G-LEGEND     

PD-G-SYMBOL General Syumbols - Design   x x x x x x x   x x x x PD-G-SYMBOL     

PD-G-SYMBOL-IDC General Symbol IDC - Design       x       x         x PD-G-SYMBOL-IDC     

PD-G-25MM 0.25 mm General Line - Design   x   x   x   x   x     x PD-G-25MM     

PD-G-40MM 0.40 mm General Line - Design   x   x   x   x   x     x PD-G-40MM     

PD-G-50MM 0.50 mm General Line - Design   x   x x x       x     x PD-G-50MM     
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Surface Feature 

Plan Cross Section Profile 

Style Name Description Item Code 
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PD-G-75MM 0.75 mm General Line - Design   x   x x x       x     x PD-G-75MM     

PD-G-TEXT General Text - Design       x       x         x PD-G-TEXT     

PD-N-LIMIT Contract Construction Limits - Design   x   x x     x   x     x PD-N-LIMIT     

Alignment 

PD-N-ALI-CL Centreline Alignment - Design   x     x x       x       PD-N-ALI-CL x   

PD-N-ALI-CL-T Centreline Alignment Text - Design       x       x         x PD-N-ALI-CL-T     

PD-N-ALI-CL-PTS Centreline Alignment Points - Design                             x   

PD-N-ALI-CL-PTST Centreline Alignment Point Symbol - Triangle                             x   

Barrier 

PD-N-BAR-FL Fence - Design   x   x x     x   x     x PD-N-BAR-FL     

PD-N-BAR-GU3 Guide Rail (3 Cable) - Design   x   x x     x   x     x PD-N-BAR-GU3     

PD-N-BAR-GU6 Guide Rail (6 Cable) - Design   x   x x     x   x     x PD-N-BAR-GU3     

PD-N-BAR-GUB Guide Rail (Box Beam) - Design   x   x x     x   x     x PD-N-BAR-GUB     

PD-N-BAR-GUC Guide Rail (Concrete Barrier) - Design   x   x x     x   x     x PD-N-BAR-GUC     

PD-N-BAR-GUI Guide Rail (IBC) - Design   x   x x     x   x     x PD-N-BAR-GUI     

PD-N-BAR-GUS Guide Rail (Steel Beam) - Design   x   x x     x   x     x PD-N-BAR-GUS     
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Surface Feature 

Plan Cross Section Profile 

Style Name Description Item Code 
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PD-N-BAR-IBM Interial Barrier Modules (IBM) - Design   x   x           x     x PD-N-BAR-IBM     

PD-N-BAR-JB Jersey Barrier - Design   x   x x     x x x     x PD-N-BAR-JB     

PD-N-BAR-NB Noise Barrier - Design   x   x x     x x x     x PD-N-BAR-NB     

PD-N-BAR-T Barrier Text - Design       x       x         x PD-N-BAR-T     

Drainage 

PD-N-DRN-BD Bottom of Ditch - Design   x   x x     x x x     x PD-N-DRN-BD     

PD-N-DRN-CB Cathc Basin - Design     x x x     x   x x   x PD-N-DRN-CB     

PD-N-DRN-CV Culvert - Design   x   x x x   x   x   x x PD-N-DRN-CV     

PD-N-DRN-DI Ditch Inlet - Design     x x x     x   x x   x PD-N-DRN-DI     

PD-N-DRN-MH Manhole - Design     x x x     x   x x   x PD-N-DRN-MH     

PD-N-DRN-RR Rip-Rap - Design   x   x                   PD-N-DRN-RR     

PD-N-DRN-SAN Sanitary Sewer Pipe - Design   x   x x x   x   x   x x PD-N-DRN-SAN     

PD-N-DRN-SEW Storm Sewer Pipe - Design   x   x x x   x   x   x x PD-N-DRN-SEW     

PD-N-DRN-SUB Sub Drain - Design   x   x x x   x x x   x x PD-N-DRN-SUB     

PD-N-DRN-WL Water Level - Design   x   x           x     x PD-N-DRN-WL     

PD-N-DRN-T Drainage Text - Design       x       x         x PD-N-DRN-T     
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Surface Feature 

Plan Cross Section Profile 

Style Name Description Item Code 
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Miscellaneous 

PD-N-MSC Miscellaneous (Generic Items) - Design   x   x           x     x PD-N-MSC     

PD-N-MSC-AS Asphalt (Miscellaneous Paving) - Design   x   x x     x x x     x PD-N-MSC-AS     

PD-N-MSC-BN Bull Nose - Design   x   x           x     x PD-N-MSC-BN     

PD-N-MSC-CO Concrete  - Design   x   x x     x x x     x PD-N-MSC-CO     

PD-N-MSC-COA Concrete With Asphalt Surface - Design   x   x                   PD-N-MSC-COA     

PD-N-MSC-EJ Expansion Joint - Design   x   x           x     x PD-N-MSC-EJ     

PD-N-MSC-EX Bottom of Earth Excavation Profile - Design   x   x x      x   x x     x PD-P-MSC-EX     

PD-N-MSC-GAB Gabion Baskets - Design   x   x   x   x x x     x PD-N-MSC-GAB     

PD-N-MSC-RW Retaining Wall - Design   x   x x     x x x     x PD-N-MSC-RW     

PD-N-MSC-SIGN Sign Footing - Design   x   x x     x x x     x PD-N-MSC-SIGN     

PD-N-MSC-SWA Asphalt Sidewalk - Design   x   x x     x x         PD-N-MSC-SWA     

PD-N-MSC-SWC Concrete Sidewalk - Design   x   x x     x x         PD-N-MSC-SWC     

PD-N-MSC-T Miscellaneous Text - Design       x       x         x PD-N-MSC-T     

Pavement Marking 

PD-N-PMK Pavement Markings - Design   x   x x     x   x     x PD-N-PMK     
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Surface Feature 

Plan Cross Section Profile 

Style Name Description Item Code 
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PD-N-PMK-GORE Gore Area - Design   x   x x     x   x     x PD-N-PMK-GORE     

PD-N-PMK-PMBW 
Pavement Marking - Broken White Line - 
Design 

  x   x x     x   x     x PD-N-PMK-PMBW     

PD-N-PMK-PMBY 
Pavement Marking - Broken Yellow Line - 
Design 

  x   x x     x   x     x PD-N-PMK-PMBY     

PD-N-PMK-PMSW Pavement Marking - Solid White Line - Design   x   x x     x   x     x PD-N-PMK-PMSW     

PD-N-PMK-PMSY 
Pavement Marking - Solid Yellow Line - 
Design 

  x   x x     x   x     x PD-N-PMK-PMSY     

PD-N-PMK-T Pavement Marking Text - Design       x       x         x PD-N-PMK-T     

Roadway 

PD-N-RDS-CR Crown of Road - Design   x   x   x   x   x     x PD-N-RDS-CR     

PD-N-RDS-CGA Asphalt Curb and Gutter - Design   x   x x     x x x     x PD-N-RDS-CGA     

PD-N-RDS-CGC Concrete Curb and Gutter - Design   x   x x     x x x     x PD-N-RDS-CGC     

PD-N-RDS-EP New Edge of Pavement - Design   x   x x x   x   x     x PD-N-RDS-EP     

PD-N-RDS-EPS New Edge of Paved Shoulder - Design   x   x x x   x   x     x PD-N-RDS-EPS     

PD-N-RDS-ES New Edge of Shoulder - Design   x   x x x   x   x     x PD-N-RDS-ES     

PD-N-RDS-TC Top of Cut - Design   x   x x     x   x     x PD-N-RDS-TC     

PD-N-RDS-TS Toe of Fill Slope - Design   x   x x     x   x     x PD-N-RDS-TS     

PD-N-RDS-UR Unpaved Road - Design   x   x x     x   x     x PD-N-RDS-UR     
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PD-N-RDS-T Roadway Text - Design   x   x       x         x PD-N-RDS-T     

Property and Right of Way 

PD-N-ROW-PLI Limited Interest (Permanent) - Design   x   x x x   x           PD-N-ROW-PLI     

PD-N-ROW-TLI Limited Interest (Temporary) - Design   x   x x x   x           PD-N-ROW-TLI     

PD-N-ROW-PRI Property Required (Intermediate) - Design   x   x x x   x           PD-N-ROW-PRI     

PD-N-ROW-PRU Property Required (Ultimate) - Design   x   x x x   x           PD-N-ROW-PRU     

PD-N-ROW-DEL Property Deletion - Design   x   x                   PD-N-ROW-DEL     

PD-N-ROW-T Property and ROW Text - Design   x   x       x           PD-N-ROW-T     

Vegetation 

PD-N-VEG-SOD Sod - Design   x   x                   PD-N-VEG-SOD     

PD-N-VEG-WO Vegetation Wood Outline - Design   x   x                   PD-N-VEG-WO     

PD-N-VEG-T Vegetation Text - Design   x   x       x   x       PD-N-VEG-T     

General Profile 

PD-P-LIMIT Profile Contract Construction Limits - Design                   x     x PD-P-LIMIT     

PD-P-LIMIT-T Profile Job Limits Text - Design                   x     x PD-P-LIMIT-T     

PD-P-G-T General Text - Profile                         x PD-P-G-T     
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Road Bed Profile 

PD-P-BED-GRA Top of Granular A Profile - Design                   x     x PD-P-BED-GRA     

PD-P-BED-GRB Top of Granular B Profile- Design                   x     x PD-P-BED-GRB     

PD-P-BED-SG Subgrade Profile - Design                   x     x PD-P-BED-SG     

PD-P-BED-TCL Left Top of Cut Profile - Design                   x     x PD-P-BED-TCL     

PD-P-BED-TCR Right Top of Cut Profile - Design                   x     x PD-P-BED-TCR     

PD-P-BED-TF Top of Filter Course Profile - Design                   x     x PD-P-BED-TF     

PD-P-BED-TP Top of Pavement Profile - Design                   x     x PD-P-BED-TP     

PD-P-BED-TSL Left Toe of Fill Slope Profile - Design                   x     x PD-P-BED-TSL     

PD-P-BED-TSR Right Toe of Fill Slope Profile - Design                   x     x PD-P-BED-TSR     

PD-P-BED-VALBL Vertical Alignment Stations Tables - Design               x   x     x PD-P-BED-VALBL     

PD-P-BED-VAPTS Vertical Alignment VPI Tangents - Design   x   x x     x   x     x PD-P-BED-VAPTS     

PD-P-BED-T Profile Roadbed Text - Design                   x     x PD-P-BED-T     

Drainage Profile 

PD-P-DRN-BDL Left Bottom of Ditch Profile - Design                   x     x PD-P-DRN-BDL     

PD-P-DRN-BDM Median Bottom of Ditch Profile - Design               x   x     x PD-P-DRN-BDM     
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PD-P-DRN-BDR Right Bottom of Ditch Profile - Design                   x     x PD-P-DRN-BDR     

PD-P-DRN-CB Catch Basin Profile - Design                   x x x x PD-P-DRN-CB     

PD-P-DRN-CV Culvert Profile - Design                   x x x x PD-P-DRN-CV     

PD-P-DRN-DI Ditch Inlet - Profile - Design                   x x x x PD-P-DRN-DI     

PD-P-DRN-MH Manhole Profile - Design                   x x x x PD-P-DRN-MH     

PD-P-DRN-SAN Sanitary Sewer Pipe Profile - Design                   x   x x PD-P-DRN-SAN     

PD-P-DRN-SEW Storm Sewer Pipe Profile - Design                   x   x x PD-P-DRN-SEW     

PD-P-DRN-SUB Sub Drain Profile - Design                   x   x x PD-P-DRN-SUB     

PD-P-DRN-T Profile Drainage Text - Design                   x     x PD-P-DRN-T     

Ground Profile 

PD-P-GND-MUB Bottom of Muskeg Profile - Design                   x     x PD-P-GND-MUB     

PD-P-GND-MUT Top of Muskeg Profile - Design                   x     x PD-P-GND-MUT     

PD-P-GND-OG Orginial Ground Profile - Design                   x     x PD-P-GND-OG     

PD-P-GND-RK Top of Rock Profile - Design                   x     x PD-P-GND-RK     

PD-P-GND-T Profile Ground Text - Design                   x     x PD-P-GND-T     

Miscellaneous Profile 
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PD-P-MSC Miscellaneous Profile Items - Design                   x     x PD-P-MSC     

PD-P-MSC-EF Earth Fill Profile - Design                   x     x PD-P-MSC-EF     

PD-P-MSC-EX Bottom of Earth Excavation Profile - Design                   x     x PD-P-MSC-EX     

PD-P-MSC-RF Rock Fill Profile - Design                   x     x PD-P-MSC-RF     

PD-P-MSC-SH Shatter Profile - Design                   x     x PD-P-MSC-SH     

PD-P-MSC-T Profile Miscellaneous Text - Design                   x     x PD-P-MSC-T     

Removal 

PD-R-BAR-FL Fence Removal   x   x                   PD-R-BAR-FL     

PD-R-BAR-GU Guide Rail Removal   x   x                   PD-R-BAR-GU     

PD-R-BAR-T Removal Barrier Text   x   x                   PD-R-BAR-T     

PD-R-DRN-CB Cathc Basin Removal   x x x                   PD-R-DRN-CB     

PD-R-DRN-CV Culvert Removal   x   x                   PD-R-DRN-CV     

PD-R-DRN-MH Manhole Removal   x x x                   PD-R-DRN-MH     

PD-R-DRN-SAN Sanitary Sewer Pipe Removal   x   x                   PD-R-DRN-SAN     

PD-R-DRN-SEW Storm Sewer Pipe Removal   x   x                   PD-R-DRN-SEW     

PD-R-DRN-SUB Sub Drain Removal   x   x                   PD-R-DRN-SUB     
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PD-R-DRN-T Removal Drainage Text       x                   PD-R-DRN-T     

PD-R-MSC Removal Miscellaneous Items   x   x                   PD-R-MSC     

PD-R-MSC-AS Asphalt Pavement Removal   x   x                   PD-R-MSC-AS     

PD-R-MSC-CO Concrete Pavement Removal   x   x                   PD-R-MSC-CO     

PD-R-MSC-COA Concrete with Asphalt Surface Removal   x   x                   PD-R-MSC-COA     

PD-R-MSC-SWA Asphalt Sidewalk Removal   x   x                   PD-R-MSC-SWA     

PD-R-MSC-SWC Concrete Sidewalk Removal   x   x                   PD-R-MSC-SWC     

PD-R-MSC-T Removal Miscellaneous Text       x                   PD-R-MSC-T     

PD-R-RDS-CGA Asphalt Curb and Gutter Removal   x   x                   PD-R-RDS-CGA     

PD-R-RDS-CGC Concrete Curb and Gutter Removal   x   x                   PD-R-RDS-CGC     

PD-R-RDS-UR Edge of Unpaved Road Removal   x   x                   PD-R-RDS-UR     

PD-R-RDS-T Removal Road Text       x                   PD-R-RDS-T     

PD-R-VEG-CLR Cleared Removal   x   x                   PD-R-VEG-CLR     

PD-R-VEG-CLRCUT Close Cut Cleared Removal   x   x                   PD-R-VEG-CLRCUT     

PD-R-VEG-CLRGRB Cleared and Grubbed Removal   x   x                   PD-R-VEG-CLRGRB     

PD-R-VEG-GRB Grubbed Removal   x   x                   PD-R-VEG-GRB     
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PD-R-VEG-T Removal Vegetation Text       x                   PD-R-VEG-T     

Typical Section 

PD-T-25MM 0.25 mm Line for Typical sections           x   x           PD-T-25MM     

PD-T-25MM-P 0.25 mm Hatch for Typical sections           x   x           PD-T-25MM-P     

PD-T-30MM 0.30 mm Line for Typical sections           x   x           PD-T-30MM     

PD-T-30MM-P 0.30 mm Hatch for Typical sections           x   x           PD-T-30MM-P     

PD-T-40MM 0.40 mm Line for Typical sections           x   x           PD-T-40MM     

PD-T-40MM-DASH 0.40 mm Dashed Line for Typical sections           x   x           PD-T-40MM-DASH     

PD-T-50MM 0.50 mm Line for Typical sections           x   x           PD-T-50MM     

PD-T-50MM-P 0.50 mm Hatch for Typical sections           x   x           PD-T-50MM-P     

PD-T-75MM 0.75 mm Line for Typical sections           x   x           PD-T-75MM     

PD-T-CL Centreline Text for Typical sections           x   x           PD-T-CL     

PD-T-DIM Dimensions for Typical sections           x   x           PD-T-DIM     

PD-T-OG Goriginal Ground for Typical sections           x   x           PD-T-OG     

PD-T-NOTE-T General Notes for Typical sections               x           PD-T-NOTE-T     

PD-T-TEXT All Text for Typical sections               x           PD-T-TEXT     
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InRoads General 

Default catchall   x   x   x   x   x     x Default x   

Breaklines Surface Breakline   x   x   x   x   x     x Breaklines     

Random Random Point     x x x   x x     x x x Random     

INR_Circle Point Symbol - Circle     x   x   x       x x   INR_Circle x   

INR_Cross Point Symbol - Cross     x   x   x       x x   INR_Cross x   

INR_Dumbbell Point Symbol - Dumbbel     x   x   x       x x   INR_Dumbbell x   

INR_Plus Sign Point Symbol - Plus Sign     x   x   x       x x   INR_Plus Sign x   

INR_Square Point Symbol - Square     x   x   x       x x   INR_Square x   

INR_Target Point Symbol - Target     x   x   x       x x   INR_Target x   

INR_Triangle Point Symbol - Triangle     x   x   x       x x   INR_Triangle x   

Contours-Major Contours   x   x                   Contours-Major     

Contours-Minor Contours   x   x                   Contours-Minor     

DTM Boundary Surfacve Boundary   x   x                   DTM Boundary     

DTM Triangles DTM Triangles   x   x                   DTM Triangles     
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Template Points 

Auxiliary Point Template Auxiliary Point IP, IBR   x     x x   x           Auxiliary Point     

Centerline Alignment Centerline Alignment (Point CL)   x   x x x   x   x      x  Centerline Alignment     

Curb and Gutter 
(Asphalt) 

Asphalt Curb and Gutter (Point CU &  GU)   x   x x     x x x     x 
Curb and Gutter 
(Asphalt) 

    

Curb and Gutter 
(Concrete) 

Concrete Curb and Gutter (Point CU &  GU)   x   x x     x x x     x 
Curb and Gutter 
(Concrete) 

    

Edge of Pavement Edge of Pavement (Point EP)   x   x x x   x   x     x Edge of Pavement     

Edge of Shoulder Edge of Shoulder (Point ES)   x   x x x   x   x     x Edge of Shoulder     

Edge of Paved Shoulder Edge of Paved Shoulder (Point EPS)   x   x x x   x   x     x Edge of Paved Shoulder     

Edge of Rounding Edge of Rounding (Point ER)   x   x x     x           Edge of Rounding     

Rounding Breakpoint Rounding Point (Point BR)   x     x     x           Rounding Breakpoint     

Granular Rounding Granular Rounding (Point GR)   x   x x     x           Granular Rounding     

Granular Shoulder Granular Shoulder (Point GS)   x   x x x   x x         Granular Shoulder     

Bottom of Ditch Bottom of Ditch (Point BC, CH MD, DI, DO)   x   x x x   x   x     x Bottom of DItch     

Bottom of Ditch - Lt Bottom of Ditch, Left - Design   x   x x     x x x     x Bottom of Ditch - Lt     

Bottom of Ditch - MD Bottom of Ditch, Median - Design   x   x x     x x x     x Bottom of Ditch - MD     

Bottom of Ditch - Rt Bottom of Ditch, Right - Design   x   x x     x x x     x Bottom of Ditch - Rt     
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Rock Rock (Point RFT, RFB, BRK, RBI)   x   x x     x x x     x Rock     

Rock Shatter Rock Shatter (Point SH, IB)   x   x x     x x x     x Rock Shatter     

Earth Bench Earth Bench (Point EBI, EBO, OB)   x     x     x x         Earth Bench     

Subdrain Subdrain (Point SD)   x   x x x   x x x   x x Subdrain     

Top of Cut Top of Cut (Point TC)   x   x x     x   x     x Top of Cut     

Top of Cut - Lt Top of Cut (Point TC) - Left   x   x x     x   x     x Top of Cut - Lt     

Top of Cut - Rt Top of Cut (Point TC) - Right   x   x x     x   x     x Top of Cut - Rt     

Toe of Fill Slope Toe of Slope (Point TS)   x   x x     x   x     x Toe of Fill Slope     

Toe of Fill Slope - Lt Toe of Slope (Point TS) - Left   x   x x     x   x     x Toe of Fill Slope - Lt     

Toe of Fill Slope - Rt Toe of Slope (Point TS) - Right   x   x x     x   x     x Toe of Fill Slope - Rt     

Raised Berm Raised Berm (Point RB)   x     x x   x x         Raised Berm     

Retaining Wall Reatining Wall (Point RW)   x   x x     x x x     x Retaining Wall     

Sidewalk (Asphalt) Asphalt Sidewalk (Point SW)   x   x x     x x         Sidewalk (Asphalt)     

Sidewalk (Concrete) Concrete Sidewalk (Point SW)   x   x x     x x         Sidewalk (Concrete)     

Muskeg Muskeg (Point MU)   x   x x     x x x     x Muskeg     

Barrier Barrier (Point BA)   x   x x     x x x     x Barrier     
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Jersey Barrier Jersey Barrier (Point JB)   x   x x     x x x     x Jersey Barrier     

Template Components 

Asphalt Top Course Asphalt Top Course   x           x x         Asphalt Top Course     

Asphalt Base Course 1 Asphalt Base Course 1   x           x x         Asphalt Base Course 1     

Asphalt Base Course 2 Asphalt Base Course 2   x           x x         Asphalt Base Course 2     

Asphalt Base Course 3 Asphalt Base Course 3   x           x x         Asphalt Base Course 3     

Asphalt Base Course 4 Asphalt Base Course 4   x           x x         Asphalt Base Course 4     

Asphalt Shoulder Top 
Course 

Asphalt Shoulder Top Course   x           x x         
Asphalt Shoulder Top 
Course 

    

Asphalt Shoulder Base 
Course 

Asphalt Shoulder Base Course   x           x x         
Asphalt Shoulder Base 
Course 

    

Concrete Pavement Plain Concrete   x           x x         Concrete Pavement     

Curb and Gutter 
(Asphalt) 

Asphalt Curb and Gutter (Point CU &  GU)   x   x x     x x x     x 
Curb and Gutter 
(Asphalt) 

    

Curb and Gutter 
(Concrete) 

Concrete Curb and Gutter (Point CU &  GU)   x   x x     x x x     x 
Curb and Gutter 
(Concrete) 

    

Granular A Granular A   x           x x         Granular A     

Granular B Granular B   x           x x         Granular B     

Granular Shoulder Granular Shoulder (Point GS)   x   x x x   x x         Granular Shoulder     

Jersey Barrier Jersey Barrier (Point JB)   x   x x     x x x     x Jersey Barrier     
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Curb & Gutter OPSD 
600.010 

Curb & Gutter OPSD 600.010   x           x x         
Curb & Gutter OPSD 
600.010 

    

Curb & Gutter OPSD 
600.020 

Curb & Gutter OPSD 600.020   x           x x         
Curb & Gutter OPSD 
600.020 

    

Curb & Gutter OPSD 
600.030 

Curb & Gutter OPSD 600.030   x           x x         
Curb & Gutter OPSD 
600.030 

    

Curb & Gutter OPSD 
600.040 

Curb & Gutter OPSD 600.040   x           x x         
Curb & Gutter OPSD 
600.040 

    

Curb & Gutter OPSD 
600.050 

Curb & Gutter OPSD 600.050   x           x x         
Curb & Gutter OPSD 
600.050 

    

Curb & Gutter OPSD 
600.060 

Curb & Gutter OPSD 600.060   x           x x         
Curb & Gutter OPSD 
600.060 

    

Curb & Gutter OPSD 
600.070 

Curb & Gutter OPSD 600.070   x           x x         
Curb & Gutter OPSD 
600.070 

    

Curb & Gutter OPSD 
600.080 

Curb & Gutter OPSD 600.080   x           x x         
Curb & Gutter OPSD 
600.080 

    

Curb & Gutter OPSD 
600.090 

Curb & Gutter OPSD 600.090   x           x x         
Curb & Gutter OPSD 
600.090 

    

Curb & Gutter OPSD 
600.100 

Curb & Gutter OPSD 600.100   x           x x         
Curb & Gutter OPSD 
600.100 

    

Curb & Gutter OPSD 
600.110 

Curb & Gutter OPSD 600.110   x           x x         
Curb & Gutter OPSD 
600.110 

    

Curb & Gutter OPSD 
601.010 

Curb & Gutter OPSD 601.010   x           x x         
Curb & Gutter OPSD 
601.010 

    

Muskeg Backfill Muskeg Backfill               x x         Muskeg Backfill     

Muskeg Excavation Muskeg Excavation               x x         Muskeg Excavation     

Cut Cut   x           x x         Cut     

Fill Fill   x           x x         Fill     
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Milling Milling   x   x     x x         Milling     

Rock Cut Rock Cut   x           x x         Rock Cut     

Rock Fill Rock Fill   x           x x         Rock Fill     

Rock Embankment Rock Embankment   x           x x         Rock Fill     

Rock Shatter Rock Shatter (Point SH, IB)   x   x x     x x x     x Rock Shatter     

Rock Shatter (Partial) Rock Shatter Partial (for deduction)   x         x x       Rock Shatter (Partial)     

Sidewalk (Asphalt) Asphalt Sidewalk (Point SW)   x   x x     x x         Sidewalk (Asphalt)     

Sidewalk (Concrete) Concrete Sidewalk (Point SW)   x   x x     x x         Sidewalk (Concrete)     

Stripping Stripping   x   x x x   x x         Stripping     

Subdrain Subdrain (Point SD)   x   x x x   x x x   x x Subdrain     

V Median Ditch V Median Ditch   x           x x         V Median Ditch     
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Photogrammetry General 

PH-G-25MM 0.25 mm Line - Existing   x   x   x   x   x     x PH-G-25MM     

PH-G-40MM 0.40 mm Line - Existing   x   x   x   x   x     x PH-G-40MM     

PH-G-50MM 0.50 mm Line - Existing   x   x   x   x   x     x PH-G-50MM     

PH-G-75MM 0.75 mm Line - Existing   x   x   x   x   x     x PH-G-75MM     

PH-G-TEXT General Text - Existing       x       x         x PH-G-TEXT     

PH-E-SCANNED Scanned Image - Existing   x   x x     x   x     x PH-E-SCANNED     

PH-G-SYMBOLS Symbols - Existing   x x x x   x x   x x   x PH-G-SYMBOLS     

PH-E-LABELS String Labels - Existing       x       x         x PH-E-LABELS     

Survey Monument 

PH-E-MON Horizontal Control - Existing   x x x x   x x     x x x PH-E-MON     

PH-E-MON-BM Vertical Control - Existing   x x x x   x x     x x x PH-E-MON-BM     

Alignment 

PH-E-ALI-E1 Entrance Alignment - Existing   x   x x x       x       PH-E-ALI-E1 x   

Barrier 

PH-E-BAR-BB Bottom of Barrier Concrete - Existing   x   x x     x   x     x PH-E-BAR-BB     
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PH-E-BAR-BT Top of Concrete Barrier - Existing   x   x x     x   x     x PH-E-BAR-BT     

PH-E-BAR-FL Top of Fence - Existing   x   x x     x   x     x PH-E-BAR-FL     

PH-E-BAR-GAT Gate - Existing   x   x x     x   x     x PH-E-BAR-GAT     

PH-E-BAR-GU Guide Rail (Plan Only) - Existing   x   x x     x   x     x PH-E-BAR-GU     

PH-E-BAR-NB Top of Noise Barrier - Existing   x   x x     x   x     x PH-E-BAR-NB     

PH-E-BAR-T Brrier Text - Existing   x   x       x         x PH-E-BAR-T     

Contour 

PH-E-CTR-C1 Contours (Primary) - Existing   x   x                   PH-E-CTR-C1     

PH-E-CTR-C2 Contours (Secondry) - Existing   x   x                   PH-E-CTR-C2     

PH-E-CTR-T Contour Text - Existing   x   x                   PH-E-CTR-T     

Drainage 

PH-E-DRN-BD Bottom of Ditch - Existing   x   x x x x x   x     x PH-E-DRN-BD     

PH-E-DRN-CB Catch Basin - Existing     x x             x   x PH-E-DRN-CB     

PH-E-DRN-CVP Culvert (One End) - Existing     x x             x   x PH-E-DRN-CVP     

PH-E-DRN-CV-P Culvert Outline - Existing   x   x   x   x   x     x PH-E-DRN-CV-P     

PH-E-DRN-CVT Top Culvert Centreline - Existing   x   x   x   x   x     x PH-E-DRN-CVT     
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PH-E-DRN-DI Ditch Inlet - Existing     x x             x   x PH-E-DRN-DI     

PH-E-DRN-EM Edge of Muskeg - Existing   x   x x x   x   x     x PH-E-DRN-EM     

PH-E-DRN-EM-P Muskeg Pattern - Existing   x   x                   PH-E-DRN-EM-P     

PH-E-DRN-EW Edge of Water - Existing   x   x x     x   x     x PH-E-DRN-EW     

PH-E-DRN-MH Manhole - Existing     x x             x   x PH-E-DRN-MH     

PH-E-DRN-RR Rip_Rap - Existing   x   x                   PH-E-DRN-RR     

PH-E-DRN-T Drainage Text - Existing       x       x         x PH-E-DRN-T     

Ground Feature 

PH-E-GND-AO Asphalt Outling - Existing   x   x x     x   x     x PH-E-GND-AO     

PH-E-GND-AS Asphalt Shots - Existing   x   x x     x   x     x PH-E-GND-AS     

PH-E-GND-BA Bank River or Stream - Existing   x   x x     x   x     x PH-E-GND-BA     

PH-E-GND-BC Bottom of Rock Cut - Existing   x   x x     x   x     x PH-E-GND-BC     

PH-E-GND-CO Conrete Outline - Existing   x   x           x     x PH-E-GND-CO     

PH-E-GND-CS Concrete Shots - Existing   x   x x     x   x     x PH-E-GND-CS     

PH-E-GND-EC Entrance Centreline - Existing   x   x x x x x   x x x x PH-E-GND-EC     

PH-E-GND-GO Gravel Outline - Existing   x   x x     x   x     x PH-E-GND-GO     
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PH-E-GND-GS Gravel Shots - Existing   x   x x     x   x     x PH-E-GND-GS     

PH-E-GND-GX Original Ground (Approximate) - Existing   x   x x     x   x     x PH-E-GND-GX     

PH-E-GND-OG Original Ground Fault - Existing   x   x x x x x   x     x PH-E-GND-OG     

PH-E-GND-RBE Railway Ballast Edge - Existing   x   x x     x   x     x PH-E-GND-RBE     

PH-E-GND-RBT Railway Ballast Top - Existing   x   x x     x   x     x PH-E-GND-RBT     

PH-E-GND-RKO Rock Outline - Existing   x   x x     x   x     x PH-E-GND-RKO     

PH-E-GND-RKS Rock Shots - Existing   x   x x     x   x     x PH-E-GND-RKS     

PH-E-GND-SP Stock Piles - Existing   x   x x     x   x     x PH-E-GND-SP     

PH-E-GND-TC Top of Rock Cut - Existing   x   x x     x   x     x PH-E-GND-TC     

PH-E-GND-XX Original Ground (Estimated) - Existing   x   x x     x   x     x PH-E-GND-XX     

PH-E-GND-P Ground Patterning (Cut and Fill) - Existing   x   x           x     x PH-E-GND-P     

PH-E-GND-T Ground Featrure Text - Existing       x       x         x PH-E-GND-T     

Miscellaneous 

PH-Q-MSC-AU Audit Line for Quality Assurance - Existing   x   x                   Default     

PH-E-MSC-AX Excluded Area - Existing   x   x           x     x PH-E-MSC-AX     

PH-E-MSC-AX-P Excluded Area Pattern - Existing   x   x                   PH-E-MSC-AX-P     



Appendix E 

InRoads Styles for Photogrammetry 

 

InRoads Preference and Standards Manual – Version 3.0                  Appendix E - 5 

Surface Feature 

Plan Cross Section Profile 

Style Name Description Item Code 

 L
in

e
 

 P
o

in
t 

 A
n
n

o
ta

ti
o

n
 

 P
o

in
t 

 P
ro

je
c
te

d
 L

in
e
 

 P
ro

je
c
te

d
 P

o
in

t 

 A
n
n

o
ta

ti
o

n
 

 C
o
m

p
o
n

e
n
t 

 P
ro

je
c
te

d
 L

in
e
 

 P
ro

je
c
te

d
 P

o
in

t 

 C
ro

s
s
in

g
 P

o
in

t 

 A
n
n

o
ta

ti
o

n
 Symbology 

Name 

 G
e
o

m
e
tr

y
 F

e
a
tu

re
 

 S
u

rv
e
y
 F

e
a
tu

re
 

PH-E-MSC-BLF Building Foundation Ruins - Existing   x   x x     x   x     x PH-E-MSC-BLF     

PH-E-MSC-BLR Building Roofline Rectangular - Existing   x   x x     x   x     x PH-E-MSC-BLR     

PH-E-MSC-BS Building Surround - Existing   x   x x     x   x     x PH-E-MSC-BS     

PH-E-MSC-BY Segment Boundry - Existing   x   x x     x   x     x PH-E-MSC-BY     

PH-E-MSC-CE Cemetry - Existing   x   x x     x   x     x PH-E-MSC-CE     

PH-E-MSC-DK Wooden Decks or Docks - Existing   x   x x     x   x     x PH-E-MSC-DK     

PH-E-MSC-EJ Expansion Joint - Existing   x   x           x     x PH-E-MSC-EJ     

PH-E-MSC-EV-Z Miscellaneous Elevations - Existing     x x     x x     x   x PH-E-MSC-EV-Z     

PH-E-MSC-GAB Gabion Baskets - Existing   x   x           x     x PH-E-MSC-GAB     

PH-E-MSC-GC Golf Course - Existing   x   x x     x           PH-E-MSC-GC     

PH-E-MSC-HR Bridge Hand Rails - Existing   x   x x     x   x     x PH-E-MSC-HR     

PH-E-MSC-OR Orchard - Existing   x   x x     x   x     x PH-E-MSC-OR     

PH-E-MSC-OS Overhead Sign - Existing   x x x x x x x   x x   x PH-E-MSC-OS     

PH-E-MSC-RLT Railway - Top of Rail - Existing   x   x x     x   x     x PH-E-MSC-RLT     

PH-E-MSC-RW Retaining Wall - Top - Existing   x   x x     x   x     x PH-E-MSC-RW     

PH-E-MSC-SW Sidewalk - Existing   x   x x     x   x     x PH-E-MSC-SW     
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PH-E-MSC-VI Vineyard - Existing   x   x x     x           PH-E-MSC-VI     

PH-E-MSC-WW Walkways - Trails - Paths - Existing   x   x x     x   x     x PH-E-MSC-WW     

PH-E-MSC-T Miscellaneous Text - Existing       x       x         x PH-E-MSC-T     

Roadway 

PH-E-RDS-AE Asphalt Edges - Existing   x x x x     x   x     x PH-E-RDS-AE     

PH-E-RDS-BRD Bridge Deck - Existing   x   x x     x   x     x PH-E-RDS-BRD     

PH-E-RDS-CR Crown of Road - Existing   x   x x     x   x     x PH-E-RDS-CR     

PH-E-RDS-CU Curbs - Existing   x   x x     x   x     x PH-E-RDS-CU     

PH-E-RDS-EG Edge of Gutter - Existing   x   x x     x   x     x PH-E-RDS-EG     

PH-E-RDS-EN Entrance - Uncertain Surface   x   x x     x   x     x PH-E-RDS-EN     

PH-E-RDS-EP Edge of Pavement - Existing   x   x x     x   x     x PH-E-RDS-EP     

PH-E-RDS-ES Edge of Shoulder - Existing   x   x x     x   x     x PH-E-RDS-ES     

PH-E-RDS-NG Gravel Entrance - Existing   x   x x     x   x     x PH-E-RDS-NG     

PH-E-RDS-NP Paved Entrance - Existing   x   x x     x   x     x PH-E-RDS-NP     

PH-E-RDS-RD Roads - Uncertain Material   x   x x     x   x     x PH-E-RDS-RD     

PH-E-RDS-UR Gravel Sideroads - Existing   x   x x     x   x     x PH-E-RDS-UR     
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PH-E-RDS-T Roadway Text - Existing       x       x         x PH-E-RDS-T     

Utility 

PH-E-UTL-AN Anchaor for Guy Wire     x x     x x           PH-E-UTL-AN     

PH-E-UTL-BH Bell Hydro Pole - Existing     x x     x x           PH-E-UTL-BH     

PH-E-UTL-BP Bell Pole - Existing     x x     x x           PH-E-UTL-BP     

PH-E-UTL-FH Fire Hydrant - Existing     x x     x x           PH-E-UTL-FH     

PH-E-UTL-HP Hydro Pole - Existing     x x     x x           PH-E-UTL-HP     

PH-E-UTL-HT Hydro Tower - Existing     x x     x x           PH-E-UTL-HT     

PH-E-UTL-LS Light Standard - Existing     x x     x x           PH-E-UTL-LS     

PH-E-UTL-PW Pole Well - Existing     x x     x x           PH-E-UTL-PW     

PH-E-UTL-PO Pole - Other - Existing     x x     x x           PH-E-UTL-PO     

PH-E-UTL-WE Well - Existing     x x     x x     x   x PH-E-UTL-WE     

PH-E-UTL-T Utilities Text - Existing       x       x         x PH-E-UTL-T     

Vegetation 

PH-E-VEG-HE Hedge - Existing   x x x x     x           PH-E-VEG-HE     

PH-E-VEG-TR Trees - Existing     x x x     x           PH-E-VEG-TR     
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PH-E-VEG-WD Woods Detail - Existing   x   x                   PH-E-VEG-WD     

PH-E-VEG-T Vegetation Text - Existing       x       x         x PH-E-VEG-T     
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Surveys & Plans General 

SP-G-CONS Construction Lines - Existing   x   x   x   x   x     x SP-G-CONS     

SP-G-25MM 0.25 mm Line - Existing   x   x   x   x   x     x SP-G-25MM     

SP-G-40MM 0.40 mm Line - Existing   x   x   x   x   x     x SP-G-40MM     

SP-G-50MM 0.50 mm Line - Existing   x   x   x   x   x     x SP-G-50MM     

SP-G-75MM 0.75 mm Line - Existing   x   x   x   x   x     x SP-G-75MM     

SP-G-TEXT General Text - Existing       x       x         x SP-G-TEXT     

SP-G-SYMBOLS Symbols - Existing   x x x     x x     x   x SP-G-SYMBOLS     

SP-E-LABELS String Labels - Existing       x       x         x SP-E-LABELS     

SP-E-SCANNED Scanned Image - Existing   x   x x     x   x     x SP-E-SCANNED     

Survey Monument 

SP-E-MON Survey Monuments - Existing   x x x x   x x     x x x SP-E-MON     

SP-E-MON-BM Bench Marks   x x x x   x x     x x x SP-E-MON-BM     

SP-G-MON-T Monument Text - Existing       x       x         x Default     

Alignment 

SP-E-ALI Misc Alignment - Existing   x x x x     x   x       SP-E-ALI x   
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SP-E-ALI-CL Centreline Alignment - Existing   x   x x x       x       SP-E-ALI-CL x   

SP-E-ALI-CL-C Centreline Alignment Chainage - Existing   x   x                 x SP-E-ALI-CL-C     

SP-E-ALI-CL-PTS Centreline Alignment Points - Existing                             x   

SP-E-ALI-CL-PTST Centreline Alignment Point Symbol - Triangle                             x   

SP-E-ALI-CL-T Centreline Alignment Text - Existing   x   x x     x   x     x SP-E-ALI-CL-T     

SP-E-ALI-D1 Drainage Alignment - Existing   x x x x     x   x       SP-E-ALI-D1 x   

SP-E-ALI-E1 Entrance Alignment - Existing   x   x x     x   x       SP-E-ALI-E1 x   

SP-E-ALI-R1 Align Revision - Ramp   x x x x     x   x       SP-E-ALI-R1 x   

SP-E-ALI-S1 Sideroad Alignment - Existing   x   x x     x   x       SP-E-ALI-S1 x   

Barrier 

SP-E-BAR-BB Bottom Concrete Barrier - Existing   x   x x     x   x     x SP-E-BAR-BB     

SP-E-BAR-BT Top of Concrete Barrier - Existing   x   x x     x   x     x SP-E-BAR-BT     

SP-E-BAR-FB Fitch Barrier - Existing   x   x x     x   x     x SP-E-BAR-FB     

SP-E-BAR-FL Fence Line (Ground) - Existing   x   x x     x   x     x SP-E-BAR-FL     

SP-E-BAR-FN Fence Line - Existing   x   x x     x   x     x SP-E-BAR-FN     

SP-E-BAR-GAT Gate - Existing   x   x x     x   x     x SP-E-BAR-GAT     
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SP-E-BAR-GP-Z Guide Rail (Top of Post) - Existing   x   x x     x   x     x SP-E-BAR-GP-Z     

SP-E-BAR-GU Guide Rail (Ground) - Existing   x   x x     x   x     x SP-E-BAR-GU     

SP-E-BAR-GW-Z Guide Rail (Top of Wire) - Existing   x   x x     x   x     x SP-E-BAR-GW-Z     

SP-E-BAR-NB Noise Barrier (Ground) - Existing   x   x x     x   x     x SP-E-BAR-NB     

SP-E-BAR-T Brrier Text - Existing   x   x       x         x SP-E-BAR-T     

Contour 

SP-E-CTR-C1 Contours (Primary) - Existing   x   x                   SP-E-CTR-C1     

SP-E-CTR-C2 Contours (Secondry) - Existing   x   x                   SP-E-CTR-C2     

SP-E-CTR-T Contour Text - Existing   x   x                   SP-E-CTR-T     

Drainage 

SP-E-DRN-BD Bottom of Ditch - Existing   x   x x x x x   x     x SP-E-DRN-BD     

SP-E-DRN-CB Catch Basin- Existing     x x             x   x SP-E-DRN-CB     

SP-E-DRN-CVP Culvert (One End) - Existing     x x             x   x SP-E-DRN-CVP     

SP-E-DRN-CV-P Culvert Symbology - Existing   x   x   x   x   x     x SP-E-DRN-CV-P     

SP-E-DRN-CVT Top Culvert Centreline - Existing   x   x   x   x   x     x SP-E-DRN-CVT     

SP-E-DRN-CV-Z Culvert Elevation - Existing     x x     x x     x   x SP-E-DRN-CV-Z     
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SP-E-DRN-DB-Z Ditch Inlet (Bottom Elevation) - Existing     x x     x x     x   x SP-E-DRN-DB-Z     

SP-E-DRN-DC Ditch Centreline - Existing   x   x x x x x   x     x SP-E-DRN-DC     

SP-E-DRN-DI Ditch Inlet - Existing     x x             x   x SP-E-DRN-DI     

SP-E-DRN-DT-Z Ditch Inlet (Top Elevation) - Existing     x x     x x     x   x SP-E-DRN-DT-Z     

SP-E-DRN-EM Edge of Muskeg - Existing   x   x x x   x   x     x SP-E-DRN-EM     

SP-E-DRN-EM-P Muskeg Pattern - Existing   x   x                   SP-E-DRN-EM-P     

SP-E-DRN-EW Edge of Water - Existing   x   x x     x   x     x SP-E-DRN-EW     

SP-E-DRN-FR-Z Frustum Elevation - Existing     x x     x x     x   x SP-E-DRN-FR-Z     

SP-E-DRN-MH Manhole - Existing     x x             x   x SP-E-DRN-MH     

SP-E-DRN-RR Rip_Rap - Existing   x   x                   SP-E-DRN-RR     

SP-E-DRN-SAN Sanitary Sewer Pipe - Existing   x   x x x   x   x   x x SP-E-DRN-SAN     

SP-E-DRN-SEW Storm Sewer Pipe - Existing   x   x x x   x   x   x x SP-E-DRN-SEW     

SP-E-DRN-SU-Z Sump Elevation - Existing     x x     x x     x   x SP-E-DRN-SU-Z     

SP-E-DRN-WM Water Mark - Existing   x x x     x x     x   x SP-E-DRN-WM     

SP-E-DRN-T Drainage Text - Existing       x       x         x PH-E-DRN-T     

Ground Feature 
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SP-E-GND-AO Asphalt Outline - Existing   x   x x     x   x     x SP-E-GND-AO     

SP-E-GND-AS Asphalt Shots - Existing   x   x x     x   x     x SP-E-GND-AS     

SP-E-GND-BA Bank of River or Stream - Existing   x   x x     x   x     x SP-E-GND-BA     

SP-E-GND-BC Bottom of Rock Cut - Existing   x   x x     x   x     x SP-E-GND-BC     

SP-E-GND-CO Concrete Outline - Existing   x   x x     x   x     x SP-E-GND-CO     

SP-E-GND-CS Concrete Shots - Existing   x   x x     x   x     x SP-E-GND-CS     

SP-E-GND-DS Door Sill - Existing   x   x x     x   x     x SP-E-GND-DS     

SP-E-GND-EC Entrance Centreline - Existing   x   x x x x x   x x x   SP-E-GND-EC     

SP-E-GND-GO Gravel Outline - Existing   x   x x     x   x     x SP-E-GND-GO     

SP-E-GND-GS Gravel Shots - Existing   x   x x     x   x     x SP-E-GND-GS     

SP-E-GND-OG Original Ground Fault - Existing   x   x x x x x   x     x SP-E-GND-OG     

SP-E-GND-RBE Railway Ballast Edge - Existing   x   x x     x   x     x SP-E-GND-RBE     

SP-E-GND-RBT Railway Ballast Top - Existing   x   x x     x   x     x SP-E-GND-RBT     

SP-E-GND-RKO Rock Outline - Existing   x   x x     x   x     x SP-E-GND-RKO     

SP-E-GND-RKS Rock Shots - Existing   x   x x     x   x     x SP-E-GND-RKS     

SP-E-GND-SB River or Stream Bed - Existing   x   x x     x   x     x SP-E-GND-SB     
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SP-E-GND-SP Stock Piles/Gravel Pits - Existing   x   x x     x   x     x SP-E-GND-SP     

SP-E-GND-TC Top of Rock Cut - Existing   x   x x     x   x     x SP-E-GND-TC     

SP-E-GND-TS Toe of Slope - Existing   x   x x     x   x     x SP-E-GND-TS     

SP-E-GND-P Ground Patterning (Cut-Fill) - Existing   x   x           x     x SP-E-GND-P     

SP-E-GND-T Ground Feature Text - Existing       x       x         x SP-E-GND-T     

Miscellaneous 

SP-Q-MSC-AU Audit Line - Existing   x   x                   SP-Q-MSC-AU     

SP-E-MSC-BLO Building Outline (Bottom) - Existing   x   x x     x   x     x SP-E-MSC-BLO     

SP-E-MSC-BN Centre of Bull Nose - Existing   x   x           x     x SP-E-MSC-BN     

SP-E-MSC-BRP Bridge Pillar - Existing   x x x x   x x   x x x x SP-E-MSC-BRP     

SP-E-MSC-BY Segment Boundary - Existing   x   x x     x   x     x SP-E-MSC-BY     

SP-E-MSC-CE Cemetry - Existing   x   x x     x   x     x SP-E-MSC-CE     

SP-E-MSC-DD Deck Drain - Existing   x   x x     x   x     x SP-E-MSC-DD     

SP-E-MSC-DK Wooden Decks or Docks - Existing   x   x x     x   x     x SP-E-MSC-DK     

SP-E-MSC-EJ Expansion Joint - Existing   x   x           x     x SP-E-MSC-EJ     

SP-E-MSC-EV-Z Miscellaneous Elevation - Existing     x x     x x     x   x SP-E-MSC-EV-Z     
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SP-E-MSC-GAB Gabion Baskets - Existing   x   x           x     x SP-E-MSC-GAB     

SP-E-MSC-GFL Gate with Flashing Light - Existing   x   x           x     x SP-E-MSC-GFL     

SP-E-MSC-HR Bridge Hand Rails - Existing   x   x x     x   x     x SP-E-MSC-HR     

SP-E-MSC-OS Overhead Sign - Existing   x x x x x x x   x x   x SP-E-MSC-OS     

SP-E-MSC-RCS Railway Crossing Sign - Existing   x x x           x     x SP-E-MSC-RCS     

SP-E-MSC-RLS Railway Sign - Existing   x x x x         x     x SP-E-MSC-RLS     

SP-E-MSC-RLT Railway - Top of Rail - Existing   x   x x     x   x     x SP-E-MSC-RLT     

SP-E-MSC-RW Retaining Wall - Bottom - Existing   x   x x     x   x     x SP-E-MSC-RW     

SP-E-MSC-SW Sidewalk - Existing   x   x x     x   x     x SP-E-MSC-SW     

SP-E-MSC-WW Walkways/Trails/Paths - Existing   x   x x     x   x     x SP-E-MSC-WW     

SP-E-MSC-T Miscellaneous Text - Existing       x       x         x SP-E-MSC-T     

Property Boundary 

SP-E-BDY-CITY City Boundary   x   x x     x           SP-E-BDY-CITY     

SP-E-BDY-LIN General Propert Boundry Line   x   x x     x           SP-E-BDY-LIN     

SP-E-BDY-LLS Lot Line - Subdivision Boundary   x   x x     x           SP-E-BDY-LLS     

SP-E-BDY-LLC Lot Line - Concession Boundary   x   x x     x           SP-E-BDY-LLC     
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SP-E-BDY-T Property Boundary Text   x   x       x         x SP-E-BDY-T     

Right of Way 

SP-E-ROW-MTO Existing MTO Property   x   x x     x   x     x SP-E-ROW-MTO     

SP-E-ROW-T Right of Way Text - Existing       x       x         x SP-E-ROW-T     

Roadway 

SP-E-RDS-AE Asphalt Edge - Existing   x   x x     x   x     x SP-E-RDS-AE     

SP-E-RDS-BRD Bridge Deck - Existing   x   x x     x   x     x SP-E-RDS-BRD     

SP-E-RDS-CR Crown of Road - Existing   x   x x     x   x     x SP-E-RDS-CR     

SP-E-RDS-CU Curbs - Existing   x   x x     x   x     x SP-E-RDS-CU     

SP-E-RDS-DL Driving Lane Edge - Existing   x   x x     x   x     x SP-E-RDS-DL     

SP-E-RDS-EG Edge of Gutter - Exisiting   x   x x     x   x     x SP-E-RDS-EG     

SP-E-RDS-EP Edge of Pavement - Exisiting   x   x x     x   x     x SP-E-RDS-EP     

SP-E-RDS-ES Wdge of Shoulder - Exisiting   x   x x     x   x     x SP-E-RDS-ES     

SP-E-RDS-NG Gravel Entrance - Exisiting   x   x x     x   x     x SP-E-RDS-NG     

SP-E-RDS-NP Paved Entrance - Existing   x   x x     x   x     x SP-E-RDS-NP     

SP-E-RDS-RS Ripple Strip - Existing   x   x x     x           SP-E-RDS-RS     
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SP-E-RDS-SR Sideroad Paved - Exisiting   x   x x     x   x     x SP-E-RDS-SR     

SP-E-RDS-UR Gravel Sideroad - Existing   x   x x     x   x     x SP-E-RDS-UR     

SP-E-RDS-T Roadway Text - Existing       x       x         x SP-E-RDS-T     

Utility 

SP-E-UTL-AN Anchor - Existing     x x     x x           SP-E-UTL-AN     

SP-E-UTL-BH Bell - Hydro Pole - Existing     x x     x x           SP-E-UTL-BH     

SP-E-UTL-BP Bell Pole - Existing     x x     x x           SP-E-UTL-BP     

SP-E-UTL-FH Fire Hydrant - Existing     x x     x x           SP-E-UTL-FH     

SP-E-UTL-GV Gas Valve - Existing     x x     x x           SP-E-UTL-GV     

SP-E-UTL-HCG-Z Hydro Crossing Ground Elevation - Existing     x x     x x     x   x SP-E-UTL-HCG-Z     

SP-E-UTL-HCW-Z Hydro Crossing Wire Elevation - Existing     x x     x x     x   x SP-E-UTL-HCW-Z     

SP-E-UTL-HP Hydro Ploe - Existing     x x     x x           SP-E-UTL-HP     

SP-E-UTL-HT Hydro Tower - Existing     x x     x x           SP-E-UTL-HT     

SP-E-UTL-LS Light Standard - Existing     x x     x x           SP-E-UTL-LS     

SP-E-UTL-PL Pipeline - Existing   x   x x     x   x     x SP-E-UTL-PL     

SP-E-UTL-PO Pole - Other - Existing     x x     x x           SP-E-UTL-PO     
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SP-E-UTL-PW Pole Well - Existing     x x     x x           SP-E-UTL-PW     

SP-E-UTL-TB Utility Terminal Box - Existing     x x     x x     x   x SP-E-UTL-TB     

SP-E-UTL-UB Underground Bell - Existing   x   x x     x   x   x x SP-E-UTL-UB     

SP-E-UTL-UG Underground Gas - Existing   x   x x     x   x   x x SP-E-UTL-UG     

SP-E-UTL-UH Underground Hydro - Existing   x   x x     x   x   x x SP-E-UTL-UH     

SP-E-UTL-UM Underground Utility Marker - Existing     x x     x x           SP-E-UTL-UM     

SP-E-UTL-UT Underground Utility - Other - Existing   x x x x   x x   x x   x SP-E-UTL-UT     

SP-E-UTL-UTV Underground Cable TV - Existing   x   x x     x   x   x x SP-E-UTL-UTV     

SP-E-UTL-UW Underground Watermain - Existing   x   x x     x   x   x x SP-E-UTL-UW     

SP-E-UTL-VE Vent - Existing     x x     x x           SP-E-UTL-VE     

SP-E-UTL-WE Well - Existing     x x     x x     x   x SP-E-UTL-WE     

SP-E-UTL-WV Water Valve - Existing     x x     x x     x   x SP-E-UTL-WV     

SP-E-UTL-T Utility Text - Existing       x       x         x SP-E-UTL-T     

Vegetation 

SP-E-VEG-HE Hedge - Existing   x x x x     x           SP-E-VEG-HE     

SP-E-VEG-P Bush Symbology - Existing   x   x           x     x SP-E-VEG-P     
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SP-E-VEG-TR Trees - Existing     x x     x x           SP-E-VEG-TR     

SP-E-VEG-WD Woods Detail - Existing   x   x           x     x SP-E-VEG-WD     

SP-E-VEG-WO Woods Overhang (Ground) - Existing   x   x           x     x SP-E-VEG-WO     

SP-E-VEG-WT Woods Trunkline - Existing   x   x           x     x SP-E-VEG-WT     

SP-E-VEG-T Vegetation Text - Existing       x       x         x SP-E-VEG-T     

Profile 

SP-P-ALI-CL Profile Information - Existing                   x x x x SP-P-ALI-CL     

SP-P-ALI-DRN Profile Drainage Information - Existing                   x x x x SP-P-ALI-DRN     

SP-P-ALI-DRN-T Profile Text - Existing                         x SP-P-ALI-DRN-T     

SP-P-ALI-GRID Profile Grid - Existing                   x     x SP-P-ALI-GRID     

SP-P-ALI-GRID-T Profile Chainage - Existing                         x SP-P-ALI-GRID-T     

LEGAL SURVEYS 

SP-L-MON Horizontal Control Points - Legal     x x                   SP-L-MON     

SP-L-MON-BM Bench Marks - Legal     x x                   SP-L-MON-BM     

SP-L-25MM Legal Survey 0.25 mm Line   x   x                   SP-L-25MM     

SP-L-25MM-SDASH Legal Survey - 0.25 mm Short Dash Line   x   x                   SP-L-25MM-SDASH     
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Surface Feature 

Plan Cross Section Profile 

Style Name Description Item Code 
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SP-L-25MM-LDASH Legal Survey - 0.25 mm Long Dash Line   x   x                   SP-L-25MM-LDASH     

SP-L-40MM Legal Survey - 0.40 mm Line   x   x                   SP-L-40MM     

SP-L-40MM-LDASH Legal Survey - 0.40 Long Dash Line   x   x                   SP-L-40MM-LDASH     

SP-L-50MM Legal Survey - 0.50 mm Line   x   x                   SP-L-50MM     

SP-L-FABRIC LINES Fabric Lines - Legal   x   x                   SP-L-FABRIC LINES     

SP-L-FABRIC TEXT Fabric Text - Legal       x                   SP-L-FABRIC TEXT     

SP-L-PARCEL Parcel - Legal   x   x                   SP-L-PARCEL     

SP-L-PART LINES Part Lines - Legal   x   x                   SP-L-PART LINES     

SP-L-PART TEXT Part Text - Legal       x                   SP-L-PART TEXT     

SP-L-TEXT Legal Text       x                   SP-L-TEXT     

SP-L-SYMBOLS Legal Symbols     x x                   SP-L-SYMBOLS     

 
 


